
SST SST LATEST EDITION

PREMIUM FEATURES PREMIUM FEATURES 

Secondary School Teacher BPS-16Secondary School Teacher BPS-16

To The Point Topic Wise One Liner Notes
Authentic, Concise, Errorless & Result
Oriented Notes & Practice MCQs 
Solved Past Papers & Most Repeated
Important Questions 
According to KPK & Federal Text Books
9th, 10th, First Year & Second Year
100% Success Guaranteed

IT  I T  
Practice BookPractice Book

To The Point Errorless Notes for Complete Preparation &
Quick Revision 

PUBLICATIONS
LETS MAKE IT HAPPEN!

MK
Contact:
Email:

0342-4470091 | 0333-2605045

mkpreparations@gmail.com @MK
PREPARATIONS

KPPSC 

According to the Latest

Syllabus & Pattern of

Khyber Pakhtunkhwa

Public Service Commission 

According to the Latest
Syllabus & Pattern of
Khyber Pakhtunkhwa

Public Service Commission 

F
o
r 

On
line Ord

e
r

0348-4233593



  MK PREPARATIONS  

 
 

  

Table of Content 

• Introduction To Computing 
And ICT 

• History Of Computers  

• Computer System: 
Architecture And 
Components 

• Number Systems, Digital 
Logics & Data  

• Operating Systems  

• Office Automation  

• Microsoft Word 

• Microsoft Excel  

• Microsoft Power Point  

• Keyboard And Shortcut 
Keys 

• Data Communication And 
Networks  

• Computational Thinking 
And Algorithms 

• Programing Fundamentals 

• Programing In C 
• Object Oriented 

Programing In C++ 

• Web Development With 
HTML, CSS, And Java 
Script 

• Data Base And Data 
Management (DBMS) 

• System Development, 
Maintenance And 
Troubleshooting 

• Emerging And 
Contemporary Technologies 

• Digital Citizenship, Literacy 
& Ethics  

• Entrepreneurship In Digital 
Age  

• Miscellaneous Information: 
A Quick Revision Notes 

• Past Papers MCQs

 



 

  MK PREPARATIONS  

 

P a g e  1 | 37 

 

  

1
. In

tro
d

u
ctio

n
 to

 C
o

m
p

u
tin

g
 a

n
d

 IC
T

 
  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Introduction to Computing and ICT 
Information and Communication Technology (ICT) 

Information and Communication Technology (ICT) is defined as a comprehensive set of 
computing tools that collectively allow people and organizations to interact in the digital world. 
It is an umbrella term encompassing communication devices (television, cell phones), 
computer and network hardware, satellite systems, and various associated services and 
applications such as video conferencing, distance learning, and e-commerce. ICT also 
represents the technological convergence of telephone networks with computer networks via a 
single link system, enabling integrated data, voice, and video communication. 

What is a System? 

A system is a collection of interconnected components working together cohesively to achieve 
specific goals or objectives by processing inputs to produce desired outputs. Systems exist in 
both natural and artificial domains. Understanding a system's structure allows for better design, 
management, and optimization across fields like engineering, biology, and computing. 

A system is described by four fundamental concepts: 

1. Objective/Purpose: The primary goal the system is designed to achieve. 

2. Components: The essential building blocks or parts that constitute the system. 

3. Environment: Everything external to the system that interacts with or influences it. 

4. Communication/Interaction: The mechanisms through which components and the system 
itself exchange information and coordinate their functions. 

Types of Systems 

Systems are broadly categorized into two main types: 
1.3.1 Natural Systems 
These occur organically in nature without human intervention. They are characterized by 
self-regulation, adaptability, stability, and are governed by natural laws (physics, chemistry, 
biology). They are highly intricate and interdependent. 

• Examples: Ecosystems (forests, oceans), weather patterns, the solar system, the human body 
(circulatory, nervous systems), DNA, psychological systems (thoughts, emotions). 

Chapter 1 
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1.3.2 Artificial Systems 
These are intentionally designed and built by humans to fulfill specific needs or solve 
problems. They are structured, require maintenance, and operate under predefined human-set 
rules and protocols. 

• Examples: 

o Knowledge Systems: Mathematics, logic, databases, information management systems. 

o Engineering Systems: Civil (bridges, roads), mechanical (robotic arms), chemical (water 
treatment plants), electrical (home automation), software (library management systems). 

o Social Systems: Academic institutions, governments, corporations. 

o Computer Systems: The primary focus of this chapter. 

Key Differences: 

Feature Natural Systems Artificial Systems 

Origin Occur naturally. Designed and built by humans. 

Complexity Highly intricate and 
interdependent. 

Structured and relatively simpler. 

Energy Source Natural (sunlight, water flow). Artificial (electricity, fuel). 

Adaptation Evolve autonomously over time. Require human updates/redesign. 

Governance Natural laws. Human-defined rules and 
protocols. 

Systems and Science 

The study of systems aligns with different scientific approaches: 

• Natural Science: Focuses on understanding and describing existing natural systems (e.g., 
studying a forest ecosystem). 

• Design Science: Focuses on creating new artificial systems to solve problems (e.g., 
developing conservation software). 
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• Computer Science: Utilizes methods from both. It studies the natural laws of computation 
(e.g., algorithm efficiency) and engages in the design science of creating new software and 
hardware systems. 

The Computer as a System 

Definition of a Computer 

A computer is a programmable electronic device that accepts raw data as input, processes it 
according to a set of stored instructions (a program), produces useful output, and stores 
(storage) the results for future use. It performs arithmetic and logical operations automatically 
and without human intervention during processing. 

Objectives of a Computer System 

The main objectives are to perform computations, process data, and execute tasks efficiently 
to provide useful information to the user. This includes running software applications, 
managing files, facilitating communication, and automating complex processes. 

Core Components of a Computer System (Hardware) 

Computer hardware consists of physical, tangible components. 

Input Devices 
Tools that allow users to enter data and instructions into the computer. 

• Keyboard: For entering text, numbers, and commands. The standard layout is QWERTY. 

• Mouse/Pointing Device: Controls the cursor on the screen for selection and navigation. 
Includes touchpads on laptops. 

• Scanner: Converts physical documents and images into a digital format. 

• Microphone: Inputs audio data. 

• Webcam: Captures live video and images. 

• Barcode Reader: Scans barcodes to input product information quickly. 

• Touch Screen: Serves as both an input (touch) and output (display) device. 

• Joystick/Gamepad: Used for gaming and simulations. 

• Light Pen: A historical pointing device for drawing directly on CRT screens. 
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The System Unit 
The central case that houses the primary electronic components. 

• Motherboard: The main circuit board that connects and allows communication between all 
components (CPU, RAM, storage, ports). 

• Central Processing Unit (CPU)/Microprocessor: The "brain" of the computer. It fetches, 
decodes, and executes instructions from memory. 

o Control Unit (CU): Directs and coordinates operations within the processor and manages 
the flow of data. 

o Arithmetic Logic Unit (ALU): Performs all mathematical calculations (addition, 
subtraction, etc.) and logical comparisons (AND, OR, NOT). 

o Registers: High-speed temporary storage locations within the CPU for holding data, 
instructions, and addresses currently being processed (e.g., Memory Address Register - 
MAR, Memory Data Register - MDR, Accumulator - AC, Program Counter - PC, Current 
Instruction Register - CIR). 

• Memory (Primary Storage): 

o Random Access Memory (RAM): Volatile, read/write memory. It temporarily holds the 
operating system, application programs, and data currently in use. It is much faster than 
secondary storage but loses its contents when power is off. 

o Read-Only Memory (ROM): Non-volatile memory that stores permanent, essential 
instructions like the BIOS (Basic Input/Output System) for booting the computer. Its contents 
are typically not modifiable by the user. 

o Cache Memory: Extremely fast, small memory located inside (L1) or close to (L2, L3) the 
CPU. It stores frequently used data and instructions to speed up processing by reducing the 
time the CPU waits for data from RAM. 

Storage Devices (Secondary/Backing Storage) 
Non-volatile media for the long-term retention of data, programs, and information. 

• Hard Disk Drive (HDD): Magnetic storage using spinning platters. Offers large capacity at 
a lower cost but is slower and more fragile than SSDs. 

• Solid State Drive (SSD): Chip-based storage using flash memory. Much faster, more 
durable, silent, and energy-efficient than HDDs, but typically more expensive per gigabyte. 

• Optical Discs: CDs, DVDs, and Blu-ray discs that use lasers to read and write data. 

• USB Flash Drive: Portable, rewritable chip-based storage. 
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• Memory Cards (SD Cards): Portable storage used in cameras, phones, and other devices. 

Output Devices 
Hardware used to present processed data (information) to the user. 

• Monitor/Visual Display Unit (VDU): Displays text, graphics, and video (soft copy). Types: 
CRT (older, bulky), LCD, LED (modern, flat-panel). 

• Printer: Produces physical hard copies. Types: Impact (e.g., dot-matrix) and Non-Impact 
(e.g., inkjet, laser). 

• Plotter: Used for printing large-scale graphics like engineering drawings and architectural 
blueprints. 

• Speakers/Headphones: Output audio. 

• Multimedia Projector: Projects the computer's display onto a larger surface like a wall or 
screen. 

Ports, Expansion Slots, and Cards 

• Ports: Interfaces on the system unit for connecting peripheral devices (e.g., USB, HDMI, 
Ethernet, audio jacks, VGA). 

• Expansion Slots: Sockets on the motherboard (e.g., PCI, PCI Express) where expansion 
cards can be inserted to add new capabilities. 

• Expansion Cards: Circuit boards that add new functions (e.g., graphics card for enhanced 
video, sound card for improved audio, network interface card for networking). 

Interaction among Components & the Environment 

Components interact seamlessly via the motherboard's buses and system software. For 
example, opening a file involves: 

1. Input: User double-clicks a file icon via the mouse. 

2. Processing: Signal sent to CPU via motherboard. 

3. Memory Access: CPU fetches the associated program instructions from RAM and the file 
data from storage (HDD/SSD). 

4. Execution: CU and ALU process the instructions to decode and display the file. 

5. Output: The file's content is displayed on the monitor. 
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The computer environment includes external factors like the power supply, network 
connections, all connected peripherals (printers, scanners), and the user themselves. 

Basic Operations of a Computer (IPO Cycle) 

All computer tasks, regardless of complexity, involve four fundamental operations: 

1. Input: Accepting data and instructions from the outside world. 

2. Processing: Manipulating and transforming the data as per instructions (performed by the 
CPU). 

3. Storage: Holding data, instructions, and intermediate or final results (in primary memory or 
secondary storage). 

4. Output: Presenting the processed information to the user. 

Computer Architecture: The Von Neumann Model 

Overview 

Proposed by mathematician John von Neumann, this is the fundamental architecture 
underlying almost all modern computers. Its key, revolutionary principle is the stored-
program concept, where both program instructions and data reside in the same memory 
unit. This allows programs to be easily modified and treated as data. 

Key Components 

1. Central Processing Unit (CPU): Contains the ALU, CU, and Registers. 

2. Memory Unit (RAM): A single store for both instructions and data. 

3. Input/Output (I/O) Devices: Facilitate communication with the external world. 

4. System Buses: Parallel electrical pathways for data transmission between components. 

o Data Bus: Carries the actual data being processed. 

o Address Bus: Carries the memory location (address) from which data is to be fetched or to 
which it is to be sent. 

o Control Bus: Carries control and timing signals (read, write, interrupt) from the CU to other 
units. 
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The Instruction Cycle (Fetch-Decode-Execute Cycle) 

The CPU executes instructions in a repetitive, continuous cycle: 

1. Fetch: The CU retrieves the next instruction from the memory address held in the Program 
Counter (PC) and loads it into the Current Instruction Register (CIR). The PC is then 
incremented. 

2. Decode: The CU interprets the instruction to determine what operation (opcode) is to be 
performed and on what data (operands). 

3. Execute: The appropriate component (often the ALU) performs the required calculation or 
operation (e.g., add two numbers, load data from memory). 

4. Store (Write Back): The result is written back to memory, a register, or sent to an output 
device. 

Characteristics, Advantages, and Disadvantages 

• Characteristics: Single memory store for data/instructions, sequential instruction execution, 
stored-program concept. 

• Advantages: Simplified design and construction, flexibility (programs are easily changed by 
modifying memory contents), efficiency. 

• Disadvantages: 

o Von Neumann Bottleneck: The shared bus system for transferring both instructions and 
data can limit the speed at which the CPU can process information, as only one piece of data 
can be transferred at a time. 

o Security Risk: Since instructions and data are stored together in the same memory space, a 
program could accidentally (or maliciously, as in a buffer overflow attack) modify other 
instructions or critical data. 

Software: The Driving Force 

Definition 

Software is a set of instructions, data, or programs that tell the computer hardware how to 
function and perform specific tasks. It acts as the essential interface between the user and the 
hardware, transforming a general-purpose machine into a specific tool. 
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System Software 

Manages and controls the hardware, providing a stable platform for running application 
software. 

• Operating System (OS): Essential software that manages hardware resources (CPU, 
memory, I/O), provides user interfaces (Graphical User Interface - GUI / Command Line 
Interface - CLI), runs applications, and handles file and memory 
management. Examples: Windows, macOS, Linux, Android, iOS. 

• Device Drivers: Specialized programs that enable the OS to communicate with and control 
specific hardware devices (e.g., printer driver, graphics card driver, scanner driver). 

• Utility Programs: Perform maintenance, optimization, and management tasks (e.g., antivirus 
software, disk cleanup/defragmentation, file compression tools (ZIP), backup software, 
system monitors). 

• Language Processors (Translators): Convert human-readable programming code into 
machine-executable code. 

o Compiler: Translates the entire high-level program (source code) into machine code (object 
code) at once. The resulting executable can be run independently. (e.g., C, C++ compilers). 

o Interpreter: Translates and executes the source code line-by-line. It does not produce a 
separate executable file. (e.g., Python, JavaScript interpreters). 

o Assembler: Translates assembly language (a low-level symbolic code) into machine code. 

Application Software 

Programs designed to help end-users perform specific tasks or solve particular problems. 

• Productivity Software: Word processors (MS Word), spreadsheets (MS Excel), presentation 
software (MS PowerPoint), database management systems (MS Access). 

• Business Software: Accounting packages (QuickBooks), Enterprise Resource Planning 
(ERP), Customer Relationship Management (CRM) software (Salesforce), payroll systems. 

• Entertainment Software: Video games, media players (VLC, Windows Media Player), 
video/audio editing software. 

• Educational Software: Learning Management Systems (LMS like Moodle), educational 
games, simulation software, classroom management tools. 
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• Graphic & Design Tools: Image editors (Adobe Photoshop, GIMP), vector graphics editors 
(Adobe Illustrator), computer-aided design (CAD) software, online design platforms 
(Canva). 

Software Terminologies 

• Open Source Software: Software whose source code is made freely available to the public 
to use, study, modify, and distribute. Examples: Linux kernel, Firefox web browser, 
LibreOffice suite, Apache web server. 

• Freeware: Copyrighted software that is distributed free of charge but typically with 
proprietary, unmodifiable source code. Examples: Skype, Adobe Reader, WhatsApp. 

• Shareware: Proprietary software that is offered on a trial basis free of charge; payment is 
required for continued legal use or to unlock full features after the trial period expires. 

Types of Computers 

Based on Technology and Data Representation 

• Analog Computers: Process continuous physical data (e.g., voltage, pressure, temperature). 
They measure inputs directly and provide output as a continuous signal. Less accurate but 
faster for simulations. Examples: Speedometer, thermometer, analog clock, traditional 
voltmeter. 

• Digital Computers: Process discrete data represented in binary digits (0s and 1s). They are 
general-purpose, highly accurate, and versatile. All modern general-purpose computers are 
digital. Examples: All modern PCs, smartphones, servers, calculators. 

• Hybrid Computers: Combine features of both analog and digital systems. They use analog 
components for fast input measurement and initial processing, and digital components for 
precision, complex calculation, storage, and logical control. Example: Medical equipment 
like ECG machines, ICU patient monitors, fuel pumps with digital price calculators. 

Classification of Digital Computers (by Size, Power & Purpose) 

1. Supercomputers: The most powerful, fastest, and most expensive computers. Used for 
highly complex scientific and engineering tasks that require immense 
calculations. Applications: Weather forecasting, nuclear research, cryptography, molecular 
modeling, astrophysics. Example: CRAY series, IBM Summit, Fugaku. 

2. Mainframe Computers: Large, powerful, highly reliable systems that support hundreds or 
thousands of users simultaneously. Used by large organizations for critical applications 
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requiring high-volume transaction processing. Applications: Banking, airline reservations, 
census data, enterprise resource planning. Examples: IBM Z series. 

3. Minicomputers (Mid-range Servers): Smaller than mainframes but larger than 
microcomputers, capable of supporting multiple users. Historically used by small 
businesses/departments. Largely replaced by powerful microcomputer-based servers and 
cloud solutions. 

4. Microcomputers (Personal Computers - PCs): The most common type, designed for 
individual use. 

o Desktop Computers 

o Laptop/Notebook Computers 

o Tablets 

o Smartphones (convergence devices) 

Cutting-Edge and Specialized Technologies 

• Smart Watches/Wearables: Wearable computers with health monitoring, connectivity, and 
app functionality. 

• Quantum Computers: Utilize quantum bits (qubits) that can exist in multiple states 
simultaneously (superposition). Potential to solve specific problems intractable for classical 
computers (e.g., complex cryptography, drug discovery, material science). 

• 3D Printers (Additive Manufacturing): Create physical objects from digital models by 
adding material layer by layer. 

• Biometric Systems: Use unique biological traits for identification and authentication (e.g., 
fingerprint scanners, facial recognition, iris scanners). 

Data Representation and Number Systems 

Machine-Level Representation 

At the machine level, all data is represented using binary digits (bits), which can be 
either 0 or 1. This binary system aligns with the two-state nature of electronic switches in 
computer hardware (ON/HIGH/1 and OFF/LOW/0). 

• A single binary digit is called a bit. 
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• Groups of bits form codes that represent all types of data: numbers, text, images, sound. 

• Example: The decimal number 5 is 101 in binary. The ASCII character 'A' is 01000001. 

Number Systems 

A number system defines a set of values and rules used to represent quantity. The four 
primary systems in computing are: 

System Base Digits/Symbols Primary Use 

Decimal 10 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 
Human-centric counting and 
math. 

Binary 2 0, 1 
Fundamental representation 
inside all computers. 

Octal 8 0, 1, 2, 3, 4, 5, 6, 7 
Compact representation of 
binary (historically significant). 

Hexadecimal 16 
0-9, A(10), B(11), 
C(12), D(13), E(14), 
F(15) 

Compact representation of 
binary; used for memory 
addresses, color codes. 

All are positional-value systems: the value of a digit depends on its position. 

• Most Significant Digit (MSD): Leftmost digit (carries the most weight). 

• Least Significant Digit (LSD): Rightmost digit (carries the least weight). 

Number System Conversions 

A. Conversion to Decimal (from any base): Multiply each digit by the base raised to its 
positional power (starting at 0 for the LSD) and sum the results. 

• Binary to Decimal: (1011.101)₂ = 1×2³ + 0×2² + 1×2¹ + 1×2⁰ + 1×2⁻¹ + 0×2⁻² + 1×2⁻³ = 
(11.625)₁₀ 

• Hexadecimal to Decimal: (3AF)₁₆ = 3×16² + 10×16¹ + 15×16⁰ = (943)₁₀ 
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B. Conversion from Decimal (to any base): 

• For the integer part: Repeatedly divide by the target base and record remainders in reverse 
order. 

• For the fractional part: Repeatedly multiply by the target base and record the integer parts 
in forward order. 

C. Direct Conversions Between Binary, Octal, and Hexadecimal: (Efficient because bases 
are powers of 2). 

• Binary ↔ Octal: Group binary digits into sets of 3 (from the binary point outward), pad if 
necessary, then convert each group to its octal digit (0-7). 

• Binary ↔ Hexadecimal: Group binary digits into sets of 4, then convert each group to its 
hex digit (0-9, A-F). 

• Octal ↔ Hexadecimal: Use binary as an intermediary (Octal → Binary → Hexadecimal, or 
vice-versa). 

Binary Arithmetic 

Computers perform all arithmetic using binary digits. 
Binary Addition: Rules: 0+0=0, 0+1=1, 1+0=1, 1+1=0 with a carry of 1 to the next higher 
bit. 
Binary Subtraction via Complements: To simplify hardware, subtraction is often 
performed using complements. 

• 1's Complement: Invert all bits of a binary number (0→1, 1→0). 

• 2's Complement: Add 1 to the 1's complement. This is the standard method for 
representing signed integers in modern computers. 

o To get 2's complement of a number: (1) Invert all bits (1's complement). (2) Add 1 to the 
result. 

o Subtraction using 2's Complement: A - B = A + (2's complement of B). Discard any final 
carry-out bit. 

Signed vs. Unsigned Numbers 

• Unsigned Numbers: All bits represent the magnitude. Range for n bits: 0 to (2ⁿ - 1). 

• Signed Numbers (using 2's Complement): The most significant bit (MSB) acts as the sign 
bit (0 for positive, 1 for negative). Range for n bits: -2⁽ⁿ⁻¹⁾ to +(2⁽ⁿ⁻¹⁾ - 1). 
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Character Encoding 

ASCII (American Standard Code for Information Interchange): 

• Original ASCII-7: Uses 7 bits, representing 128 characters (letters A-Z/a-z, digits 0-9, 
punctuation, control codes). 

• Extended ASCII-8: Uses 8 bits (1 byte), representing 256 characters, including additional 
symbols and accented letters. 

• Key Ranges: Digits '0'-'9' = 48-57; Uppercase 'A'-'Z' = 65-90; Lowercase 'a'-'z' = 97-122. 

Unicode: A universal character set designed to support all written languages of the world 
(over 100,000 characters). It is compatible with ASCII. Common encoding forms: 

• UTF-8: Variable-length (1-4 bytes per character), most common on the web. Backward 
compatible with ASCII. 

• UTF-16: Uses one or two 16-bit code units. 

• UTF-32: Fixed-length 32-bit representation. 

Operating Systems: Core Concepts 

Definition and Core Functions 

An Operating System (OS) is essential system software that acts as an intermediary 
between users/application programs and the computer hardware. It manages resources and 
provides common services. 

1. Process Management: Creates, schedules, synchronizes, and terminates processes; allocates 
CPU time. 

2. Memory Management: Allocates and deallocates memory space for programs; manages 
swapping between RAM and secondary storage (virtual memory). 

3. File Management: Creates, reads, writes, deletes, and organizes files and directories on 
storage devices. 

4. Device Management: Controls and coordinates input/output devices via drivers. 

5. Security & Protection: Enforces access controls, user authentication, and protects system 
resources. 
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6. User Interface: Provides interfaces (GUI/CLI) for user interaction. 

Process Management in Detail 

• Process: A program in execution. It is a dynamic entity (with a Process Control Block - 
PCB) residing in RAM, as opposed to a static program file on disk. 

• Process States: New → Ready → Running → Blocked/Waiting → Terminated. 

• Thread: A lightweight unit of execution within a process. A single process can contain 
multiple threads that share resources (memory, files) but can execute independently, enabling 
concurrency. 

• Process Scheduler: OS component that selects which ready process runs next on the CPU 
using algorithms (First-Come-First-Served, Shortest Job Next, Round Robin, Priority). 

• Interrupts: Signals from hardware or software that require immediate CPU attention, 
causing it to pause and execute an Interrupt Service Routine (ISR). 

• Deadlock: A situation where two or more processes are stuck, each waiting for a resource 
held by the other, preventing any progress. 

Types of Operating Systems 

• Batch Processing OS: Processes similar jobs in groups ("batches") without user interaction. 

• Multitasking/Time-Sharing OS: Allows multiple users/tasks to interact concurrently by 
rapidly switching CPU time, creating the illusion of simultaneous execution (e.g., Windows, 
macOS, Linux). 

• Real-Time OS (RTOS): Designed for time-critical applications with strict deadlines (e.g., 
medical systems, robotics, industrial controllers). Can be Hard RTOS (absolute deadline) or 
Soft RTOS (preferred deadline). 

• Distributed OS: Manages a group of networked computers as a single, cohesive system, 
transparently distributing tasks. 

• Embedded OS: Built into the hardware of a dedicated device with limited resources (e.g., 
microwave, car engine controller, smartwatch - FreeRTOS, Embedded Linux). 

File Systems 

A file system organizes, stores, retrieves, and manages data on storage devices. 
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• Structure: Hierarchical (tree-structured) using directories/folders and files. 

• File Allocation Methods: 

o Contiguous: File occupies consecutive disk blocks. Fast access but prone to external 
fragmentation. 

o Linked: File blocks are scattered but linked via pointers. Efficient space use, but slow for 
random access. 

o Indexed: Uses an index block (like a file's table of contents) to point to all data blocks. Good 
balance. 

• Common File Systems: NTFS (Windows), APFS (macOS), ext4 (Linux), FAT32 
(removable drives). 

Data Communication and Networks 

Fundamentals and Components 

Data communication is the process of exchanging data between two or more devices via a 
transmission medium. 

• Components: Sender → Message/Data → Transmission  

Modes of Data Transmission 

• Simplex: One-way only (e.g., keyboard to computer, traditional TV/radio broadcast). 

• Half-Duplex: Two-way communication, but only one direction at a time (e.g., walkie-
talkies). 

• Full-Duplex: Two-way simultaneous communication (e.g., telephone call, modern network 
connection). 

Communication Devices 

• Hub: Basic connector that broadcasts incoming data to all devices on a network segment. 
Inefficient. 

• Switch: Intelligent device that learns device addresses (MAC) and directs data only to the 
specific intended port, improving network efficiency. 
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• Router: Connects different networks (e.g., a home LAN to the Internet). Routes data packets 
between networks based on IP addresses. 

• Gateway: A router that connects networks using different communication protocols. 

Network Types (by Geographical Scope) 

• Personal Area Network (PAN): Very small area, around an individual (e.g., Bluetooth 
connection). 

• Local Area Network (LAN): Covers a small area like a building, home, or campus. High 
speed, low error rate, owned by the organization. Example: School computer lab, office 
network. 

• Metropolitan Area Network (MAN): Covers a city or large campus (size between LAN 
and WAN). Example: City-wide Wi-Fi. 

• Wide Area Network (WAN): Spans large geographical areas (cities, countries, globally). 
Connects multiple LANs. Often uses leased telecommunication lines. Example: The 
Internet. 

Network Architectures 

• Client-Server Network: Dedicated, powerful servers provide resources (files, applications, 
email) to client computers. Centralized, easier to manage, secure, and backup. Common in 
businesses. 

• Peer-to-Peer (P2P) Network: All computers (peers) have equal status, acting as both clients 
and servers. Simpler and cheaper for very small networks (e.g., home), but less secure and 
less manageable as it scales. 

Network Topologies (Physical/Logical Layout) 

• Bus Topology: All devices connected to a single backbone cable. Simple, low cost, but a 
cable break disables the network. Poor scalability. 

• Star Topology: All devices connected to a central hub or switch. Easy to install/manage; 
failure of one node doesn't affect others. Central device is a single point of failure. 

• Ring Topology: Devices connected in a closed loop. Data travels in one direction (often 
token-passing). Orderly access, but a single node/cable failure can break the entire ring. 
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• Mesh Topology: Every device is connected to every other device. Highly reliable (redundant 
paths) and high performance, but very expensive and complex to wire and manage. Common 
in backbone networks. 

• Hybrid Topology: Combination of two or more basic topologies to leverage their 
advantages (e.g., Star-Bus, Star-Ring). 

The Internet and World Wide Web 

• Internet: A global, public WAN – a "network of networks" connecting billions of devices 
using standardized protocols (TCP/IP). 

• Key Concepts: 

o TCP/IP Suite: The fundamental communication protocol of the Internet (Transmission 
Control Protocol / Internet Protocol). 

o Packet-Switching: Data is broken into packets, sent independently across the network via 
the best available routes, and reassembled at the destination. 

o Domain Name System (DNS): Translates human-readable domain names 
( [www.example.com]{.underline} ) into machine-readable IP addresses (e.g., 192.0.2.1). 

• World Wide Web (WWW): An information system on the Internet where documents and 
resources are identified by URLs, linked via hypertext, and accessed via browsers using 
HTTP/HTTPS. 

Software Development Life Cycle (SDLC) 

Phases of the SDLC 

A structured process for planning, creating, testing, and deploying high-quality software. 

1. Planning & Feasibility Study: Define project scope, estimate resources/costs/schedule. 
Assess technical, economic, operational, and legal feasibility. 

2. Requirement Analysis & Engineering: Gather, analyze, validate, and document detailed 
functional and non-functional requirements from stakeholders. 

3. System Design: Create high-level (architecture) and low-level (detailed) design. Define 
system components, data flow, algorithms, and user interfaces (using tools like UML, 
flowcharts). 

https://www.example.com/
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4. Development/Coding: Write the actual program code in the chosen programming 
language(s), following coding standards. 

5. Testing: Systematic process to identify defects. 

o Levels: Unit Testing (individual modules), Integration Testing (combined modules), System 
Testing (entire system), Acceptance Testing (by client). 

o Types: Black Box (tests functionality without seeing code), White Box (tests internal logic 
and structures of the code). 

o Debugging: The process of identifying the root cause of a bug (error) and fixing it. 

6. Deployment/Implementation: Making the software operational for end-users. 

o Methods: Direct (immediate cutover), Parallel (run old & new simultaneously), Phased 
(gradual rollout), Pilot (limited group first). 

7. Maintenance & Support: Fixing issues (corrective), adapting to new environments 
(adaptive), improving performance (perfective), and preventing future problems (preventive). 

Software Development Models 

• Waterfall Model: Linear, sequential phases. Simple to understand, good for stable, well-
defined requirements. Inflexible to changes late in the cycle. 

• Agile Model: Iterative and incremental. Development occurs in small cycles (sprints), with 
continuous feedback and adaptation. Emphasizes flexibility, collaboration, and customer 
satisfaction. Suitable for projects with evolving requirements. Frameworks: Scrum, Kanban. 

Digital Logic and Circuit Design 

Analog vs. Digital Signals 

Feature Analog Signal Digital Signal 

Nature Continuous waveform, infinite 
values within a range. 

Discrete, represents data using 
binary values (0/1). 
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Noise 
Immunity 

Susceptible to noise and 
degradation; quality loss when 
copied. 

More resistant to noise; can be 
regenerated perfectly. 

Examples Human voice, analog radio, vinyl 
records. 

MP3 files, digital TV, data in 
computer memory. 

11.2 Logic Gates 

Fundamental building blocks of digital circuits. They perform basic logical functions on one 
or more binary inputs to produce a single binary output. 

Gate 
Boolean Expression 

(2-input) 
Truth Table 

(A B | F) 
Function 

AND F = A · B 0 0 | 0 
0 1 | 0 
1 0 | 0 
1 1 | 1 

Output is 1 only if ALL inputs 
are 1. 

OR F = A + B 0 0 | 0 
0 1 | 1 
1 0 | 1 
1 1 | 1 

Output is 1 if AT LEAST ONE 
input is 1. 

NOT F = Ā (or A') 0 | 1 
1 | 0 

Output is the inverse 
(complement) of the input. 

NAND F = A⋅B‾A⋅B 0 0 | 1 
0 1 | 1 
1 0 | 1 
1 1 | 0 

Output is 0 only if ALL inputs 
are 1 (AND + NOT). 

NOR F = A+B‾A+B 0 0 | 1 
0 1 | 0 

Output is 1 only if ALL inputs 
are 0 (OR + NOT). 
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1 0 | 0 
1 1 | 0 

XOR F = A ⊕ B 0 0 | 0 
0 1 | 1 
1 0 | 1 
1 1 | 0 

Output is 1 only if inputs are 
DIFFERENT. 

Boolean Algebra and Simplification 

• Boolean Algebra: A mathematical system for logic operations using variables that can be 
true (1) or false (0) and operators (AND, OR, NOT). 

• Truth Table: Lists all possible input combinations and their corresponding output for a 
Boolean function or logic circuit. 

• Boolean Identities: Fundamental laws (Identity, Domination, Idempotent, Complement, 
Commutative, Associative, Distributive, De Morgan's Theorem) used to simplify 
expressions, leading to circuits with fewer gates. 

• Karnaugh Maps (K-Maps): A graphical method for simplifying Boolean expressions. 
Adjacent 1s on the map (grouped in powers of two) represent terms where variables can be 
eliminated. 

Applications of Logic Gates 

Logic gates are combined to build complex digital systems: 

• Arithmetic Circuits: Adders (Half-Adder, Full-Adder), Subtractors, built into the ALU. 

• Memory Elements: Flip-flops and latches (basic 1-bit storage) which form registers and 
RAM. 

• Combinational Circuits: Multiplexers (select one of many inputs), Demultiplexers, 
Encoders, Decoders. 

• Control Systems: Traffic light controllers, elevator controllers, digital watches. 

Emerging Paradigms: Cloud Computing and Cybersecurity 

Cloud Computing Fundamentals 
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The on-demand delivery of IT resources (servers, storage, databases, networking, software, 
analytics) over the internet with pay-as-you-go pricing. 

Key Characteristics: On-Demand Self-Service, Broad Network Access, Resource Pooling, 
Rapid Elasticity, Measured Service. 

Service Models: 

• Infrastructure as a Service (IaaS): Rents fundamental computing resources (VMs, storage, 
networks). User manages OS, apps, data. Example: Amazon EC2, DigitalOcean. 

• Platform as a Service (PaaS): Provides a platform (OS, database, web server, development 
tools) for developing and deploying applications. User manages apps and data 
only. Example: Google App Engine, Microsoft Azure App Services. 

• Software as a Service (SaaS): Delivering software applications over the internet, on a 
subscription basis. User only uses the software. Example: Gmail, Microsoft 365, Salesforce. 

Deployment Models: 

• Public Cloud: Resources owned/operated by a third-party provider and shared by multiple 
organizations (e.g., AWS, Azure, Google Cloud). 

• Private Cloud: Cloud infrastructure used exclusively by a single organization (more control, 
higher cost). 

• Hybrid Cloud: Combines public and private clouds, allowing data and applications to be 
shared between them for flexibility. 

Cybersecurity Principles 

The practice of protecting systems, networks, programs, and data from digital attacks, 
damage, or unauthorized access. 

Common Cyber Threats: 

• Malware: Malicious software (Viruses, Worms, Trojans, Ransomware, Spyware, Adware). 

• Phishing/Spear Phishing: Deceptive emails/websites designed to steal sensitive 
information. 

• Denial-of-Service (DoS) / Distributed DoS (DDoS): Overwhelming a system with traffic to 
make it unavailable. 

• Man-in-the-Middle (MitM) Attacks: Intercepting communication between two parties. 
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• Insider Threats: Malicious actions by employees or trusted individuals. 

Essential Protection Measures: 

• Defense in Depth: Use multiple, layered security controls. 

• Strong Authentication: Use strong, unique passwords and Multi-Factor Authentication 
(MFA). 

• Regular Updates: Patch OS, applications, and firmware promptly. 

• Firewalls & Antivirus: Deploy network firewalls and endpoint protection. 

• Encryption: Protect data at rest (storage) and in transit (network). Symmetric (single key, 
e.g., AES) and Asymmetric (public/private key pair, e.g., RSA) encryption. 

• Backups: Maintain regular, tested backups of critical data (3-2-1 rule). 

• User Education & Awareness: Train users to recognize and report threats. 

Human-Computer Interaction (HCI), Usability, and Ethics 

Human-Computer Interaction (HCI) 

The study of how people interact with computers and the design of user-friendly, efficient, 
and accessible interfaces. 

• Elements: User, Task, Interface (GUI, voice, touch), Environment. 

Usability 

The measure of how effectively, efficiently, and satisfactorily a user can achieve goals in a 
particular context. 

• Key Components: Learnability, Efficiency, Memorability, Error Handling, Satisfaction. 

• Usability Testing: Methods include Moderated/Unmoderated, Qualitative 
(interviews)/Quantitative (metrics), A/B Testing. 

Accessibility 

Designing systems to be usable by people with a wide range of abilities and disabilities. 

• Principles (POUR): Perceivable, Operable, Understandable, Robust. 
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• Solutions: Screen readers, captions, keyboard navigation, voice control, high-contrast 
modes. 

Ethics and Societal Impact 

System design involves balancing competing priorities like Usability vs. Security (e.g., 
complex passwords vs. user convenience). 

• Ethical Considerations: Data privacy, user consent, algorithmic bias, transparency. 

• Societal Impact: Digital divide, effects on employment, environmental impact (e-waste, 
energy use), social media influence. 

This master chapter integrates the complete foundational knowledge of computer systems, 
from basic components and data representation to advanced concepts in networking, software 
development, and modern computing paradigms, providing a comprehensive and self-
contained resource.
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One Liners: Introduction to Computing and ICT 

1. ICT is an umbrella term for computing tools enabling interaction in the digital world, 
representing the convergence of telephone and computer networks. 

2. A system is a collection of interconnected components working cohesively to achieve a 
specific objective by processing inputs into outputs. 

3. The four fundamental concepts describing any system are its Objective, Components, 
Environment, and Communication/Interaction. 

4. Natural systems occur organically, are self-regulated, adaptable, and governed by natural 
laws, such as ecosystems and the human body. 

5. Artificial systems are human-designed, structured, require maintenance, and operate under 
predefined rules, like engineering, social, and computer systems. 

6. Natural systems are governed by natural laws, while artificial systems operate under 
human-defined rules and protocols. 

7. Design Science focuses on creating new artificial systems, like conservation software, to 
solve problems. 

8. A computer is a programmable electronic device that accepts input, processes it according 
to stored instructions, produces output, and stores results. 

9. The primary objectives of a computer system are to perform computations, process data, 
and execute tasks efficiently to provide useful information. 

10. An input device allows users to enter data and instructions into a computer, such as a 
keyboard, mouse, or scanner. 

11. The standard keyboard layout is QWERTY. 
12. A touch screen serves as both an input (touch) and output (display) device. 
13. The system unit houses the primary electronic components of a computer, including the 

motherboard and CPU. 
14. The motherboard is the main circuit board connecting all components like the CPU, RAM, 

storage, and ports. 
15. The CPU, or microprocessor, is the computer's "brain," responsible for fetching, decoding, 

and executing instructions. 
16. The Control Unit (CU) directs and coordinates operations within the processor and 

manages data flow. 
17. The Arithmetic Logic Unit (ALU) performs all mathematical calculations and logical 

comparisons. 
18. Registers are high-speed temporary storage locations within the CPU for data and 

addresses being processed. 
19. The Memory Address Register (MAR) holds the memory location of data to be fetched or 

stored. 
20. The Memory Data Register (MDR) holds the data fetched from or to be written to 

memory. 
21. The Program Counter (PC) holds the address of the next instruction to be executed. 
22. The Current Instruction Register (CIR) holds the instruction currently being decoded and 

executed. 
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23. Random Access Memory (RAM) is volatile, read/write memory that temporarily holds the 
OS, applications, and data in use. 

24. Read-Only Memory (ROM) is non-volatile memory storing permanent, essential 
instructions like the BIOS. 

25. Cache memory is extremely fast memory located close to the CPU to store frequently used 
data and speed up processing. 

26. Secondary storage devices provide non-volatile, long-term retention of data, programs, 
and information. 

27. Hard Disk Drives (HDD) use magnetic storage on spinning platters, offering large 
capacity at lower cost but are slower than SSDs. 

28. Solid State Drives (SSD) use chip-based flash memory, offering faster speeds, durability, 
and energy efficiency than HDDs. 

29. Output devices present processed data to the user, such as monitors (soft copy) and 
printers (hard copy). 

30. A plotter is an output device used for printing large-scale graphics like engineering 
drawings. 

31. Ports are interfaces on the system unit for connecting peripheral devices (e.g., USB, 
HDMI). 

32. Expansion slots on the motherboard allow the insertion of expansion cards to add new 
capabilities like enhanced graphics or audio. 

33. The computer's environment includes external factors like the power supply, network 
connections, peripherals, and the user. 

34. The fundamental operations of a computer are Input, Processing, Storage, and Output, 
known as the IPO cycle. 

35. The Von Neumann architecture's revolutionary principle is the stored-program concept, 
where both instructions and data reside in the same memory. 

36. In the Von Neumann model, the CPU contains the ALU, CU, and Registers. 
37. The three types of system buses are the Data Bus, Address Bus, and Control Bus. 
38. The Data Bus carries the actual data being processed between components. 
39. The Address Bus carries memory location (address) information. 
40. The Control Bus carries control and timing signals, such as read and write commands. 
41. The instruction cycle consists of four stages: Fetch, Decode, Execute, and Store (Write 

Back). 
42. During the Fetch stage, the CU retrieves an instruction from memory into the CIR and 

increments the Program Counter. 
43. The Von Neumann Bottleneck is the limitation in processing speed caused by the shared 

bus system transferring both instructions and data. 
44. A security risk in the Von Neumann architecture is that instructions and data share the 

same memory, allowing a program to accidentally or maliciously modify other 
instructions. 

45. Software is a set of instructions, data, or programs that tell computer hardware how to 
function and perform tasks. 

46. System software manages and controls hardware, providing a stable platform for 
application software. 
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47. The Operating System (OS) manages hardware resources, provides user interfaces, runs 
applications, and handles file and memory management. 

48. Device drivers are specialized programs enabling the OS to communicate with and control 
specific hardware devices. 

49. Utility programs perform maintenance tasks like antivirus scanning, disk cleanup, and file 
compression. 

50. A compiler translates an entire high-level program into machine code at once, producing 
an independent executable file. 

51. An interpreter translates and executes source code line-by-line, without producing a 
separate executable. 

52. An assembler translates assembly language (low-level symbolic code) into machine code. 
53. Application software helps end-users perform specific tasks, such as using a word 

processor or spreadsheet. 
54. Open Source Software has its source code made freely available for use, study, 

modification, and distribution (e.g., Linux). 
55. Freeware is copyrighted software distributed free of charge, but its source code is typically 

not modifiable (e.g., Adobe Reader). 
56. Shareware is proprietary software offered on a trial basis; payment is required for 

continued use or full features. 
57. The first generation of computers (1940-1956) used vacuum tubes, were large, expensive, 

slow, and consumed high power. 
58. The second generation of computers (1956-1963) used transistors, making them smaller, 

faster, and more reliable than the first generation. 
59. The third generation of computers (1964-1971) used Integrated Circuits (ICs), leading to 

significant reductions in size, cost, and power consumption. 
60. The fourth generation of computers (1971-Present) uses microprocessors (VLSI), placing 

the entire CPU on a single chip and enabling the PC revolution. 
61. The fifth generation of computers focuses on Artificial Intelligence (AI), natural language 

processing, and parallel processing. 
62. Analog computers process continuous physical data, such as voltage or temperature, and 

are less accurate but faster for simulations. 
63. Digital computers process discrete data represented in binary digits (0s and 1s) and are 

highly accurate and versatile. 
64. Hybrid computers combine analog and digital systems, using analog for fast measurement 

and digital for precision and control. 
65. Supercomputers are the most powerful, fastest, and most expensive computers, used for 

highly complex scientific tasks. 
66. Mainframe computers are large, powerful systems that support hundreds or thousands of 

users simultaneously for critical, high-volume transaction processing. 
67. Microcomputers, or Personal Computers (PCs), are designed for individual use and are the 

most common computer type. 
68. Quantum computers use qubits, which can exist in superposition, potentially solving 

problems intractable for classical computers. 
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69. At the machine level, all data is represented using binary digits (bits), which align with the 
two-state nature of electronic switches. 

70. A single binary digit is called a bit. 
71. A number system defines a set of values and rules used to represent quantity; the four 

primary systems in computing are Decimal, Binary, Octal, and Hexadecimal. 
72. Decimal system has a base of 10 and uses digits 0-9. 
73. Binary system has a base of 2 and uses digits 0 and 1. 
74. Octal system has a base of 8 and uses digits 0-7. 
75. Hexadecimal system has a base of 16 and uses digits 0-9 and letters A-F. 
76. The Most Significant Digit (MSD) is the leftmost digit in a number, carrying the most 

weight. 
77. The Least Significant Digit (LSD) is the rightmost digit in a number, carrying the least 

weight. 
78. To convert from any base to decimal, multiply each digit by the base raised to its 

positional power and sum the results. 
79. To convert the integer part of a decimal number to another base, repeatedly divide by the 

target base and record remainders in reverse order. 
80. To convert the fractional part of a decimal number, repeatedly multiply by the target base 

and record integer parts in forward order. 
81. Binary to Octal conversion involves grouping binary digits into sets of 3 and converting 

each group to its octal digit. 
82. Binary to Hexadecimal conversion involves grouping binary digits into sets of 4 and 

converting each group to its hex digit. 
83. The binary addition rule 1+1 equals 0 with a carry of 1 to the next higher bit. 
84. The 1's complement of a binary number is obtained by inverting all its bits (0→1, 1→0). 
85. The 2's complement is found by adding 1 to the 1's complement and is the standard 

method for representing signed integers. 
86. Subtraction using 2's complement is performed as A - B = A + (2's complement of B). 
87. In signed numbers using 2's complement, the Most Significant Bit (MSB) acts as the sign 

bit (0 for positive, 1 for negative). 
88. The range for an n-bit unsigned number is 0 to (2ⁿ - 1). 
89. The range for an n-bit signed number using 2's complement is -2⁽ⁿ⁻¹⁾ to +(2⁽ⁿ⁻¹⁾ - 1). 
90. ASCII-7 uses 7 bits, representing 128 characters including letters, digits, and control 

codes. 
91. In ASCII, the digit '0' has a decimal value of 48, 'A' has 65, and 'a' has 97. 
92. Unicode is a universal character set designed to support all written languages of the world, 

compatible with ASCII. 
93. UTF-8 is a variable-length Unicode encoding (1-4 bytes per character) that is backward 

compatible with ASCII. 
94. An Operating System acts as an intermediary between users/application programs and 

computer hardware. 
95. Core OS functions include Process Management, Memory Management, File 

Management, Device Management, Security, and providing a User Interface. 
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96. A process is a program in execution, a dynamic entity with a Process Control Block 
(PCB), as opposed to a static program file. 

97. A thread is a lightweight unit of execution within a process; multiple threads in a process 
can execute independently and share resources. 

98. The process states are New, Ready, Running, Blocked/Waiting, and Terminated. 
99. The Process Scheduler selects which ready process runs next on the CPU using algorithms 

like Round Robin or Priority. 
100. An interrupt is a signal from hardware or software requiring immediate CPU attention, 

causing it to execute an Interrupt Service Routine (ISR). 
101. A deadlock is a situation where two or more processes are each waiting for a resource held 

by the other, preventing any progress. 
102. A Real-Time OS (RTOS) is designed for time-critical applications with strict deadlines, 

such as medical systems or robotics. 
103. An Embedded OS is built into the hardware of a dedicated device with limited resources, 

like a smartwatch or car controller. 
104. In a file system, contiguous allocation assigns consecutive disk blocks to a file, allowing 

fast access but causing external fragmentation. 
105. Linked file allocation stores file blocks scattered across the disk, linked by pointers, which 

is space-efficient but slow for random access. 
106. Indexed file allocation uses an index block to point to all data blocks of a file, offering a 

good balance between access speed and management. 
107. Data communication involves a Sender, Message, Transmission Medium, Protocol, and 

Receiver. 
108. In simplex mode, data transmission is one-way only (e.g., keyboard to computer). 
109. In half-duplex mode, two-way communication is possible, but only one direction at a time 

(e.g., walkie-talkies). 
110. In full-duplex mode, two-way simultaneous communication occurs (e.g., telephone call). 
111. A hub is a basic network connector that broadcasts incoming data to all devices on a 

segment, making it inefficient. 
112. A switch is an intelligent network device that learns MAC addresses and directs data only 

to the specific intended port. 
113. A router connects different networks (e.g., a LAN to the Internet) and routes data packets 

based on IP addresses. 
114. A gateway is a router that connects networks using different communication protocols. 
115. A LAN (Local Area Network) covers a small area like a building, offers high speed, and is 

typically owned by the organization. 
116. A WAN (Wide Area Network) spans large geographical areas, connects multiple LANs, 

and often uses leased telecommunication lines. 
117. In a Client-Server network, dedicated servers provide resources to client computers, 

offering centralized management and security. 
118. In a Peer-to-Peer (P2P) network, all computers have equal status, acting as both clients 

and servers, which is simpler but less secure. 
119. In a bus topology, all devices connect to a single backbone cable; a cable break can 

disable the entire network. 
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120. In a star topology, all devices connect to a central hub/switch; failure of one node doesn't 
affect others, but the central device is a single point of failure. 

121. In a ring topology, devices are connected in a closed loop with data traveling in one 
direction; a single node failure can break the ring. 

122. In a mesh topology, every device is connected to every other device, providing high 
reliability through redundant paths but at high cost and complexity. 

123. The Internet is a global public WAN, a "network of networks" using standardized TCP/IP 
protocols. 

124. Packet-switching involves breaking data into packets, sending them independently via the 
best routes, and reassembling them at the destination. 

125. DNS (Domain Name System) translates human-readable domain names into machine-
readable IP addresses. 

126. The World Wide Web (WWW) is an information system on the Internet where documents 
are identified by URLs and linked via hypertext. 

127. The first phase of the Software Development Life Cycle (SDLC) is Planning & Feasibility 
Study, which assesses technical, economic, and operational viability. 

128. Requirement Analysis involves gathering, analyzing, validating, and documenting detailed 
functional and non-functional requirements. 

129. System Design involves creating high-level architecture and low-level detailed designs, 
often using tools like UML. 

130. In the Testing phase, Unit Testing checks individual modules, Integration Testing checks 
combined modules, and System Testing checks the entire system. 

131. Black Box testing examines functionality without seeing the internal code, while White 
Box testing examines internal logic and structures. 

132. Debugging is the process of identifying the root cause of a software bug and fixing it. 
133. Deployment methods include Direct cutover, Parallel running, Phased rollout, and Pilot 

implementation with a limited group. 
134. Software Maintenance includes Corrective (fixing bugs), Adaptive (adapting to new 

environments), Perfective (improving performance), and Preventive activities. 
135. The Waterfall model is a linear, sequential SDLC model suitable for projects with stable, 

well-defined requirements. 
136. The Agile model is iterative and incremental, emphasizing flexibility, collaboration, and 

customer satisfaction through small development cycles called sprints. 
137. An analog signal is a continuous waveform with infinite values within a range, such as a 

human voice, and is susceptible to noise. 
138. A digital signal is discrete, representing data using binary values (0/1), and is more 

resistant to noise as it can be regenerated. 
139. An AND logic gate outputs 1 only if all its inputs are 1. 
140. An OR logic gate outputs 1 if at least one of its inputs is 1. 
141. A NOT logic gate outputs the inverse (complement) of its single input. 
142. A NAND gate is a combination of an AND gate followed by a NOT gate; it outputs 0 only 

if all inputs are 1. 
143. A NOR gate is a combination of an OR gate followed by a NOT gate; it outputs 1 only if 

all inputs are 0. 
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144. An XOR (Exclusive OR) gate outputs 1 only if its inputs are different. 
145. Boolean Algebra is a mathematical system for logic operations using variables that can be 

true (1) or false (0). 
146. A truth table lists all possible input combinations and their corresponding output for a 

Boolean function. 
147. De Morgan's Theorem states that the complement of a conjunction is the disjunction of the 

complements, and vice versa. 
148. A Karnaugh Map (K-Map) is a graphical method for simplifying Boolean expressions by 

grouping adjacent 1s. 
149. A half-adder is a combinational circuit that adds two single binary digits and produces a 

sum and a carry output. 
150. A full-adder adds three single binary digits (including a carry-in) and produces a sum and 

a carry-out. 
151. A flip-flop is a basic 1-bit memory element that forms the building block for registers and 

RAM. 
152. Cloud computing delivers IT resources over the internet with on-demand self-service, 

broad network access, and pay-as-you-go pricing. 
153. IaaS (Infrastructure as a Service) rents fundamental computing resources like VMs and 

storage; the user manages the OS and applications. 
154. PaaS (Platform as a Service) provides a platform for developing and deploying 

applications; the user manages only the apps and data. 
155. SaaS (Software as a Service) delivers software applications over the internet on a 

subscription basis; the user only uses the software. 
156. Public cloud resources are owned by a third-party provider and shared by multiple 

organizations. 
157. Private cloud infrastructure is used exclusively by a single organization, offering more 

control at a higher cost. 
158. Malware is malicious software, encompassing viruses, worms, Trojans, ransomware, 

spyware, and adware. 
159. Phishing uses deceptive emails or websites to steal sensitive information like passwords or 

credit card numbers. 
160. A Denial-of-Service (DoS) attack overwhelms a system with traffic to make it unavailable 

to legitimate users. 
161. Multi-Factor Authentication (MFA) requires two or more verification factors to gain 

access, significantly improving security. 
162. Symmetric encryption uses a single shared key for both encryption and decryption (e.g., 

AES). 
163. Asymmetric encryption uses a public/private key pair, where the public key encrypts and 

the private key decrypts (e.g., RSA). 
164. The 3-2-1 backup rule advises having at least 3 total copies of data, 2 of which are on 

different media, and 1 stored offsite. 
165. Human-Computer Interaction (HCI) studies how people interact with computers and 

designs user-friendly, efficient interfaces. 
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166. Usability measures how effectively, efficiently, and satisfactorily a user can achieve goals 
with a product. 

167. Usability testing methods include moderated/unmoderated sessions and A/B testing. 
168. Accessibility design principles (POUR) aim for systems that are Perceivable, Operable, 

Understandable, and Robust for all users. 
169. Screen readers and captions are examples of accessibility solutions for visually and 

hearing-impaired users. 
170. A key ethical consideration in system design is balancing Usability vs. Security, such as 

complex passwords versus user convenience. 
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Practice MCQs
1. In the context of systems, which of the 
following is NOT one of the four 
fundamental concepts that describe any 
system? 
a) Objective/Purpose 
b) Components 
c) Efficiency 
d) Environment 
Answer: c) Efficiency 

2. What is the key, revolutionary 
principle proposed by John von 
Neumann that underlies almost all 
modern computer architectures? 
a) The use of vacuum tubes 
b) The stored-program concept 
c) The Harvard architecture separation 
d) Binary arithmetic logic 
Answer: b) The stored-program 
concept 

3. During the Fetch stage of the 
instruction cycle, what happens to the 
Program Counter (PC) after an 
instruction is retrieved? 
a) It is decremented 
b) It is loaded with the address of the 
fetched instruction 
c) It is incremented 
d) It is compared with the CIR 
Answer: c) It is incremented 

4. Which component of the CPU is 
specifically responsible for performing 
all mathematical calculations and logical 
comparisons? 
a) Control Unit (CU) 
b) Memory Data Register (MDR) 
c) Arithmetic Logic Unit (ALU) 
d) Cache Memory 
Answer: c) Arithmetic Logic Unit 
(ALU) 

5. What is the primary vulnerability 
associated with the Von Neumann 
architecture that can be exploited in 
attacks like buffer overflows? 
a) Slow processing speed due to the 
bottleneck 
b) Instructions and data residing in 
separate memory units 
c) Instructions and data residing in the 
same memory space 
d) The use of a single system bus 
Answer: c) Instructions and data 
residing in the same memory space 

6. Which of the following best 
distinguishes a compiler from an 
interpreter? 
a) A compiler is used for system 
software, an interpreter for application 
software. 
b) A compiler translates code line-by-
line, while an interpreter translates the 
entire program at once. 
c) A compiler translates the entire source 
code into machine code at once, 
producing an executable. 
d) An interpreter produces an object file, 
while a compiler does not. 
Answer: c) A compiler translates the 
entire source code into machine code 
at once, producing an executable. 

7. A software that is copyrighted and 
distributed free of charge, but whose 
source code is typically not modifiable 
by the user, is classified as: 
a) Open Source Software 
b) Shareware 
c) Freeware 
d) Firmware 
Answer: c) Freeware 
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8. The technological shift from vacuum 
tubes to transistors primarily 
characterized which generation of 
computers? 
a) First to Second 
b) Second to Third 
c) Third to Fourth 
d) Fourth to Fifth 
Answer: a) First to Second 

9. Which type of computer is 
specifically designed to process 
continuous physical data like voltage or 
pressure and is considered faster for 
simulations but less accurate? 
a) Digital Computer 
b) Hybrid Computer 
c) Analog Computer 
d) Quantum Computer 
Answer: c) Analog Computer 

10. In a hybrid computer system, what is 
the typical role of the analog 
component? 
a) Long-term data storage 
b) Complex logical decision-making 
c) Fast input measurement and initial 
processing 
d) User interface management 
Answer: c) Fast input measurement 
and initial processing 

11. What is the correct decimal range for 
an 8-bit unsigned binary number? 
a) -128 to +127 
b) 0 to 255 
c) -256 to +255 
d) 0 to 511 
Answer: b) 0 to 255 

12. To perform the subtraction 7 - 5 
using the 2's complement method in an 
8-bit system, what operation would the 
ALU actually carry out? 
a) 7 + (1's complement of 5) 

b) 7 + (2's complement of 5) 
c) 5 + (2's complement of 7) 
d) Direct binary subtraction of 0101 
from 0111 
Answer: b) 7 + (2's complement of 5) 

13. In the ASCII-7 character encoding 
standard, what is the decimal value 
assigned to the uppercase letter 'A'? 
a) 48 
b) 65 
c) 97 
d) 32 
Answer: b) 65 

14. Which Unicode encoding form is 
variable-length (1-4 bytes), backward 
compatible with ASCII, and the most 
common on the web? 
a) UTF-16 
b) UTF-32 
c) UTF-8 
d) ASCII-8 
Answer: c) UTF-8 

15. In process management, what is a 
'thread'? 
a) A complete, independent program in 
execution 
b) A high-priority system process 
c) A lightweight unit of execution within 
a process that shares resources 
d) The state of a process when it is 
waiting for an I/O operation 
Answer: c) A lightweight unit of 
execution within a process that shares 
resources 

16. Which type of operating system is 
designed for time-critical applications 
where missing a deadline could have 
catastrophic consequences? 
a) Batch Processing OS 
b) Time-Sharing OS 
c) Soft Real-Time OS 
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d) Hard Real-Time OS 
Answer: d) Hard Real-Time OS 

17. In the context of file systems, which 
allocation method stores file blocks 
scattered across the disk, linked together 
by pointers, making it efficient for space 
but slow for random access? 
a) Contiguous Allocation 
b) Indexed Allocation 
c) Linked Allocation 
d) Sequential Allocation 
Answer: c) Linked Allocation 

18. In data communication, which mode 
allows for two-way communication but 
only in one direction at a time, similar to 
a walkie-talkie? 
a) Simplex 
b) Half-Duplex 
c) Full-Duplex 
d) Multiplex 
Answer: b) Half-Duplex 

19. What is the key functional difference 
between a network hub and a network 
switch? 
a) A hub operates at the network layer, 
while a switch operates at the data link 
layer. 
b) A hub broadcasts data to all 
connected devices, while a switch directs 
data only to the specific destination 
device. 
c) A switch connects different networks, 
while a hub connects devices within the 
same network. 
d) A hub has more ports than a switch. 
Answer: b) A hub broadcasts data to 
all connected devices, while a switch 
directs data only to the specific 
destination device. 

20. Which network topology connects 
every device to every other device, 

providing maximum redundancy but at 
the highest cost and complexity? 
a) Star 
b) Bus 
c) Ring 
d) Mesh 
Answer: d) Mesh 

21. In the TCP/IP model used by the 
Internet, what is the primary function of 
the Domain Name System (DNS)? 
a) To encrypt data packets for secure 
transmission 
b) To route packets between different 
networks 
c) To translate domain names into IP 
addresses 
d) To establish and manage 
communication sessions 
Answer: c) To translate domain 
names into IP addresses 

22. During which phase of the SDLC are 
detailed functional and non-functional 
requirements gathered, analyzed, 
validated, and documented? 
a) Planning & Feasibility 
b) System Design 
c) Requirement Analysis & Engineering 
d) Testing 
Answer: c) Requirement Analysis & 
Engineering 

23. What is the defining characteristic of 
the Agile software development model 
compared to the Waterfall model? 
a) It follows a strict, sequential phase 
approach. 
b) It is only suitable for small projects. 
c) It is iterative, incremental, and 
emphasizes adaptability. 
d) It requires all requirements to be fixed 
before design begins. 
Answer: c) It is iterative, incremental, 
and emphasizes adaptability. 
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24. A digital signal is preferred over an 
analog signal in computing primarily 
because it: 
a) Carries more information per unit 
time. 
b) Is a continuous representation of data. 
c) Is more resistant to noise and can be 
perfectly regenerated. 
d) Requires simpler circuitry to process. 
Answer: c) Is more resistant to noise 
and can be perfectly regenerated. 

25. According to the truth table of a 
logic gate, the output is 1 only when all 
inputs are 0. Which gate is this? 
a) AND 
b) OR 
c) NAND 
d) NOR 
Answer: d) NOR 

26. In Boolean Algebra, which theorem 
states that the complement of a sum 
(OR) is equal to the product (AND) of 
the complements? 
a) Distributive Law 
b) Associative Law 
c) De Morgan's Theorem 
d) Commutative Law 
Answer: c) De Morgan's Theorem 

27. Which digital circuit is considered a 
basic 1-bit memory element and forms 
the foundation for computer registers? 
a) Half-Adder 
b) Multiplexer 
c) Decoder 
d) Flip-Flop 
Answer: d) Flip-Flop 

28. In cloud computing, which service 
model provides a platform including OS, 
database, and development tools, 
allowing users to deploy their 
applications without managing the 

underlying infrastructure? 
a) Infrastructure as a Service (IaaS) 
b) Platform as a Service (PaaS) 
c) Software as a Service (SaaS) 
d) Hardware as a Service (HaaS) 
Answer: b) Platform as a Service 
(PaaS) 

29. Which type of cyber attack involves 
overwhelming a target system with 
excessive traffic to make it unavailable 
to legitimate users? 
a) Phishing 
b) Man-in-the-Middle (MitM) 
c) Denial-of-Service (DoS) 
d) SQL Injection 
Answer: c) Denial-of-Service (DoS) 

30. The security practice that involves 
using a combination of something you 
know (password), something you have 
(phone), and something you are 
(fingerprint) is known as: 
a) Single Sign-On (SSO) 
b) Encryption 
c) Multi-Factor Authentication (MFA) 
d) Firewalling 
Answer: c) Multi-Factor 
Authentication (MFA) 

31. Which of the following describes a 
key characteristic of symmetric 
encryption? 
a) It uses a public/private key pair. 
b) The same key is used for both 
encryption and decryption. 
c) It is inherently slower than 
asymmetric encryption. 
d) The encryption key is publicly shared 
while the decryption key is kept private. 
Answer: b) The same key is used for 
both encryption and decryption. 

32. The "POUR" principles are a 
cornerstone of which important area in 
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computing? 
a) Cybersecurity threat modeling 
b) Software testing methodologies 
c) System performance optimization 
d) Accessibility design 
Answer: d) Accessibility design 

33. What is the standard method used by 
modern computers to represent signed 
integers internally? 
a) Sign-and-Magnitude 
b) 1's Complement 
c) 2's Complement 
d) Binary Coded Decimal (BCD) 
Answer: c) 2's Complement 

34. Which of the following is NOT a 
component of the core definition of a 
system? 
a) A collection of interconnected 
components 
b) Working together to achieve a goal 
c) Must be created by humans 
d) Processes inputs to produce outputs 
Answer: c) Must be created by 
humans 

35. Which register in the CPU holds the 
memory address of the next instruction 
to be fetched for execution? 
a) Memory Address Register (MAR) 
b) Memory Data Register (MDR) 
c) Program Counter (PC) 
d) Current Instruction Register (CIR) 
Answer: c) Program Counter (PC) 

36. Which of the following best 
describes the primary role of cache 
memory? 
a) To provide permanent storage for the 
BIOS 
b) To serve as the main working 
memory for running programs 
c) To act as a high-speed buffer between 
the CPU and RAM 

d) To store the operating system kernel 
Answer: c) To act as a high-speed 
buffer between the CPU and RAM 

37. In which computer generation did 
the introduction of keyboards and 
monitors as primary I/O devices become 
prominent? 
a) First Generation 
b) Second Generation 
c) Third Generation 
d) Fourth Generation 
Answer: c) Third Generation 

38. Which type of software is designed 
to perform specific, user-oriented tasks 
like word processing or accounting? 
a) System Software 
b) Firmware 
c) Application Software 
d) Utility Software 
Answer: c) Application Software 

39. The term "ICT" represents the 
convergence of which two major 
technological networks? 
a) Television and Radio networks 
b) Telephone and Computer networks 
c) Satellite and Cable networks 
d) Power and Communication networks 
Answer: b) Telephone and Computer 
networks 

40. What is the base of the hexadecimal 
number system? 
a) 2 
b) 8 
c) 10 
d) 16 
Answer: d) 16 

41. In the SDLC, which type of testing is 
conducted by the client to determine if 
the system meets the agreed-upon 
requirements before final acceptance? 
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a) Unit Testing 
b) Integration Testing 
c) System Testing 
d) Acceptance Testing 
Answer: d) Acceptance Testing 

42. Which network device operates at 
the network layer and is primarily used 
to connect different networks together, 
such as a LAN to the Internet? 
a) Hub 
b) Switch 
c) Router 
d) Bridge 
Answer: c) Router 

43. Which logic gate's output is the exact 
inverse of an AND gate? 
a) OR 
b) NOT 
c) NAND 
d) XOR 
Answer: c) NAND 

44. What is the primary goal of a 
Karnaugh Map (K-Map) in digital logic 
design? 
a) To convert analog signals to digital 
b) To visualize the timing of sequential 
circuits 
c) To simplify Boolean expressions 
algebraically 
d) To simplify Boolean expressions 
graphically 
Answer: d) To simplify Boolean 
expressions graphically 

45. Which cloud deployment model 
combines public and private clouds, 
allowing data and applications to be 
shared between them? 
a) Public Cloud 
b) Private Cloud 
c) Hybrid Cloud 

d) Community Cloud 
Answer: c) Hybrid Cloud 

46. The 3-2-1 backup rule is a best 
practice primarily associated with which 
domain? 
a) Network Topology Design 
b) Data Security and Recovery 
c) Software Development 
d) User Interface Design 
Answer: b) Data Security and 
Recovery 

47. In HCI, which metric specifically 
measures how easy it is for users to 
accomplish basic tasks the first time they 
encounter the design? 
a) Efficiency 
b) Memorability 
c) Learnability 
d) Satisfaction 
Answer: c) Learnability 

48. Which component is responsible for 
carrying control and timing signals, such 
as read and write commands, between 
the CPU and other units? 
a) Data Bus 
b) Address Bus 
c) Control Bus 
d) System Bus 
Answer: c) Control Bus 

49. A system that is "non-volatile" is 
characterized by its ability to: 
a) Retain stored information even when 
power is turned off. 
b) Process data at very high speeds. 
c) Be easily modified by the user. 
d) Connect to multiple input/output 
devices. 
Answer: a) Retain stored information 
even when power is turned off. 
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History of Computers 
Introduction to Computers: 

The word 'computer' originally referred to people who performed mathematical calculations. 
Before modern computers existed, these human 'computers' were employed to carry out complex 
arithmetic operations, often used in fields like astronomy, engineering, and navigation. This 
practice dates back to at least the 17th century. 

The first recorded use of the word 'computer' in English was in 1613, describing a person who 
computes. Over the centuries, as technology progressed, mechanical and electronic devices took 
over the computational role. This evolution marked the transition from manual computing to the 
automated systems we rely on today. 

Understanding the history of computing helps us appreciate the innovations and challenges faced 
by early scientists and inventors who laid the foundation for today’s digital age. 

The Mechanical Era (1600–1900) 

During the Mechanical Era, inventors developed physical devices to assist in computation. These 
devices worked without electricity and were typically operated by hand. 

Tally Sticks 

Tally sticks were simple tools used since ancient times to record numbers, debts, or messages. 
They were not calculators but rather record-keeping aids. A notch on a stick represented a unit of 
value or count. These were used extensively in medieval Europe, especially for tax collection. 

Abacus (c. 2400 BC) 

The abacus is one of the oldest calculating tools known to humanity. First used in Babylon around 
2400 BC and later perfected in China around 500 BC, the abacus consists of beads that can be 
moved along rods to perform arithmetic operations. It was especially useful in trading and finance 
and is still used today in parts of Asia. 

Chapter 2 
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One Liners: History of Computer 
1. The word 'computer' originally referred to a person who performed mathematical 

calculations. 
2. The first recorded use of the word 'computer' in English was in 1613. 
3. The Mechanical Era of computing (1600-1900) involved physical devices operated 

without electricity. 
4. Tally sticks were ancient record-keeping aids, not calculators, often used in medieval 

Europe for tax collection. 
5. The abacus, dating to 2400 BC in Babylon, is one of the oldest calculating tools, using 

beads on rods. 
6. Napier's Bones (1614), invented by John Napier, used inscribed rods to simplify 

multiplication and division. 
7. The slide rule (1622), developed by William Oughtred, used logarithmic scales for 

complex calculations. 
8. The Pascaline (1642) was a mechanical calculator created by Blaise Pascal to perform 

addition and subtraction. 
9. Gottfried Wilhelm Leibniz designed the Stepped Reckoner (1672), capable of all four 

basic arithmetic operations. 
10. The Arithmometer (1820) by Charles Xavier Thomas de Colmar was the first 

commercially successful mechanical calculator. 
11. Charles Babbage, the Father of the Computer, proposed the Difference Engine and 

Analytical Engine. 
12. The Difference Engine was designed to compute polynomial functions and print results 

automatically. 
13. The Analytical Engine is considered the first design for a general-purpose mechanical 

computer. 
14. Ada Lovelace wrote the first algorithm intended for the Analytical Engine, making her the 

first programmer. 
15. Ada Lovelace suggested using binary and conceptualized machine-generated music. 
16. The Scheutzian Engine (1843) was the first mechanical calculator to automatically print 

its results. 
17. The Jacquard Loom (1881) used punch cards to control weaving patterns, inspiring future 

computer data input. 
18. Herman Hollerith's Tabulating Machine (1890) used punched cards for data processing, 

starting with the U.S. Census. 
19. The Tabulating Machine's innovation led to the founding of IBM. 
20. The Electronic Era brought faster, smaller, more reliable machines using electricity and 

introduced programmability. 
21. Konrad Zuse's Z1 (1936-1938) is considered the first freely programmable mechanical 

computer. 
22. The Z1 used binary floating-point arithmetic and input via punched tape. 
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Practice MCQs

1. What was the original meaning of the word 
"computer"? 
a) An electronic calculating device 
b) A person who performs mathematical 
calculations 
c) A mechanical automation tool 
d) A data storage unit 
Answer: b) A person who performs 
mathematical calculations 

2. The Pascaline, invented by Blaise Pascal, 
was primarily designed to: 
a) Perform multiplication and division 
b) Weave complex fabric patterns 
c) Assist with tax collection through addition 
and subtraction 
d) Solve polynomial equations 
Answer: c) Assist with tax collection 
through addition and subtraction 

3. Which device is considered the first design 
for a general-purpose mechanical computer? 
a) Difference Engine 
b) Analytical Engine 
c) Stepped Reckoner 
d) Arithmometer 
Answer: b) Analytical Engine 

4. Ada Lovelace is historically significant for: 
a) Inventing the first mechanical calculator 
b) Writing the first algorithm intended for 
machine processing 
c) Developing the stored-program concept 
d) Building the first electronic computer 
Answer: b) Writing the first algorithm 
intended for machine processing 

5. The Tabulating Machine, which used 
punched cards for data processing, directly 
led to the founding of which company? 
a) Microsoft 
b) IBM 
c) Intel 
d) Apple 
Answer: b) IBM 

6. Konrad Zuse's Z1 is notable for being the: 
a) First electronic digital computer 
b) First computer to use vacuum tubes 
c) First freely programmable mechanical 
computer 
d) First commercial computer 
Answer: c) First freely programmable 
mechanical computer 

7. The Atanasoff-Berry Computer (ABC) 
introduced which of the following concepts? 
a) Stored-program architecture 
b) Use of transistors 
c) Binary representation and electronic 
calculation using vacuum tubes 
d) Integrated circuits 
Answer: c) Binary representation and 
electronic calculation using vacuum tubes 

8. What was the primary use of the Harvard 
Mark I during World War II? 
a) Code-breaking 
b) Ballistics calculations for the U.S. Navy 
c) Predicting election results 
d) Running business payroll 
Answer: b) Ballistics calculations for the 
U.S. Navy 
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Computer System: Architecture and Components 

Introduction To Computer And Its Basic Operations 

In today's information age, computers are used in every walk of life. They are found in 
devices ranging from MP3 players and toys to industrial robots, fighter aircraft, and beyond, 
making life easier and more comfortable. 

Definition of a Computer 

A computer is an electronic device that accepts input data and instructions via input devices, 
stores them until needed, processes the data, and produces output through output devices. 

Basic Operations of a Computer 

All computers perform four fundamental operations to carry out any task: Input, Processing, 
Output, and Storage.  

• Input Operation: The process of capturing or accepting data or information using input 
devices (e.g., keyboard, mouse). 

• Processing Operation: The transformation of input into output. The Central Processing 
Unit (CPU) performs this task under the direction of a program. 

• Output Operation: The result or outcome of the processing, delivered via output devices 
(e.g., monitor, printer, speakers). 

• Storage Operation: The process of retaining data, information, or instructions so the user can 
retrieve them when required. Storage can be temporary (e.g., RAM) or permanent (e.g., Hard 
Disk). 

Evolution of Computing Devices 

The term "computing device" refers to any machine that can perform calculations, from 
simple addition to managing complex systems. 

• Early Computing Devices: 

o Abacus (c. 3000 BC): Considered the first computer, using a system of sliding beads for 
calculations. 

Chapter 3 
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One Liners: Computer Systems, Architecture and components 
1. A computer is an electronic device that accepts input data and instructions, stores them, 

processes the data, and produces output. 
2. The four fundamental operations of a computer are Input, Processing, Output, and Storage. 
3. Input operation involves capturing or accepting data using input devices like a keyboard or 

mouse. 
4. The Central Processing Unit (CPU) performs the transformation of input into output, which 

is the processing operation. 
5. Output operation delivers the result or outcome of processing via devices like a monitor, 

printer, or speakers. 
6. Storage operation retains data, instructions, or information for future retrieval, and can be 

temporary (RAM) or permanent (Hard Disk). 
7. The Abacus (c. 3000 BC) is considered the first computing device, using sliding beads for 

calculations. 
8. Charles Babbage proposed the Difference Engine (1822) to solve differential equations. 
9. The Analytical Engine was Charles Babbage's later concept for a general-purpose computer. 
10. Herman Hollerith's Tabulating Machine (1889) used punched cards and was developed for 

the U.S. census. 
11. The Z3 (1941), developed by Konrad Zuse, was used for designing airplanes and missiles. 
12. The Harvard Mark I (1944) was an electromechanical relay computer. 
13. ENIAC (1946) was the first general-purpose electronic computer. 
14. EDVAC (1945), designed by John von Neumann, introduced the stored-program concept. 
15. UNIVAC-I (1951) was one of the first commercially available computers. 
16. Microcomputers (Personal Computers) are the smallest and least expensive class, originally 

for individual users. 
17. Types of microcomputers include Desktop, Notebook, Laptop, and Handheld devices 

(Palmtop, PDA, Smartphone). 
18. Mainframe computers are the second most powerful and expensive, used by large 

organizations for critical, bulk-data processing. 
19. Mainframes support many terminals simultaneously and are used for census, ERP, financial 

transactions, and airline reservations. 
20. Supercomputers are the most powerful and expensive, designed for intense scientific, 

engineering, and business applications. 
21. Supercomputers are used for weather forecasting, weapon research, space exploration, and 

complex simulations. 
22. Mobile Computers are devices enabling mobile computing—processing and transmitting data 

wirelessly. 
23. Mobile computers include laptops, smartphones, tablets, and PDAs, featuring wireless 

connectivity and portability. 
24. Computer hardware refers to the physical, tangible components of a computer system (e.g., 

monitor, keyboard, mouse, CPU). 
25. The primary function of hardware is to store and execute software. 
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Practice MCQs

1. Which of the following is NOT one of 
the four fundamental operations 
performed by all computers? 
a) Input 
b) Processing 
c) Communication 
d) Storage 
Answer: c) Communication 

2. Which early computing device, 
considered the first computer, used a 
system of sliding beads for calculations? 
a) Analytical Engine 
b) Difference Engine 
c) Abacus 
d) Pascaline 
Answer: c) Abacus 

3. The concept where both program 
instructions and data are stored in the 
same memory was introduced by which 
computer? 
a) ENIAC 
b) Harvard Mark I 
c) EDVAC 
d) UNIVAC-I 
Answer: c) EDVAC 

4. Which type of computer is specifically 
designed for intense scientific 
applications and is the most powerful and 
expensive? 
a) Mainframe Computer 
b) Microcomputer 
c) Minicomputer 
d) Supercomputer 
Answer: d) Supercomputer 

5. What is the primary functional 
distinction between computer hardware 
and software? 

a) Hardware is logical, software is 
physical. 
b) Hardware provides instructions, 
software executes them. 
c) Hardware is tangible and performs 
physical work, software is intangible and 
provides instructions. 
d) Hardware is stored permanently, 
software is temporary. 
Answer: c) Hardware is tangible and 
performs physical work, software is 
intangible and provides instructions. 

6. Which type of software acts as an 
interface between the computer hardware 
and the application software? 
a) Utility Software 
b) System Software 
c) Firmware 
d) Customized Software 
Answer: b) System Software 

7. A software translator that converts the 
entire source code into machine code at 
once, producing an object file, is called 
a(n): 
a) Interpreter 
b) Assembler 
c) Compiler 
d) Linker 
Answer: c) Compiler 

8. Customized banking software 
developed for a specific bank is an 
example of which category of application 
software? 
a) General-Purpose Software 
b) Productivity Software 
c) Special-Purpose Software 
d) System Software 
Answer: c) Special-Purpose Software 
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Number Systems, Digital Logics and Data 
Basics 

Introduction to Digital Systems and Data 

Modern technology is built upon the principles of digital systems. These systems process 
information using discrete values—primarily the binary digits 0 and 1—as opposed to the 
continuous signals found in the natural world. This chapter provides a comprehensive 
foundation in the core concepts that bridge data representation, logical processing, and 
structured data management. We will explore how computers represent numbers, text, and 
multimedia, how they perform logical and arithmetic operations using Boolean algebra and 
logic gates, and how complex data is organized and managed in database systems. Mastery of 
these topics is essential for understanding the inner workings of all computational devices. 

Data and Number Systems 

Data, Information, and Operations 

• Data is a raw collection of facts, figures, and statistics related to an object. It is an 
organizational asset used to view past activities and make future decisions. 

• Information is data that has been processed, manipulated, and organized into a meaningful 
and useful context (e.g., a student's percentage result). 

• Data Processing Operations involve a series of actions to convert data into information: 

1. Data Capturing: Recording data via source documents or input devices. 

2. Data Manipulation: This includes: 

 Classifying: Organizing data into groups using codes. 

 Calculating: Performing arithmetic operations. 

 Sorting: Arranging data in a logical sequence. 

 Summarizing: Condensing data into a concise form. 

3. Managing Output Results: This involves storing, retrieving, communicating, and 
reproducing the processed information. 

Chapter 4 



 

  MK PREPARATIONS  

 

P a g e  11 | 20 

 

  

4
. N

u
m

b
e

r Sy
ste

m
s, D

ig
ita

l L
o

g
ics &

 D
a

ta
 B

a
sics 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

One Liners: Number Systems, Digital Logics and Data Basics 
1. Data is a raw collection of facts, figures, and statistics related to an object, used for viewing 

past activities and making future decisions. 
2. Information is data that has been processed, manipulated, and organized into a meaningful and 

useful context. 
3. The first data processing operation is Data Capturing, which involves recording data via 

source documents or input devices. 
4. Data Manipulation includes the actions of Classifying, Calculating, Sorting, and Summarizing 

data. 
5. The decimal number system uses a base of 10 and the digits 0-9, and is primarily for human 

everyday use. 
6. The binary number system uses a base of 2 and the digits 0 and 1, and is used for internal 

computer processing. 
7. The octal number system uses a base of 8 and digits 0-7, historically used for compact binary 

representation (3 bits/digit). 
8. The hexadecimal number system uses a base of 16 and digits 0-9 and A-F, used for modern 

compact binary representation (4 bits/digit) and memory addressing. 
9. Binary representation is used because digital circuits are built from transistors with two stable 

states: ON (1) and OFF (0). 
10. To convert a decimal number to another base, repeatedly divide the decimal number by the 

target base and record remainders from bottom to top. 
11. To convert binary to octal, group bits into sets of three from the right, pad with leading zeros 

if needed, and convert each group to its octal digit. 
12. To convert binary to hexadecimal, group bits into sets of four from the right, pad with leading 

zeros if needed, and convert each group to its hex digit. 
13. To convert octal to binary, convert each octal digit to its 3-bit binary equivalent. 
14. To convert hexadecimal to binary, convert each hex digit to its 4-bit binary equivalent. 
15. Whole numbers (unsigned integers) use all bits for magnitude; for n bits, the range is 0 to (2ⁿ 

– 1). 
16. Signed integers use the Most Significant Bit (MSB) as a sign bit: 0 for positive, 1 for negative. 
17. The Two's Complement method is used to represent negative integers: invert all bits of the 

positive number and add 1 to the result. 
18. For an n-bit signed integer using two's complement, the range is -2ⁿ⁻¹ to (2ⁿ⁻¹ – 1). 
19. Real numbers (with fractions) are represented using floating-point notation: Sign × Mantissa × 

2^Exponent. 
20. Single-precision floating-point format uses 32 bits: 1 sign bit, 8 exponent bits, and 23 

mantissa bits. 
21. Double-precision floating-point format uses 64 bits: 1 sign bit, 11 exponent bits, and 52 

mantissa bits. 
22. To convert a fractional decimal part to binary, multiply the fraction by 2 repeatedly, recording 

the integer part each time. 
23. Binary addition follows the rules: 0+0=0, 0+1=1, 1+0=1, 1+1=0 with a carry of 1. 
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Practice MCQs
1. What is the key difference between 
data and information? 
a) Data is processed, information is raw. 
b) Data is meaningful, information is a 
collection of facts. 
c) Data is raw, information is processed 
and meaningful. 
d) Data is stored electronically, 
information is printed. 
Answer: c) Data is raw, information is 
processed and meaningful. 

2. Which of the following is NOT a step 
in data manipulation? 
a) Classifying 
b) Capturing 
c) Calculating 
d) Summarizing 
Answer: b) Capturing 

3. Which number system uses a base of 8 
and is historically significant for 
representing 3 binary bits per digit? 
a) Decimal 
b) Hexadecimal 
c) Octal 
d) Binary 
Answer: c) Octal 

4. What is the primary reason computers 
use the binary number system internally? 
a) It is easy for humans to understand. 
b) It allows for complex mathematical 
operations. 
c) It aligns with the two stable states 
(ON/OFF) of transistors in digital 
circuits. 
d) It provides the most compact 
representation of numbers. 
Answer: c) It aligns with the two stable 

states (ON/OFF) of transistors in 
digital circuits. 

5. To convert the decimal number 29 to 
binary, what is the correct sequence of 
remainders from the repeated division-
by-2 process? 
a) 10111 
b) 11101 
c) 11011 
d) 11110 
Answer: b) 11101 

6. The binary number 11010101 is 
equivalent to which hexadecimal 
number? 
a) D5 
b) C5 
c) D4 
d) E5 
Answer: a) D5 

7. What is the range of values for an 8-bit 
unsigned integer? 
a) -128 to +127 
b) 0 to 255 
c) -255 to +255 
d) 0 to 511 
Answer: b) 0 to 255 

8. In the two's complement 
representation, how is the negative 
equivalent of a positive binary number 
formed? 
a) Invert all bits. 
b) Invert all bits and subtract 1. 
c) Invert all bits and add 1. 
d) Add 1 to the number. 
Answer: c) Invert all bits and add 1. 
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Operating Systems 

Introduction to Software and Operating Systems 

What is Software? 

Software is a collection of computer programs, procedures, and associated documentation that 
instructs a computer on what to do and how to do it. Without software, a computer's hardware 
is a useless collection of electronic components. 

Types of Software 

Software is broadly classified into two main categories: 

1. System Software: This software is designed to manage and operate the computer hardware, 
providing a platform for running application software. It acts as an intermediary between the 
hardware and the user applications. 

o Examples: Operating Systems (Windows, macOS, Linux), Device Drivers (printer, graphics 
card drivers), Utility Programs (antivirus, disk cleanup, backup tools). 

o Purpose: To manage hardware resources and create a stable environment for other software. 

2. Application Software: This software is designed to help users perform specific tasks or solve 
particular problems. These programs fulfill user needs directly. 

o Examples: Word Processors (Microsoft Word, Google Docs), Web Browsers (Chrome, 
Firefox), Spreadsheet Software (Microsoft Excel), Graphic Design Software (Adobe 
Photoshop, GIMP), Games. 

o Purpose: To enable users to accomplish productive, creative, or entertainment-oriented tasks. 

Key Differences: 

• Control: System software controls the hardware; application software is controlled by the user 
to perform tasks. 

• Necessity: A computer cannot run without system software; application software is optional 
and installed based on user needs. 

• Installation: System software (especially the OS) is usually pre-installed; application software 
is installed by the user. 

Chapter 5 
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One Liners: Operating Systems 
1. Software is a collection of computer programs, procedures, and documentation that instructs 

a computer on what to do and how to do it. 
2. Without software, a computer's hardware is a useless collection of electronic components. 
3. System Software is designed to manage and operate computer hardware, providing a 

platform for running application software. 
4. System Software acts as an intermediary between hardware and user applications. 
5. Examples of System Software include Operating Systems, Device Drivers, and Utility 

Programs. 
6. The purpose of System Software is to manage hardware resources and create a stable 

environment for other software. 
7. Application Software is designed to help users perform specific tasks or solve particular 

problems. 
8. Application Software fulfills user needs directly, such as word processing or web browsing. 
9. System Software controls the hardware, whereas Application Software is controlled by the 

user to perform tasks. 
10. A computer cannot run without System Software; Application Software is optional and 

installed based on user needs. 
11. System Software (especially the OS) is usually pre-installed, while Application Software is 

installed by the user. 
12. An Operating System (OS) is the most critical type of System Software, acting as an 

interface between the user and hardware. 
13. The OS controls the execution of all programs and manages the computer's resources. 
14. The primary purpose of an OS is to act as a Resource Manager for hardware and software 

resources (CPU, memory, disk, I/O). 
15. An OS provides a User Interface, offering a stable, consistent way for users and applications 

to interact with hardware. 
16. A Command Line Interface (CLI) is a text-based interface where users type specific 

commands to instruct the computer. 
17. CLI is powerful and flexible but has a steep learning curve and requires command 

memorization. 
18. DOS (Disk Operating System) was one of the first widely-installed OS for IBM-compatible 

PCs, using commands like DIR and COPY. 
19. UNIX is a powerful, multi-user, multitasking OS developed at Bell Labs, forming the basis 

for Linux and macOS. 
20. A Menu-Driven Interface (MDI) presents users with a series of screens with list options, 

requiring no command memorization. 
21. MDI is simpler than CLI but less flexible, ideal for systems like ATMs and information 

kiosks. 
22. A Graphical User Interface (GUI) uses graphics (icons, windows, buttons) and is interacted 

with via a pointing device like a mouse. 
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Practice MCQs

1. What is the fundamental role of System 
Software? 
a) To help users perform specific tasks like 
word processing. 
b) To manage and operate computer 
hardware, providing a platform for 
application software. 
c) To provide entertainment and games for 
users. 
d) To connect the computer to the internet. 
Answer: b) To manage and operate 
computer hardware, providing a 
platform for application software. 

2. Which of the following is a key 
distinction between System Software and 
Application Software? 
a) System Software is optional, 
Application Software is essential. 
b) System Software is installed by the 
user, Application Software is pre-installed. 
c) A computer cannot run without System 
Software, but Application Software is 
optional. 
d) Application Software controls the 
hardware directly. 
Answer: c) A computer cannot run 
without System Software, but 
Application Software is optional. 

3. The most critical type of system 
software that acts as an interface between 
the user and the computer hardware is the: 
a) Device Driver 
b) Utility Program 
c) Operating System (OS) 
d) Compiler 
Answer: c) Operating System (OS) 

4. Which type of user interface is 
characterized by a text-based environment 

where users must type specific 
commands? 
a) Graphical User Interface (GUI) 
b) Menu-Driven Interface (MDI) 
c) Command Line Interface (CLI) 
d) Touch Interface 
Answer: c) Command Line Interface 
(CLI) 

5. Which early operating system was one 
of the first widely-installed for IBM-
compatible PCs and used commands like 
DIR and COPY? 
a) UNIX 
b) Windows 95 
c) DOS (Disk Operating System) 
d) macOS 
Answer: c) DOS (Disk Operating 
System) 

6. What is a primary advantage of a 
Graphical User Interface (GUI) over a 
Command Line Interface (CLI)? 
a) It offers more precise control over the 
file system. 
b) It is faster for experienced users to 
perform complex tasks. 
c) It is more user-friendly and easier to 
learn, using visual recognition. 
d) It uses fewer system resources like 
RAM and CPU. 
Answer: c) It is more user-friendly and 
easier to learn, using visual recognition. 

7. An OS that allows only one user to run 
multiple applications concurrently is 
classified as: 
a) Multi-User, Single-Tasking 
b) Single-User, Multitasking 
c) Multi-User, Multitasking 
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Office Automation 

Introduction to Office Automation 

Office Automation refers to the use of computer software and systems to digitally create, 
collect, store, manipulate, and relay office information to accomplish core tasks. The primary 
applications involved are Word Processors, Spreadsheets, Database Management Systems, and 
Presentation Software. This chapter provides a comprehensive guide to Word Processing and 
Spreadsheet software, their features, interfaces, and practical operations. 

Word Processing 

What is a Word Processor? 

A Word Processor is application software used for the composition, editing, formatting, and 
printing of text-based documents. It goes beyond simple typing by allowing the manipulation 
of text, insertion of images, sounds, charts, graphics, and even video clips. Documents can be 
saved in various formats (.txt, .rtf, .html, .doc, .docx) and published on the web with hyperlinks. 
Its greatest advantage over a typewriter is the ability to make changes without retyping the entire 
document. 

Examples of Word Processing Software: MS Word, WordPerfect, OpenOffice Writer, 
Google Docs, AbiWord, Apple iWork. 

Categories of Word Processors 

Text Editors (Simple Word Processors) 

These support basic features only. Examples include WordPad and Notepad. 
Basic Features: 

• Insert & Delete Text: Add or erase characters, words, lines, or pages. 

• Cut, Copy & Paste: Move or duplicate sections of text. 

• Page Size & Margins: Define page layout; text readjusts automatically. 

• Search & Replace: Find and optionally replace specific words/phrases. 

• Word Wrap: Text automatically moves to the next line. 

Chapter 6 
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One Liners: Office Automation 
1. Office Automation uses computer software to digitally create, collect, store, manipulate, and 

relay office information to accomplish core tasks. 
2. Primary applications of office automation include Word Processors, Spreadsheets, Database 

Management Systems, and Presentation Software. 
3. A Word Processor is application software used for the composition, editing, formatting, and 

printing of text-based documents. 
4. A key advantage of a word processor over a typewriter is the ability to make changes without 

retyping the entire document. 
5. Text Editors (simple word processors) support only basic features like insert, delete, cut, copy, 

paste, and word wrap. 
6. Full-Featured Word Processors support advanced capabilities like mail merge, macros, 

footnotes, and table of contents generation. 
7. The WYSIWYG (What You See Is What You Get) feature ensures the on-screen display 

matches the printed output. 
8. The Title Bar in a word processor window displays the name of the active document and the 

application. 
9. The Ribbon in modern word processors replaced menus and contains tabs grouping related 

commands. 
10. The Quick Access Toolbar is a customizable bar for frequently used commands like Save, 

Undo, and Redo. 
11. The Ruler shows text positioning, tabs, margins, and indents both horizontally and vertically. 
12. The Document Window is the main area for creating and editing, with a blinking cursor 

indicating the insertion point. 
13. The Status Bar shows document information such as page number, word count, and zoom 

level. 
14. Ctrl+N is the keyboard shortcut to create a new document in most word processors. 
15. Ctrl+S is the shortcut to save a document, while Ctrl+O is used to open an existing document. 
16. Ctrl+P opens the Print dialog box for printing a document. 
17. In Insert Mode (default), new text pushes existing text forward. 
18. In Overtype Mode, new text overwrites existing text at the cursor position. 
19. Ctrl+A selects the entire document's content. 
20. The Backspace key deletes characters to the left of the cursor, while the Delete key deletes 

characters to the right. 
21. Cut (Ctrl+X), Copy (Ctrl+C), and Paste (Ctrl+V) are used to move or duplicate text via the 

Clipboard. 
22. The Clipboard is a temporary memory space managed by the operating system for transferring 

data between applications. 
23. Undo (Ctrl+Z) reverses the last action, and Redo (Ctrl+Y) reapplies it. 
24. Font Formatting involves changing the appearance of characters, including type, size, style, 

and color. 
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Practice MCQs
1. What is the primary purpose of Office 
Automation? 
a) To replace human workers entirely 
b) To use computer software to digitally 
create, store, manipulate, and relay office 
information 
c) To design hardware for office use 
d) To provide entertainment in the 
workplace 
Answer: b) To use computer software 
to digitally create, store, manipulate, 
and relay office information 

2. Which of the following is NOT a 
primary application of office automation? 
a) Word Processor 
b) Spreadsheet 
c) Operating System 
d) Database Management System 
Answer: c) Operating System 

3. The greatest advantage of a word 
processor over a traditional typewriter is: 
a) It is more expensive 
b) It makes a louder sound 
c) It allows changes without retyping the 
entire document 
d) It uses more paper 
Answer: c) It allows changes without 
retyping the entire document 

4. Which word processing feature ensures 
that the on-screen display exactly 
matches the printed output? 
a) AutoCorrect 
b) WYSIWYG (What You See Is What 
You Get) 
c) Word Wrap 
d) Mail Merge 
Answer: b) WYSIWYG (What You See 
Is What You Get) 

5. In a word processor window, which 
component is a customizable bar for 
frequently used commands like Save and 
Undo? 
a) Title Bar 
b) Ribbon 
c) Quick Access Toolbar 
d) Status Bar 
Answer: c) Quick Access Toolbar 

6. What is the keyboard shortcut to select 
all text in a document? 
a) Ctrl+C 
b) Ctrl+V 
c) Ctrl+A 
d) Ctrl+X 
Answer: c) Ctrl+A 

7. Which typing mode causes new text to 
overwrite existing text at the cursor 
position? 
a) Insert Mode 
b) Overtype Mode 
c) Replace Mode 
d) Typeover Mode 
Answer: b) Overtype Mode 

8. The temporary memory space used by 
the operating system to hold cut or copied 
data for pasting is called the: 
a) Cache 
b) Clipboard 
c) RAM 
d) Hard Drive 
Answer: b) Clipboard 

9. Which font type has small decorative 
strokes at the ends of characters and is 
generally better for printed body text? 
a) Sans-serif 
b) Script 
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Microsoft Word (MS Word) 
With Word you can: 

 Create a document from scratch or from a template . 
 Add text, images, art, and videos. 
 Research a topic and find credible sources. 
 Access your documents from a computer, tablet, or phone via OneDrive. 
 Share your documents and collaborate with others. 
 Track and review changes. 

Create a new document 

1. On the File tab, select New. 
2. Select Blank document, or double-click a template image or type the kind of document into 

the Search for online templates box and press Enter. 
Tip:  For practice using Word features, try a learning guide like Welcome to Word or Insert your 
first table of contents. 

Add and format text 

1. Click on your new blank page and type some text. 

  

Chapter 8 

https://create.microsoft.com/word-templates
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For a basic table, click Insert > Table and move the cursor over the grid until you highlight the 
number of columns and rows you want. 

For a larger table, or to customize a table, select Insert > Table > Insert Table. 

 
Tips:  

 If you already have text separated by tabs, you can quickly convert it to a table. 
Select Insert > Table, and then select Convert Text to Table. 

 To draw your own table, select Insert > Table > Draw Table 

Save a document 

Save your document to OneDrive so you can get to it from anywhere – at work, at home, or on the go. 
Or save to another location, like your desktop. 

1. On the File tab, select Save As or Save a Copy. 
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When you save to OneDrive or SharePoint, all your changes are saved automatically. You can turn 
AutoSave on or off on the Quick Access Toolbar, either above or below your ribbon.  

If you don't see the Quick Access Toolbar, right-click the ribbon, and select Show Quick Access 
Toolbar.  

 
Note: When your document is stored in OneDrive, Word will save your changes automatically. 

Change margins 

In Word, each page automatically has a one-inch margin. You can customize or choose predefined 
margin settings, set margins for facing pages, allow extra margin space to allow for document binding, 
and change how margins are measured. 

1. Select Layout > Margins.  
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One Liners: MS Word 
1. Microsoft Word allows you to create documents from scratch or from an online template. 
2. You can research topics and find credible sources directly within Microsoft Word. 
3. Documents can be accessed from a computer, tablet, or phone via OneDrive. 
4. Word facilitates document sharing and collaboration with others. 
5. The Track and Review changes feature is available in Microsoft Word. 
6. A new blank document is created from the File tab by selecting New and then Blank 

document. 
7. To create a document from a template, you can double-click a template image or search in 

the Search for online templates box. 
8. Learning guides like Welcome to Word are available for practice with Word features. 
9. Text is formatted using options on the Home tab such as Bold, Italic, Bullets, 

and Numbering. 
10. The Insert tab is used to add elements like Tables, Pictures, Shapes, SmartArt, Charts, and 

Screenshots. 
11. A table is inserted by selecting Insert > Table and hovering over a grid to choose the 

number of rows and columns. 
12. For a larger or customized table, use Insert > Table > Insert Table. 
13. Existing text separated by tabs can be converted to a table using Insert > Table > Convert 

Text to Table. 
14. You can draw a custom table using Insert > Table > Draw Table. 
15. To add text, place the cursor at the desired location and start typing. 
16. To replace text, select it and start typing; double-click selects a single word. 
17. Clicking to the left of a line selects the entire line. 
18. Text formatting can be applied from the pop-up toolbar or the Home tab's Font group. 
19. The Format Painter tool copies formatting from one text selection to another. 
20. Double-clicking the Format Painter allows copying formatting to multiple locations. 
21. To save a document to OneDrive, use File > Save As or Save a Copy and 

select OneDrive. 
22. Save personal files to OneDrive - Personal and work files to your company's OneDrive 

or SharePoint site. 
23. You can also save a document to other locations like the Desktop by selecting Browse. 
24. AutoSave automatically saves changes when a document is stored in OneDrive or 

SharePoint. 
25. AutoSave can be toggled on or off from the Quick Access Toolbar. 
26. The Quick Access Toolbar can be shown by right-clicking the ribbon and selecting Show 

Quick Access Toolbar. 
27. Pictures can be inserted from your PC (This Device), from Stock Images, or from the web 

(Online Pictures). 
28. In older Word versions, the option for online pictures may be labeled Online 

Pictures next to Pictures. 
29. To resize a picture, select it and drag a corner handle. 
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Practice MCQs
1. In Microsoft Word, where do you go 
to create a brand new document from a 
blank slate? 
a) Home > New 
b) File > New > Blank document 
c) Insert > New Document 
d) View > New Window 
Answer: b) File > New > Blank 
document 

2. Which feature in Word allows you to 
automatically save changes when your 
document is stored on OneDrive? 
a) AutoRecover 
b) Quick Save 
c) AutoSave 
d) Background Save 
Answer: c) AutoSave 

3. To quickly convert text separated by 
tabs into a structured table, which 
command should you use? 
a) Insert > Table > Draw Table 
b) Insert > Table > Excel Spreadsheet 
c) Insert > Table > Convert Text to Table 
d) Layout > Convert > Text to Table 
Answer: c) Insert > Table > Convert Text 
to Table 

4. What is the primary function of the 
Format Painter tool in Word? 
a) To change the page color 
b) To copy formatting from one text 
selection to another 
c) To insert painterly art effects 
d) To adjust paragraph spacing 
Answer: b) To copy formatting from one 
text selection to another 

5. How do you ensure that the header 
on the first page of your document is 
different from the rest (e.g., blank)? 

a) Delete the header on the first page 
manually. 
b) Insert a section break after the first page. 
c) Check the Different First Page box in 
the Header & Footer Tools. 
d) Use File > Options to disable the first 
page header. 
Answer: c) Check the Different First 
Page box in the Header & Footer Tools. 

6. When inserting a picture, which text 
wrapping option places the picture within 
the text paragraph, causing it to move as 
text is edited? 
a) Square 
b) Tight 
c) Behind Text 
d) In Line with Text 
Answer: d) In Line with Text 

7. You want to start page numbering 
from "1" on the second page of your 
document. What should you set the "Start 
at" value to in the Page Number Format 
dialog? 
a) 1 
b) 0 
c) 2 
d) -1 
Answer: b) 0 

8. To create a custom watermark using 
your company logo, which sequence of 
commands do you follow? 
a) Design > Watermark > Custom 
Watermark > Picture watermark 
b) Insert > Picture > Set as Watermark 
c) Page Layout > Background > Custom 
Watermark 
d) View > Watermark > Insert Picture 
Answer: a) Design > Watermark > 
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Microsoft Excel (MS Excel) 
What is Excel? 

Excel makes it easy to crunch numbers. With Excel, you can streamline data entry with AutoFill. Then, 
get chart recommendations based on your data, and create them with one click. Or easily spot trends and 
patterns with data bars, color coding, and icons. 

Create a workbook 

1. Open Excel. 

2. Select Blank workbook. Or press Ctrl+N. 

Enter data 

To manually enter data: 

1. Select an empty cell, such as A1, and then type text or a number. 

2. Press Enter or Tab to move to the next cell. 

To fill data in a series: 

1. Enter the beginning of the series in two cells: such as Jan and Feb; or 2014 and 2015. 
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AutoSum horizontally 

Avoid rewriting the same formula 

After you create a formula, you can copy it to other cells — no need to rewrite the same formula. 
You can either copy the formula, or use the fill handle  to copy the formula to adjacent cells. 

For example, when you copy the formula in cell B6 to C6, the formula in that cell automatically 
changes to update to cell references in column C. 

https://support.microsoft.com/en-us/office/paste-options-8ea795b0-87cd-46af-9b59-ed4d8b1669ad
https://support.microsoft.com/en-us/office/fill-a-formula-down-into-adjacent-cells-041edfe2-05bc-40e6-b933-ef48c3f308c6
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When you copy the formula, ensure that the cell references are correct. Cell references may 
change if they have relative references.  

What can I use in a formula to mimic calculator keys? 

Calculator key Excel method Description, example Result 

+ (Plus key) + (plus) Use in a formula to add numbers. Example: 
=4+6+2 

12 

- (Minus key) - (minus) Use in a formula to subtract numbers or to 
signify a negative number. 
Example: =18-12 
Example: =24*-5 (24 times negative 5) 

 
6 
-120 

x (Multiply key) * (asterisk; also 
called "star") 

Use in a formula to multiply numbers. Example: 
=8*3 

24 

÷ (Divide key) / (forward slash) Use in a formula to divide one number by 
another. Example: =45/5 

9 

% (Percent key) % (percent) Use in a formula with * to multiply by a 
percent. Example: =15%*20 

3 

√ (square root) SQRT (function) Use the SQRT function in a formula to find the 
square root of a number. Example: =SQRT(64) 

8 

1/x (reciprocal) =1/n Use =1/n in a formula, where n is the number 
you want to divide 1 by. 
Example: =1/8 

0.125 

Add a watermark in Excel 

You can use an image, such as a logo, to insert as a watermark that will appear on the 
spreadsheet along with the displayed data.  

Create a watermark 

1. Select Insert > Header & Footer. 
2. Tap on the header and on the Header & Footer Elements tab on the ribbon, click Picture. 
3. Select one of the available options to insert your image. In the header, you'll see & 

[Picture]. 
4. Tap anywhere outside the header to see the watermark. 
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Number formats 

To see all available number formats, select the Dialog Box Launcher next to Number on 

the Home tab in the Number group. 

Format Description 

General The default number format that Excel applies when you type a number. For the most 
part, numbers that are formatted with the General format are displayed just the way 
you type them. However, if the cell is not wide enough to show the entire number, 
the General format rounds the numbers with decimals. The General number format 
also uses scientific (exponential) notation for large numbers (12 or more digits). 

Number Used for the general display of numbers. You can specify the number of decimal 
places that you want to use, whether you want to use a thousands separator, and how 
you want to display negative numbers. 

Currency Used for general monetary values and displays the default currency symbol with 
numbers. You can specify the number of decimal places that you want to use, 
whether you want to use a thousands separator, and how you want to display 
negative numbers. 

Accounting Also used for monetary values, but it aligns the currency symbols and decimal 
points of numbers in a column. 

Date Displays date and time serial numbers as date values, according to the type and 
locale (location) that you specify. Date formats that begin with an asterisk (*) 
respond to changes in regional date and time settings that are specified in Control 
Panel. Formats without an asterisk are not affected by Control Panel settings. 
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This unlocks all the cells on the worksheet when you protect the worksheet. Now, you can choose 
the cells you specifically want to lock. 

5. On the worksheet, select only the cells that you want to lock. 

6. Bring up the Format Cells popup window again (Ctrl+Shift+F). 

7. This time, on the Protection tab, check the Locked box and then select OK. 

8. On the Review tab, select Protect Sheet. 

 
9. In the Allow all users of this worksheet to list, choose the elements that you want users to 

be able to change. 

More information about worksheet elements 

Clear this check box To prevent users from 

Select locked cells 
Moving the pointer to cells for which the Locked check box is selected on 
the Protection tab of the Format Cells dialog box. By default, users are 
allowed to select locked cells. 

Select unlocked cells 

Moving the pointer to cells for which the Locked check box is cleared on 
the Protection tab of the Format Cells dialog box. By default, users can 
select unlocked cells, and they can press the TAB key to move between the 
unlocked cells on a protected worksheet. 
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protected the worksheet, the formatting continues to change when a user 
enters a value that satisfies a different condition. 

Format columns Using any of the column formatting commands, including changing 
column width or hiding columns (Home > Format). 

Format rows Using any of the row formatting commands, including changing row 
height or hiding rows (Home > Format). 

Insert columns Inserting columns. 
Insert rows Inserting rows. 
Insert hyperlinks Inserting new hyperlinks, even in unlocked cells. 
Delete columns Deleting columns. 

If Delete columns is protected and Insert columns is not also protected, a 
user can insert columns that they cannot delete. 

Delete rows Deleting rows. 
If Delete rows is protected and Insert rows is not also protected, a user 
can insert rows that they cannot delete. 

Sort Using any commands to sort data (Data tab, Sort & Filter group). 
Users can't sort ranges that contain locked cells on a protected worksheet, 
regardless of this setting. 

Use AutoFilter Using the drop-down arrows to change the filter on ranges when 
AutoFilters are applied. 
Users cannot apply or remove AutoFilters on a protected worksheet, 
regardless of this setting. 

Use PivotTable 
reports 

Formatting, changing the layout, refreshing, or otherwise modifying 
PivotTable reports, or creating new reports. 

Edit objects Doing any of the following: 
 Making changes to graphic objects including maps, embedded charts, 

shapes, text boxes, and controls that you did not unlock before you 
protected the worksheet. For example, if a worksheet has a button 
that runs a macro, you can click the button to run the macro, but you 
cannot delete the button. 

 Making any changes, such as formatting, to an embedded chart. The 
chart continues to be updated when you change its source data. 

 Adding or editing comments. 
Edit scenarios Viewing scenarios that you have hidden, making changes to scenarios that 

you have prevented changes to, and deleting these scenarios. Users can 
change the values in the changing cells, if the cells are not protected, and 
add new scenarios. 
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One Liners: MS Excel 

1. Excel simplifies numerical calculations and data entry with features like AutoFill. 

2. Chart recommendations based on your data can be created with a single click in Excel. 

3. Trends and patterns can be easily visualized using data bars, color coding, and icons in 

Excel. 

4. A new blank workbook is created by selecting Blank workbook or pressing Ctrl+N. 

5. To enter data manually, select a cell, type, and press Enter or Tab to move to the next cell. 

6. The AutoFill series is created by entering the start of the series in two cells and dragging 

the fill handle. 

7. Excel can perform calculations using simple formulas for addition, subtraction, 

multiplication, and division. 

8. All Excel formulas must begin with an equal sign (=). 

9. The basic arithmetic operators are: plus (+) for addition, minus (-) for subtraction, asterisk 

(*) for multiplication, and forward slash (/) for division. 

10. There is no dedicated SUBTRACT function in Excel; the minus operator (-) is used 

within a formula. 

11. The SUM function can incorporate negative numbers using a minus sign, e.g., 

=SUM(12,5,-3,8,-4). 

12. The AutoSum feature automatically senses a contiguous range and inserts a SUM 

formula. 

13. AutoSum can be applied both vertically (above/below a range) and horizontally (left/right 

of a range). 

14. AutoSum does not work on non-contiguous ranges of cells. 

15. The Intellisense guide for a function appears as a floating tag and provides a hyperlink to 

its Help topic. 

16. After creating a formula, you can copy it to adjacent cells to avoid rewriting it. 

17. When a formula with relative references is copied, the cell references update automatically 

relative to their new position. 
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Practice MCQs
1. Which keyboard shortcut is used to 

create a new blank workbook in Excel? 
a) Ctrl+B 
b) Ctrl+N 
c) Ctrl+W 
d) Ctrl+T 
Answer: b) Ctrl+N 

2. To automatically fill a series like "Jan, 
Feb, Mar..." what must you do first? 
a) Type the entire series once. 
b) Use the Fill Series dialog box. 
c) Enter the beginning of the series in 
two cells and select them. 
d) Select the cells and choose "Fill 
Series" from the Data tab. 
Answer: c) Enter the beginning of the 
series in two cells and select them. 

3. What is a fundamental requirement for 
every Excel formula? 
a) It must contain a function. 
b) It must reference another cell. 
c) It must begin with an equal sign (=). 
d) It must be enclosed in parentheses. 
Answer: c) It must begin with an 
equal sign (=). 

4. How does Excel handle subtraction 
within a formula, given there is no 
SUBTRACT function? 
a) It uses the SUM function with 
negative numbers. 
b) It uses the DIF function. 
c) It uses the minus (-) operator. 
d) Both a and c are correct. 
Answer: d) Both a and c are correct. 

5. The AutoSum feature is designed to 
work with which type of cell ranges? 
a) 3-D references 
b) Non-contiguous ranges 
c) Contiguous ranges 

d) Array ranges 
Answer: c) Contiguous ranges 

6. When you copy a formula containing a 
relative cell reference like =A1 to the 
cell one column to the right, what does it 
become? 
a) =A1 
b) =$A$1 
c) =B1 
d) =A2 
Answer: c) =B1 

7. In Excel, which function is equivalent to 
the calculator's square root (√) key? 
a) SQR 
b) ROOT 
c) SQRT 
d) POWER(...,0.5) 
Answer: c) SQRT 

8. Where is a watermark picture inserted in 
an Excel worksheet to appear behind the 
data? 
a) As a background from the Page 
Layout tab. 
b) Into the header or footer via Insert > 
Header & Footer. 
c) As an inline image on the worksheet. 
d) Using the Watermark option on the 
Design tab. 
Answer: b) Into the header or footer 
via Insert > Header & Footer. 

9. What happens to the contents of cells 
B2, C2, and D2 when they are merged 
into one cell? 
a) All contents are concatenated. 
b) Only the content of the upper-left cell 
(B2) is kept. 
c) The contents are averaged. 
d) An error message appears. 
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Microsoft PowerPoint (MS PowerPoint) 
What is PowerPoint? 

Overview 

 With PowerPoint on your PC, Mac, or mobile device, you can: 
 Create presentations from scratch or a template. 
 Add text, images, art, and videos. 
 Select a professional design with PowerPoint Designer. 
 Add transitions, animations, and cinematic motion. 
 Save to OneDrive, to get to your presentations from your computer, tablet, or phone. 
 Share your work and work with others, wherever they are. 

Create a presentation in PowerPoint 

Create presentations from scratch or start with a professionally designed, fully customizable 
template from Microsoft Create. 

Tip: If you have Microsoft Copilot it can help you create a presentation, add slides or images, 
and more. To learn more see Create a new presentation with Copilot in PowerPoint. 

Create a presentation 

1. Open PowerPoint. 
2. In the left pane, select New. 
3. Select an option: 

 To create a presentation from scratch, select Blank Presentation. 
 To use a prepared design, select one of the templates. 

Chapter 9 

https://go.microsoft.com/fwlink/?linkid=2226436
https://go.microsoft.com/fwlink/?linkid=2226436
https://support.microsoft.com/en-us/office/create-a-new-presentation-with-copilot-in-powerpoint-3222ee03-f5a4-4d27-8642-9c387ab4854d
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  Save in PowerPoint 

Save your presentation to OneDrive 

When you save your files to the cloud, you can share and collaborate with others, and get to your 
files from anywhere - on your computer, tablet, or phone. 

1. Select File > Save As. 

2. Select OneDrive. 

Save personal files to OneDrive - Personal, and work files to your company OneDrive. 
You can also save to another location, like your device. 

Offline 

When you're online, AutoSave is always on and saves your changes as you work. If at any time 
you lose your Internet connection or turn it off, any pending changes will sync as soon as you’re 

back online. 

https://www.facebook.com/sharer.php?u=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fcreate-a-presentation-in-powerpoint-422250f8-5721-4cea-92cc-202fa7b89617
https://www.facebook.com/sharer.php?u=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fcreate-a-presentation-in-powerpoint-422250f8-5721-4cea-92cc-202fa7b89617
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make those pre-designed themes available to you on the Design tab in Normal view. You can also 
get more themes from templates.office.com. 

Every theme you use in your presentation includes a slide master and a related set of layouts. If 
you use more than one theme in your presentation, you’ll have more than one slide master and 
multiple sets of layouts. 

Slide Layouts 

You change and manage slide layouts in Slide Master view. Every theme has a several slide 
layouts. You choose the layouts that best match your slide content; some are better for text and 
some are better for graphics. 

In Normal view, you’ll apply the layouts to your slides. 

Each slide layout is set up differently — with different types of placeholders in different locations 
on each layout. 

Every slide master has a related slide layout called Title Slide Layout, and each theme arranges 
the text and other object placeholders for that layout differently, with different colors, fonts and 
effects. The following pictures contrast the title slide layouts for two themes: first the Basis theme 
and then the Integral theme. 

You can change anything about a layout to suit your needs. When you change a layout master and 
then go to Normal view, every slide you add after that time that's based on that layout will reflect 
the changed look of the layout. However, if there are existing slides in your presentation that are 
based on the prior version of the layout, you’ll need to reapply the layout to those slides.  

https://go.microsoft.com/fwlink/p/?linkid=2170884
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 To view a detail in your slide up close, select Zoom into slide, and then point to the part 

you want to see. 

 
 To point to or write on your slides as you present, select Pen and laser pointer tools. 

 
Press the Esc key when you want to turn off the pen, laser pointer, or highlighter. 

 To hide or unhide the current slide in your presentation, select Black or unblack slide 
show. 
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One Liners: MS Power Point 
1. PowerPoint allows you to create presentations from scratch or from professionally 

designed templates. 

2. With Microsoft Copilot, you can get assistance creating presentations, adding slides, 

images, and more. 

3. To create a new presentation, open PowerPoint, select New in the left pane, and 

choose Blank Presentation or a template. 

4. The Take a Tour option provides tips for using PowerPoint. 

5. A new slide is added by selecting a slide in the thumbnail pane, then going to Home > 

Slides > New Slide. 

6. The layout for a new slide is chosen from the Layout menu in the Slides section on 

the Home tab. 

7. Text is formatted using options like Font, Bold, Italic, Increase Font Size, and Decrease 

Font Size in the Home tab's Font section. 

8. Bulleted or numbered lists are created by selecting text and 

choosing Bullets or Numbering on the Home tab. 

9. Pictures are inserted from the Insert tab, Images section, by selecting Pictures and 

choosing a source. 

10. Illustrations such as Shapes, Icons, 3D Models, SmartArt, and Charts are inserted from 

the Illustrations section of the Insert tab. 

11. To save a presentation to the cloud for access and collaboration, use File > Save As and 

select OneDrive. 

12. Save personal files to OneDrive - Personal and work files to your company OneDrive. 

13. AutoSave is always on when you're online and saves changes as you work; pending 

changes sync when you reconnect. 

14. Themes and their Variants are applied from the Design tab. 

15. PowerPoint Designer suggests design ideas when you insert pictures, a list, or dates; it 

opens automatically. 
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Practice MCQs
1. What is the primary purpose of 

Microsoft Copilot in PowerPoint as 
mentioned in the chapter? 
a) To design custom animations 
b) To help create presentations, add 
slides or images, and more 
c) To automatically record narration 
d) To convert presentations to video 
Answer: b) To help create 
presentations, add slides or images, 
and more 

2. Where is the "Take a Tour" option 
located when creating a new 
presentation? 
a) On the Design tab 
b) In the New pane after 
selecting Blank Presentation 
c) Under File > Options 
d) On the Slide Show tab 
Answer: b) In the New pane after 
selecting Blank Presentation 

3. To apply a professional design 
suggestion automatically after inserting 
a picture, which feature should you 
use? 
a) Slide Master 
b) Transitions 
c) PowerPoint Designer 
d) Animation Painter 
Answer: c) PowerPoint Designer 

4. How do you access the Presenter 
View when running a slide show on a 
single monitor? 
a) Press F5 
b) Select Slide Show > Presenter View 
c) Click the three dots (...) on the 
control bar in Slide Show view 
d) It automatically appears if notes are 

added 
Answer: c) Click the three dots (...) 
on the control bar in Slide Show view 

5. If you want a company logo to appear 
on every slide in the same position, 
where should you place it? 
a) On the first slide only 
b) On the Slide Master 
c) As a watermark from the Design tab 
d) In the Header & Footer dialog 
Answer: b) On the Slide Master 

6. What happens when you edit a layout 
master in Slide Master view? 
a) Only new slides based on that layout 
will reflect the changes. 
b) All existing slides immediately 
update. 
c) Only the title slide changes. 
d) You must manually update each 
slide. 
Answer: a) Only new slides based on 
that layout will reflect the changes. 

7. Which of the following is NOT a 
standard method to delete a sequence of 
contiguous slides? 
a) Press Shift, select the first and last 
slides, right-click, choose Delete Slide. 
b) Press Ctrl, select each slide 
individually, right-click, choose Delete 
Slide. 
c) Go to Slide Sorter view, select the 
slides, and press Delete. 
d) The chapter does not mention using 
the Delete key. 
Answer: b) Press Ctrl, select each 
slide individually, right-click, choose 
Delete Slide. (This is for non-adjacent 
slides) 
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Key-Board and Shortcut Keys 
What is KEYBOARD? 

• A panel/plate/board of keys that operates a computer or typewriters. 

• A piece of computer hardware used to input text, characters, and other commands into a 
computer or similar device 

Types of Keys Setup on Keyboard: 

Keyboard Shortcut keys: 

1. Set of one or more keys that generates a particular command to be executed. 

2. Generally executed by using Alt or Ctrl keys with some other keys 

3. A plus (+) sign between two or more keys indicates that these keys 
should pressed in combination. For example Ctrl+Shift+A means to press 
and hold Ctrl and Shift and then press A 

Chapter 10 



 

  MK PREPARATIONS  

 

P a g e  2 | 35 

 

  

1
0

. K
e

y
b

o
a

rd
 a

n
d

 Sh
o

rt K
e

y
s 

  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Frequently used Keys: 

 

Key Function 

Alt Key • Key modifier that enables a different input 

Escape (esc) key 
• Cancel the current operation 

• Exit the currant window 

Space bar • Move the curser one space forward 

Tab Key 
• Move the cursor several space foreword 

• Move to next text box on a form or on a table 

Control (ctrl) Key 

• Modifer key 

• Pressed in conjuction with another key performed a specific 

task 

Back Space Key Move the curser one space backward 

 
Enter Key 

• Move the curser to the beginning of the next line 

• In a dialogue box enable the highlighted option 

• In some program start the next operation 
or confirm the current operation 
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Microsoft Power Point Shortcut Keys 

Shortcut Keys Operation 

12 Save As. 

Alt + F4 Close PowerPoint 

Ctrl + M Insert a new slide. 

Ctrl + D Duplicate the selected slide. 

Ctrl + Shift + D Duplicate the selected slide. 

Page Up/Down Navigate to the previous/next slide 

Ctrl + G Group objects. 

Ctrl + Spacebar Reset manual character formatting 

Shift + F3 Change the case of selected text. 

Alt + Q "Tell me what you want to do". 

Ctrl + T Open the Font window. 

Ctrl + K Insert a hyperlink. 

Ctrl + Tab Switch between open presentations. 

Alt + F9 Show/hide gridlines and guides 

Alt + F10 Show/hide selection pane. 
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Command + T Open a new tab in browsers. 

Command + L Highlight the address bar in browsers 

Famous Abbreviations: 

Abbreviation Meaning Abbreviation Meaning 

AI Artificial Indulgence  .exe Executable 

ASCII American slandered code 
for information exchange  

FAX Facsimile – Latin 
word meaning make 
similar 

BINAC Binary automatic 
computer 

GIF Graphic Interchange 
Format  

BIOS Basic input output system GSM Global System for 
Mobile 
Communication 

CD Compact Disk HTTP Hyper Text Transfer 
Protocol 

DVD Digital versatile Disk HTML Hypertext Markup 
Language 

E-Commerce Electronic commerce  JPEG Joint photographic 
Experts Group 

LED Light Emitting Diode ROM Read Only Memory 

MMS Multimedia Message Service RIP Routing Information 
Protocol 

MPEG Moving Picture Experts 
Group 

SIM Subscriber 
Identification Module  

PC Personal Computer TCP Transmission control 
protocol 
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One Liners: Keyboard and shortcut Keys 

1. A keyboard is a panel of keys used to operate a computer or typewriter. 

2. A keyboard is a piece of computer hardware used to input text, characters, and other 

commands. 

3. Keyboard shortcut keys are a set of one or more keys that generate a particular command to 

be executed. 

4. Shortcut keys are generally executed by using the Alt or Ctrl keys in combination with other 

keys. 

5. A plus (+) sign between keys indicates that those keys should be pressed in combination. 

6. Ctrl+Shift+A means press and hold Ctrl and Shift, then press A. 

7. The Alt key is a key modifier that enables a different input. 

8. The Escape (Esc) key cancels the current operation or exits the current window. 

9. The Spacebar moves the cursor one space forward. 

10. The Tab key moves the cursor several spaces forward or to the next text box on a form. 

11. The Control (Ctrl) key is a modifier key pressed in conjunction with another key to perform a 

specific task. 

12. The Backspace key moves the cursor one space backward. 

13. The Enter key moves the cursor to the beginning of the next line. 

14. The Enter key enables the highlighted option in a dialogue box. 
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Practice MCQs

1. What is the primary function of a 

keyboard? 

a) Display visual output 

b) Input text and commands 

c) Process data 

d) Store files 

Answer: b) Input text and commands 

2. In the shortcut notation "Ctrl+Shift+A", 

the plus sign (+) indicates: 

a) Press keys one after the other 

b) Press keys in sequence slowly 

c) Press and hold keys in combination 

d) Press the keys only once 

Answer: c) Press and hold keys in 

combination 

3. Which key is used to cancel the current 

operation or exit a window? 

a) Tab 

b) Alt 

c) Escape (Esc) 

d) Spacebar 

Answer: c) Escape (Esc) 

4. The function of the Tab key is NOT to: 

a) Move the cursor several spaces 

forward 

b) Move to the next text box on a form 

c) Move the cursor one space forward 

d) Navigate within a table 

Answer: c) Move the cursor one space 

forward 

5. What is the role of the Ctrl key? 

a) To type uppercase letters 

b) To move the cursor backward 

c) As a modifier key pressed with 

another key for a task 

d) To open the Start menu 

Answer: c) As a modifier key pressed 

with another key for a task 

6. Pressing Shift + F10 in Windows 

performs which action? 

a) Opens the Run dialog 

b) Saves the document 

c) Simulates a right-click 

d) Refreshes the page 

Answer: c) Simulates a right-click 

7. In Microsoft Word, which shortcut 

changes text to Heading 2? 

a) Ctrl + Alt + 1 

b) Ctrl + Alt + 2 

c) Ctrl + Alt + 3 

d) Ctrl + Alt + H 

Answer: b) Ctrl + Alt + 2 
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Data Communication and Networks 

Introduction to Data Communication 

We live in an era of an electronic global village, where computers, telephones, and wireless 
devices are interconnected worldwide. Data communication is the electronic exchange of data 
between two devices via a transmission medium such as a wire cable or wireless system. It 
enables the transfer of information from one location to another, forming the backbone of 
modern connectivity, collaboration, and information sharing. 

Components of Data Communication 

A data communication system consists of five fundamental components that work together to 
enable the transfer of information. 

Message 

The message is the information or data to be communicated. It can consist of text, numbers, 
pictures, sound, video, or any combination of these. 

Sender (Transmitter/Source) 

The sender is the device that originates and sends the data message. It can be a computer, 
workstation, telephone handset, video camera, mobile phone, or radio/TV station. The 
transmitter converts the message into a signal suitable for transmission over the chosen 
medium. 

Receiver (Sink/Destination) 

The receiver is the device that accepts the transmitted message. It can be a computer, 
workstation, telephone, television, printer, or fax machine. The receiver converts the received 
signal back into a form usable by the destination. 

Transmission Medium (Channel) 

The transmission medium is the physical path or channel through which the message travels 
from the sender to the receiver. It can be a guided (wired/bounded) medium like a cable or 
an unguided (wireless/unbounded) medium like air or space. 

Protocol 

Chapter 11 
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Need for Standards 

Standards provide common guidelines for manufacturers and vendors to ensure 
interoperability between different hardware and software. They define how devices identify 
each other, format data, and manage communication. Examples include IEEE 802 series 
(Ethernet, Wi-Fi), and protocols like TCP/IP. 

The OSI (Open Systems Interconnection) Reference Model 

Developed by ISO, the OSI model is a conceptual framework that standardizes the 
functions of a telecommunication or computing system into seven distinct layers. Each layer 
serves the layer above it and is served by the layer below it. 

Layer Name Function Protocols/Devices 
PDU 

(Protocol 
Data Unit) 

7 Application 

Provides network 
services directly to 
user applications 
(email, file 
transfer). 

HTTP, FTP, 
SMTP, DNS, 
Telnet 

Data/Messag
e 

6 
Presentatio
n 

Translates, 
encrypts, and 
compresses data for 
the application 
layer. 

SSL/TLS, JPEG, 
MPEG, ASCII to 
EBCDIC 
conversion 

Data/Messag
e 

5 Session 

Establishes, 
manages, and 
terminates 
connections 
(sessions) between 
applications. 

NetBIOS, RPC, 
SIP 

Data/Messag
e 
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One Liners: Data Communication and Networks 

1. Data communication is the electronic exchange of data between two devices via a 

transmission medium. 

2. The five fundamental components of a data communication system are Message, Sender, 

Receiver, Transmission Medium, and Protocol. 

3. A message can consist of text, numbers, pictures, sound, video, or any combination thereof. 

4. The sender, or transmitter, is the device that originates and sends the data message. 

5. The transmitter converts the message into a signal suitable for transmission over the chosen 

medium. 

6. The receiver, or destination, is the device that accepts the transmitted message. 

7. The receiver converts the received signal back into a form usable by the destination. 

8. The transmission medium is the physical path through which the message travels from 

sender to receiver. 

9. A protocol is a set of rules governing data communication, representing an agreement 

between communicating devices. 

10. Protocols handle aspects like error detection, synchronization, signaling, and 

authentication. 

11. An encoder converts digital signals into a form suitable for transmission, while a decoder 

converts them back. 

12. The three key properties of an effective data communication system are Delivery, 

Accuracy, and Timeliness. 

13. Delivery ensures data reaches the correct intended destination. 

14. Accuracy requires that data received is identical to data sent, without alteration. 

15. Timeliness for real-time data means delivery as it is produced, without significant delay or 

jitter. 

16. Signals are electromagnetic or light waves representing data used to transfer information. 

17. An analog signal is a continuous electrical wave that varies smoothly over time. 

18. The key characteristics of an analog signal are Amplitude, Frequency, and Phase. 
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Practice MCQs
1. Which of the following is NOT a 

fundamental component of a data 
communication system? 
a) Message 
b) Sender 
c) Router 
d) Protocol 
Answer: c) Router 

2. In data communication, what is the 
primary function of a protocol? 
a) To amplify the signal strength 
b) To convert analog signals to digital 
c) To govern the rules and conventions 
for communication 
d) To provide the physical transmission 
path 
Answer: c) To govern the rules and 
conventions for communication 

3. The property of a communication system 
that ensures data is delivered without 
alteration is called: 
a) Delivery 
b) Timeliness 
c) Accuracy 
d) Synchronization 
Answer: c) Accuracy 

4. Which characteristic of an analog signal 
refers to the number of cycles it 
completes in one second? 
a) Amplitude 
b) Wavelength 
c) Frequency 
d) Phase 
Answer: c) Frequency 

5. Unicode was developed primarily to 
address the limitation of ASCII in: 
a) Processing speed 

b) Representing characters from diverse 
world languages 
c) Error detection capabilities 
d) Signal transmission range 
Answer: b) Representing characters 
from diverse world languages 

6. The phenomenon where a signal loses 
energy and weakens as it travels over a 
distance is known as: 
a) Distortion 
b) Noise 
c) Attenuation 
d) Crosstalk 
Answer: c) Attenuation 

7. Which guided transmission medium 
operates on the principle of total internal 
reflection? 
a) Unshielded Twisted Pair (UTP) 
b) Coaxial Cable 
c) Shielded Twisted Pair (STP) 
d) Fiber Optic Cable 
Answer: d) Fiber Optic Cable 

8. A major disadvantage of Satellite 
Microwave communication is: 
a) Inability to penetrate walls 
b) High signal propagation delay 
c) Very short range 
d) Susceptibility to electromagnetic 
interference 
Answer: b) High signal propagation 
delay 

9. In which communication mode can both 
devices send and receive data, but not at 
the same time? 
a) Simplex 
b) Full-Duplex 
c) Half-Duplex 



 

  MK PREPARATIONS  

 
 

P a g e  1 | 29 

 

  

1
2

. C
o

m
p

u
ta

tio
n

a
l T

h
in

k
in

g
 a

n
d

 A
lg

o
rith

m
 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Computational Thinking and Algorithms 

Introduction to Computational Thinking 

Computational Thinking (CT) is a structured, problem-solving methodology that enables 
individuals to tackle complex problems by applying techniques and processes inspired by 
computer science. It is a universal skill, not limited to programming, applicable in fields such 
as mathematics, science, engineering, business, healthcare, and everyday life tasks like planning 
a trip or organizing an event. CT involves a mental framework for logical and creative problem-
solving, using specific techniques to think clearly, logically, and systematically. 

The primary goal is to design systematic, step-by-step solutions that can be executed by a 
human, a computer, or both. It prepares individuals to deconstruct complex challenges, identify 
patterns, focus on essentials, and design effective solutions. 

Core Components (Pillars) Of Computational Thinking 

Computational thinking is built upon four fundamental, interconnected pillars. 

Decomposition 

Definition: The process of breaking a large, complex problem into smaller, more manageable 
sub-problems or tasks. 
Purpose: Makes understanding, analyzing, and solving the problem significantly easier. It 
simplifies the overall task and allows for focused work on individual parts. 
Examples: 

• Everyday: Building a birdhouse can be decomposed into: designing, gathering materials, 
cutting wood, assembling, painting, and installing. Preparing a meal involves steps like 
deciding the menu, gathering ingredients, cooking, and serving. 

• Software: Building a mobile app is decomposed into designing the user interface, coding 
features (login, navigation), and implementing data storage. 

• Robotics: Solving a maze problem for a robot can be broken down into: determining the maze 
size, defining start/end points, identifying allowed moves, and recognizing dead ends. 

Pattern Recognition 

Definition: Identifying similarities, trends, or regularities within data or across different 
problems. 

Chapter 12 
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One Liners: Computational Thinking and Algorithm 

1. Computational Thinking is a structured problem-solving methodology inspired by computer 

science but applicable to all fields. 

2. The four fundamental pillars of Computational Thinking are Decomposition, Pattern 

Recognition, Abstraction, and Algorithmic Design. 

3. Decomposition is the process of breaking a large, complex problem into smaller, more 

manageable sub-problems. 

4. Pattern Recognition involves identifying similarities, trends, or regularities within data or 

across different problems. 

5. Abstraction is the process of filtering out irrelevant details to focus only on the essential 

information needed to solve a problem. 

6. Algorithmic Design is the creation of a finite, precise, step-by-step sequence of instructions to 

solve a specific problem. 

7. A core guiding principle of CT is Problem Understanding, the thorough analysis of a problem 

to define requirements and constraints. 

8. The Problem-Solving Process involves: Identify, Define, Analyze, Plan, Test, and Select the 

best solution. 

9. The Input-Process-Output (IPO) model is the fundamental structure for any computational 

solution. 

10. An IPO Chart is a simple tabular tool used to visually plan a solution based on Input, Process, 

and Output. 

11. A Simple Problem has a clear cause and straightforward solution, requiring fewer resources. 

12. A Complex Problem has multiple interconnected causes, requires significant resources, and 

may have no guaranteed solution. 

13. A Decision Problem is one where the solution is a binary "yes-or-no" (true/false) answer for a 

given input. 

14. A Search Problem involves finding a specific item, path, or configuration that satisfies given 

criteria from a set of possibilities. 
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Practice MCQs
1. Which of the following is NOT one of the 

four core pillars of Computational 
Thinking? 
a) Decomposition 
b) Pattern Recognition 
c) Data Encryption 
d) Algorithmic Design 
Answer: c) Data Encryption 

2. In the problem-solving process, the step 
that involves breaking down the problem 
into smaller parts to identify Facts, Input, 
Output, and Process is called: 
a) Identify the Problem 
b) Define the Problem 
c) Analyze the Problem 
d) Plan the Solution 
Answer: c) Analyze the Problem 

3. The IPO Model in computational 
problem-solving stands for: 
a) Input, Program, Outcome 
b) Instruction, Process, Output 
c) Input, Process, Output 
d) Initialize, Process, Operate 
Answer: c) Input, Process, Output 

4. A problem that asks, "Is this number a 
prime?" is best categorized as a: 
a) Search Problem 
b) Counting Problem 
c) Decision Problem 
d) Optimization Problem 
Answer: c) Decision Problem 

5. If you have 5 different shirts and 4 
different pairs of pants, and you want to 
find the total number of possible outfits 
(one shirt + one pant), you must apply 
the: 
a) Addition Principle 

b) Subtraction Principle 
c) Multiplication Principle 
d) Division Principle 
Answer: c) Multiplication Principle 

6. The formula nCr = n! / (r!(n-r)!) is used 
to calculate: 
a) The number of permutations 
of *r* items from *n* 
b) The number of combinations 
of *r* items from *n* 
c) The number of ways to 
arrange *n* items in a line 
d) The sum of all possible selections 
Answer: b) The number of 
combinations of *r* items from *n* 

7. The Pigeonhole Principle guarantees that 
if you have 15 students and only 12 
lockers, then: 
a) Every locker will be used. 
b) At least one locker will be empty. 
c) At least one locker will contain more 
than one item. 
d) The number of lockers must be 
increased. 
Answer: c) At least one locker will 
contain more than one item. 

8. Which characteristic of a good algorithm 
explicitly requires that it must stop after a 
finite number of steps? 
a) Definiteness 
b) Finiteness 
c) Feasibility 
d) Generality 
Answer: b) Finiteness 

9. An algorithm that solves a problem by 
dividing it into independent sub-
problems, solving each, and combining 
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Programming Fundamentals 

The Foundations of Computing & Programming 

Introduction to Computing & Binary 

Computers are universal machines that process information. At their most fundamental level, 

they operate on two states: ON and OFF, represented by the numbers 1 and 0. This binary 

foundation underpins all digital computing. 

Information Representation: The Binary System 

Everything a computer processes—text, images, sound, and programs—is ultimately 

represented as numbers using the binary number system, which has a base of 2 and uses 

only two digits: 0 and 1. 

• Bit: The smallest unit of data, short for Binary Digit. A single bit holds a value of either 0 or 

1. 

• Byte: A group of 8 bits. It is the standard unit for measuring data size. 

• Larger Units: Data storage scales up using binary multiples (based on 1024, which is 2¹⁰): 

o 1 Kilobyte (KB) = 1024 Bytes 

o 1 Megabyte (MB) = 1024 KB 

o 1 Gigabyte (GB) = 1024 MB 

o 1 Terabyte (TB) = 1024 GB 

Chapter 13 
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for i in range(10, 0, -2):   # 10,8,6,4,2 

    print(i) 

• Lists: Ordered, mutable collections. 

python 

fruits = ["apple", "banana", "orange"] 

fruits.append("grape")        # Add item 

print(len(fruits))           # Number of items 

print(fruits[0])             # First item 

• Functions: Defined using def. 

python 

def calculate_area(radius): 

    area = 3.14159 * radius ** 2 

    return area 

Turtle Graphics 

A built-in library for creating drawings. 

python 

import turtle 

turtle.forward(100) 

turtle.left(90) 

turtle.circle(50) 

Libraries and Modules 
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Loops: 

javascript 

for (let i = 0; i < 5; i++) { console.log(i); } // for loop 

let i = 0; while (i < 5) { console.log(i); i++; } // while loop 

Arrays in JavaScript 

Ordered lists of elements. 

javascript 

let fruits = ["Apple", "Banana", "Orange"]; 

fruits.push("Grape"); // Add to end 

console.log(fruits.length); // Number of elements 

Looping through an array: 

javascript 

for (let i = 0; i < fruits.length; i++) { 

    console.log(fruits[i]); 

} 

Functions in JavaScript 

Reusable blocks of code. 

javascript 

function calculateSum(a, b) { 

    return a + b; 

} 
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One Liners: Programing Fundamentals 
1. At its core, a computer processes information using two states: ON (1) and OFF (0). 
2. The binary number system has a base of 2 and uses only the digits 0 and 1. 
3. A Bit (Binary Digit) is the smallest unit of data, holding a value of either 0 or 1. 
4. A Byte is a group of 8 bits and is the standard unit for measuring data size. 
5. Data storage scales using binary multiples: 1 Kilobyte (KB) = 1024 Bytes. 
6. In a binary number, the leftmost bit is the Most Significant Bit (MSB) and the rightmost is 

the Least Significant Bit (LSB). 
7. To convert binary to decimal, use positional notation: multiply each bit by 2 raised to its 

position power and sum the results. 
8. To convert decimal to binary, use the repeated division-by-2 method and read the 

remainders from the last to the first. 
9. ASCII is an 8-bit code representing 128 characters, where 'a' = 01100001₂ (97₁₀). 
10. Unicode is an extended system capable of representing over 65,000 characters from many 

world languages. 
11. In the RGB color model, each color component (Red, Green, Blue) is represented by an 8-

bit number (0-255). 
12. White in RGB is represented as (255,255,255) or (11111111, 11111111, 11111111)₂. 
13. Sound is converted from analogue to digital using an Analogue-to-Digital Converter 

(ADC). 
14. The quality of digital sound is determined by Sample Rate (samples per second) and Bit 

Depth (bits per sample). 
15. Problem analysis involves clearly defining the problem, identifying causes, and 

brainstorming solutions. 
16. Solution planning techniques include Abstraction, Divide and Conquer, Analogy, 

Brainstorming, and Research. 
17. The best solution is evaluated based on Speed/Time Efficiency, Cost (resources, memory), 

and Complexity (number of steps). 
18. An algorithm is a well-defined, step-by-step procedure that takes input, processes it, and 

produces an output. 
19. Algorithm efficiency is measured by Time Complexity (execution speed) and Space 

Complexity (memory usage). 
20. A flowchart is a diagrammatic representation of an algorithm using standardized symbols. 
21. In a flowchart, an Oval represents the Start or End terminal. 
22. In a flowchart, a Parallelogram represents an Input or Output operation. 
23. In a flowchart, a Rectangle represents a Process or calculation step. 
24. In a flowchart, a Diamond represents a Decision point (Yes/No, True/False). 
25. Before drawing a flowchart, determine the problem's inputs, processing, decisions, and 

outputs. 
26. A Program is a set of ordered instructions telling a computer how to perform a specific 

task. 
27. The concept of a stored program in memory was pioneered by John von Neumann. 
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Practice MCQs
1. Which of the following correctly defines 

the relationship between a bit and a byte? 
a) A bit is a group of 8 bytes. 
b) A byte is a group of 8 bits. 
c) A bit represents a decimal digit, while 
a byte represents a binary digit. 
d) A byte is always 1024 bits. 
Answer: b) A byte is a group of 8 bits. 

2. In the binary number 1101, the weight of 
the digit '1' in the leftmost position 
(assuming positions start at 0 from the 
right) is: 
a) 2^0 
b) 2^1 
c) 2^2 
d) 2^3 
Answer: d) 2^3 

3. Using the repeated division-by-2 method, 
the binary representation of the decimal 
number 29 is: 
a) 11100 
b) 11101 
c) 11011 
d) 10111 
Answer: b) 11101 

4. In the RGB color model, the binary 
representation for the color Red (255, 0, 
0) would be: 
a) (11111111, 00000000, 00000000) 
b) (00000000, 11111111, 00000000) 
c) (00000000, 00000000, 11111111) 
d) (11111111, 11111111, 11111111) 
Answer: a) (11111111, 00000000, 
00000000) 

5. When planning a software solution, the 
technique of creating a simplified model 
to focus on essential details is known as: 
a) Decomposition 

b) Pattern Recognition 
c) Abstraction 
d) Algorithmic Design 
Answer: c) Abstraction 

6. The primary purpose of a flowchart's 
diamond-shaped symbol is to represent a: 
a) Start or End point 
b) Input or Output operation 
c) Calculation or Process step 
d) Decision or Conditional branch 
Answer: d) Decision or Conditional 
branch 

7. The von Neumann architecture is most 
famous for introducing the concept of: 
a) Binary number system 
b) Stored-program computers 
c) Graphical user interfaces 
d) Object-oriented programming 
Answer: b) Stored-program computers 

8. A program that translates assembly 
language mnemonics into machine code 
is called a(n): 
a) Compiler 
b) Interpreter 
c) Assembler 
d) Linker 
Answer: c) Assembler 

9. In programming, a construct that allows a 
block of code to be executed repeatedly 
as long as a condition remains true is a: 
a) Sequence 
b) Selection 
c) Loop (Repetition) 
d) Event 
Answer: c) Loop (Repetition) 

10. In Scratch, a variable declared as "for this 
sprite only" has what kind of scope? 
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Programming in C 

Introduction to Programming and C Language 

Computer Programs and Programming 

A computer program is a well-defined, precise set of instructions that directs a computer to 
perform a specific task. The process of analyzing a problem, designing a solution, and then 
writing these instructions in a programming language is called computer programming. An 
individual who performs this task is a programmer. 

Program Syntax and Semantics 

• Syntax: Refers to the set of grammatical rules that dictate the structure of a programming 
language—how symbols, keywords, and punctuation must be arranged. Violating syntax 
results in a compilation error. 

o Example: In C, printf("Hello"); is syntactically correct, while print("Hello") is not. 

• Semantics: Refers to the meaning or logic behind the statements—the sequence of actions 
the computer will execute. A program can be syntactically perfect but produce incorrect 
results due to semantic errors (logical errors). 

o Example: The statement area = length + width; is syntactically valid but semantically incorrect 
for calculating the area of a rectangle. 

Evolution and History of C 

The C programming language was developed by Dennis Ritchie at AT&T Bell Laboratories 
in 1972. It evolved from the B language (created by Ken Thompson) and was originally 
designed for implementing the UNIX operating system. Due to its power, efficiency, and 
flexibility, C quickly became popular for system and application programming. The language 
was later standardized by the American National Standards Institute (ANSI), leading 
to ANSI C. C is a high-level, structured, procedural language that provides a unique balance 
between high-level functionality and low-level access to machine hardware. 

Categories of Programming Languages 

Low-Level Languages 

These languages are closely tied to the computer's hardware architecture. 

Chapter 14 
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Constants 

A constant is a quantity whose value does not change during program execution. 

• Literal Constants: Values typed directly into the code. 

o Integer: 100 

o Floating-point: 3.14159 

o Character: 'A' 

o String: "Hello" 

• Defined Constants (Macros): Created using the #define preprocessor directive. 

o #define MAX 100 

• Constant Qualifier (const): Uses the const keyword to declare a named constant variable. 

o const float PI = 3.14159; 

Fundamental Data Types 

Data types define the type of data a variable can hold, the amount of memory it occupies, and 
the operations that can be performed on it. 

Data Type Keyword 
Typical 

Size 
Description & Range (Typical) 

Integer int 
2 or 4 
bytes 

Whole numbers. e.g., -32,768 to 32,767 (2-
byte) or ~-2.1 billion to ~2.1 billion (4-
byte). 

Long 
Integer 

long 4 bytes 
Larger whole numbers. e.g., -
2,147,483,648 to 2,147,483,647. 

Floating-
point 

float 4 bytes 
Single-precision real numbers (6-7 decimal 
digits). e.g., 3.4e-38 to 3.4e+38. 
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An if or if-else statement placed inside another if, else, or else-if block. Used for making 
decisions within decisions. 

c 

if (marks >= 50) { 

    if (marks >= 80) { 

        printf("Grade: A"); 

    } else { 

        printf("Grade: B"); 

    } 

} else { 

    printf("Grade: F"); 

} 

The if-else if Ladder 

A clean way to handle multiple, mutually exclusive conditions. Conditions are checked from 
top to bottom. Once a true condition is found, its block is executed, and the rest of the ladder 
is skipped. 

c 

if (condition1) { 

    // Statements 1 

} else if (condition2) { 

    // Statements 2 

} else if (condition3) { 

    // Statements 3 

} else { 
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    fprintf(fp, "Bob 30\n"); 

    fclose(fp); 

 

    // READING from the same file 

    fp = fopen("records.txt", "r"); 

    if (fp == NULL) { 

        printf("File open error for read.\n"); 

        exit(1); 

    } 

    printf("Contents of file:\n"); 

    while (fscanf(fp, "%s %d", name, &age) != EOF) { 

        printf("Name: %s, Age: %d\n", name, age); 

    } 

    fclose(fp); 

    return 0; 

} 
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One Liners: Programing in C 

1. A computer program is a well-defined, precise set of instructions directing a computer to 

perform a specific task. 

2. Programming is the process of analyzing a problem, designing a solution, and writing 

instructions in a programming language. 

3. Syntax refers to the grammatical rules of a programming language; violating it causes a 

compilation error. 

4. Semantics refers to the meaning or logic behind statements; semantic errors cause 

incorrect results despite correct syntax. 

5. The C programming language was developed by Dennis Ritchie at AT&T Bell 

Laboratories in 1972. 

6. C evolved from the B language and was designed for implementing the UNIX operating 

system. 

7. ANSI C is the standardized version of C established by the American National Standards 

Institute. 

8. Machine Language (1GL) is the computer's native language of binary digits (0s and 1s) 

executed directly by the CPU. 

9. Assembly Language (2GL) uses symbolic codes called mnemonics and requires an 

assembler for translation into machine code. 

10. High-Level Languages (HLL) use human-readable syntax, are machine-independent, and 

easier to learn and debug. 

11. Procedural Languages (3GL) design programs as a sequence of procedures or functions 

operating on data; C is an example. 

12. Structured Languages emphasize breaking programs into logical blocks using control 

structures like loops and conditionals. 

13. Object-Oriented Programming (OOP) languages build programs using objects that 

encapsulate data and functions. 
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Practice MCQs

1. Which of the following best describes 

the primary difference between syntax 

and semantics in programming? 

a) Syntax deals with the meaning of 

code, while semantics deals with its 

structure. 

b) Syntax deals with the grammatical 

rules, while semantics deals with the 

logical meaning. 

c) Syntax errors occur during runtime, 

while semantic errors are caught during 

compilation. 

d) Both syntax and semantics refer to the 

visual layout of the code. 

Answer: b) Syntax deals with the 

grammatical rules, while semantics 

deals with the logical meaning. 

2. Dennis Ritchie developed the C 

programming language primarily for 

which purpose? 

a) Creating graphical user interfaces for 

Windows. 

b) Implementing the UNIX operating 

system. 

c) Developing web applications and 

server-side scripts. 

d) Writing machine learning algorithms. 

Answer: b) Implementing the UNIX 

operating system. 

3. A language that uses mnemonics 

like ADD and MOV and requires an 

assembler for translation is classified as: 

a) Machine Language (1GL) 

b) Assembly Language (2GL) 

c) High-Level Language (3GL) 

d) Object-Oriented Language (4GL) 

Answer: b) Assembly Language (2GL) 

4. Which characteristic is NOT true of 

High-Level Languages (HLL)? 

a) They are machine-independent and 

portable. 

b) They require deep knowledge of the 

computer's internal architecture. 

c) They are easier to learn, write, debug, 

and maintain than low-level languages. 

d) They support structured and modular 

programming. 

Answer: b) They require deep 

knowledge of the computer's internal 

architecture. 

5. In the C program development life cycle, 

the step where the linker combines 

object files with library files to create an 
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Object Oriented Programing in C++ 
The Programming Environment 

• Computer Program: A set of instructions written in a programming language to perform a 
specified task for a computer. It dictates what to do and in which order. 

• Software Development Life Cycle (SDLC): A structured process for developing software, 
consisting of phases like Planning, Analysis, Design, Implementation, and 
Testing/Maintenance. Its objectives are to ensure quality, manage cost and time, and deliver a 
system that meets user requirements. 

Introduction to C++ 

• History: C++ was developed by Bjarne Stroustrup at Bell Labs in the early 1980s. It is a 
superset of the C language, adding object-oriented programming features like classes, 
inheritance, and operator overloading from languages like Simula and Algol. 

• Importance: It supports both high-level and low-level programming, making it powerful for 
system-level coding and application development. 

Basic Structure of a C++ Program 
A typical C++ program has three main components: 

1. Preprocessor Directives: 

• Instructions processed before compilation, starting with #. 

• #include <header_file.h>: Inserts the contents of a header file (e.g., iostream.h, conio.h, math.h). 

• #define identifier value: Defines symbolic constants (macros). No semicolon is used. 

cpp 

#define PI 3.14159 

#define NEWLINE '\n' 

2. The main() Function: 

• The mandatory entry point where program execution begins. The function header is int main(). 

3. The Body of main() Function: 

Chapter 15 
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One Liners: Object Oriented Programing in C++ 
1. Object-Oriented Programming (OOP) bundles data (attributes) and functions (methods) into 

single units called classes, modeling real-world objects. 
2. A class is a user-defined blueprint or template that defines properties (data members) and 

behaviors (member functions). 
3. An object is an instance of a class; memory is allocated when an object is created. 
4. Access specifiers in C++ are private, public, and protected. 
5. The private access specifier (default) allows access only from within other member functions 

of the same class or from friend functions. 
6. The public access specifier allows members to be accessible from anywhere in the program 

where the object is visible. 
7. The protected access specifier is similar to private but also accessible in derived (child) 

classes. 
8. Data hiding is implemented using the private access specifier. 
9. Class members are accessed using the dot operator (.) with the object name. 
10. A constructor is a special member function automatically called when an object is created; it 

has the same name as the class and no return type. 
11. A default constructor takes no arguments; it is provided by the compiler if no constructor is 

defined. 
12. A parameterized constructor takes arguments to initialize an object with specific values. 
13. Constructor overloading allows multiple constructors with different parameter lists in the 

same class. 
14. A destructor is a special member function automatically called when an object is destroyed; 

its name is the class name preceded by a tilde (~). 
15. Destructors take no arguments, have no return type, and are used for cleanup tasks like 

releasing memory. 
16. Inheritance is a mechanism where a new class (derived/child class) is created from an existing 

class (base/parent class), inheriting its properties and behaviors. 
17. Inheritance promotes code reusability. 
18. Multiple inheritance allows a class to inherit from more than one base class. 
19. Polymorphism is the ability to present the same interface for different underlying data types, 

meaning "many forms." 
20. Examples of polymorphism include the + operator adding integers, floats, or concatenating 

strings. 
21. Polymorphism is achieved through function overloading, operator overloading, and virtual 

functions. 
22. Classes are defined using the keyword class, followed by the class name and a body enclosed 

in braces, and must end with a semicolon. 
23. Objects are created by declaring them with the class name, e.g., ClassName obj1, obj2;. 
24. Private members of a class cannot be accessed directly from outside the class using the dot 

operator. 
25. The public interface of a class allows interaction with the object from external code. 
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Practice MCQs

1. What is the primary purpose of a 
constructor in a C++ class? 
A) To delete the object 
B) To initialize the object's data members 
C) To perform cleanup operations 
D) To allocate memory for the class 
definition 
Answer: B) To initialize the object's 
data members 

2. Which access specifier allows class 
members to be accessible only from 
within the same class? 
A) public 
B) protected 
C) private 
D) friend 
Answer: C) private 

3. In OOP, what is an 'object'? 
A) A blueprint for creating classes 
B) An instance of a class 
C) A special type of function 
D) A memory address 
Answer: B) An instance of a class 

4. What does the 'protected' access 
specifier provide that 'private' does 
not? 
A) Access from anywhere in the program 
B) Access from derived classes 
C) Access from friend functions only 
D) No difference 
Answer: B) Access from derived classes 

5. Which of the following is 
automatically called when an object is 
destroyed? 
A) Constructor 
B) Destructor 
C) Inline function 

D) Friend function 
Answer: B) Destructor 

6. What is the term for creating 
multiple functions with the same name 
but different parameters? 
A) Overriding 
B) Polymorphism 
C) Overloading 
D) Inheritance 
Answer: C) Overloading 

7. Which concept allows a class to 
acquire the properties and behaviors of 
another class? 
A) Encapsulation 
B) Polymorphism 
C) Inheritance 
D) Abstraction 
Answer: C) Inheritance 

8. What is the default access specifier 
for members of a C++ class if none is 
specified? 
A) public 
B) protected 
C) private 
D) friend 
Answer: C) private 

9. How is a destructor declared in a 
C++ class? 
A) Same name as the class with a ~ prefix 
B) Same name as the class with a ! prefix 
C) Name must be 'destroy' 
D) It cannot be declared explicitly 
Answer: A) Same name as the class 
with a ~ prefix 

10. Which operator is used to access 
members of an object directly? 
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Web Development with HTML, CSS, and Java 
Script 

Introduction to the World Wide Web and Web Development 

The World Wide Web (WWW, W3, or Web) is a graphical information system on the Internet, 

introduced to the public on August 6, 1991, by Tim Berners-Lee. It allows documents to be 

connected via hypertext links, enabling users to search for information by moving from one 

document to another. It is crucial to distinguish the Web from the Internet: the Internet is the 

global network connecting computers, while the Web is the collection of interconnected 

documents (web pages) accessed via browsers. 

Web Development is the process of creating websites and web applications. It involves using 

programming languages and tools to design, build, and maintain websites. 

Why Learn Web Development? 

• Digital Literacy: Understand how websites are built and how the Internet works. 

• Career Opportunities: Opens diverse job prospects in the IT industry (e.g., web developer, 

designer). 

• Problem-Solving: Enhances logical thinking and troubleshooting skills. 

• Creativity: Allows the creation of visually appealing and interactive websites. 

• Entrepreneurship: Enables starting online businesses or creating web services. 

 

 

 

Chapter 16 
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• width & height: Specify image dimensions in pixels. 

• border: Sets border width (deprecated; use CSS instead). 

Lists 

Used to group related information. 

• Unordered List (<ul>): Creates a bulleted list. Each item uses <li>. 

html 

<ul> 

    <li>Item 1</li> 

    <li>Item 2</li> 

</ul> 

• Ordered List (<ol>): Creates a numbered list. Each item uses <li>. 

• Definition List (<dl>): Creates a list of terms and definitions. 

html 

<dl> 

    <dt>Term</dt> 

    <dd>Definition of the term.</dd> 

</dl> 

• Nested List: A list inside another list (e.g., an unordered list inside an ordered list item). 

Tables (<table>) 

Display data in rows and columns. 
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.box:hover { 

    background-color: yellow; 

    width: 200px; 

} 

• Animations: Define complex sequences of changes using @keyframes. 

css 

@keyframes example { 

    from {background-color: red;} 

    to {background-color: yellow;} 

} 

.animated-box { 

    animation-name: example; 

    animation-duration: 4s; 

    animation-iteration-count: infinite; 

} 

Introduction to JavaScript 

JavaScript is a programming language that makes web pages interactive and dynamic (e.g., 

animations, form validation, games). It was created by Brendan Eich in 1995. 

Basic Syntax and Inclusion 

JavaScript code is placed within <script> tags, either in the <head> or <body>. 

html 
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One Liners: Web Development with HTML, CSS and Java script 
1. The World Wide Web (WWW) is a graphical information system on the Internet, 

introduced publicly on August 6, 1991, by Tim Berners-Lee. 
2. The Internet is the global network connecting computers, while the Web is the collection of 

interconnected documents accessed via browsers. 
3. Web Development is the process of creating websites and web applications using 

programming languages and tools. 
4. Learning web development enhances digital literacy by explaining how websites are built 

and how the Internet works. 
5. Career opportunities in web development include roles like web developer, designer, and 

other IT industry positions. 
6. Web development improves problem-solving skills through logical thinking and 

troubleshooting. 
7. It allows creativity by enabling the creation of visually appealing and interactive websites. 
8. Web development skills support entrepreneurship by allowing the start of online businesses 

or web services. 
9. A Web Page is a document written in HTML, viewed in a browser, and identified by a 

unique URL. 
10. A Website is a collection of related web pages hosted on a web server and accessible via a 

unique address. 
11. A Web Browser is software used to retrieve and display information from websites (e.g., 

Chrome, Firefox, Edge). 
12. A Web Server is a computer that stores, processes, and delivers web pages using HTTP. 
13. Any computer can become a web server by installing server software. 
14. URL (Uniform Resource Locator) is the unique address for a file on the Internet, following 

the format: protocol://hostname/other_information. 
15. A Search Engine is a website that helps users find information by searching keywords (e.g., 

Google, Yahoo!). 
16. The Home Page is the main or index page of a website, opening first when the site is 

accessed. 
17. Web Hosting is the service of storing website content on a server connected to the Internet, 

making it accessible worldwide. 
18. Web Portals are comprehensive websites offering multiple services (e.g., email, news) and 

often require login. 
19. News Websites provide the latest news, updates, and often include videos and archives. 
20. Informational Websites provide detailed information on various topics (e.g., Wikipedia). 
21. Educational Websites are created for learning, offering tutorials, courses, and organized 

educational content. 
22. Personal Websites are created by individuals for expression, portfolio, or social 

networking. 
23. Business Websites facilitate business activities like e-commerce, banking, and reservations. 
24. Entertainment Websites focus on media, games, and recreational content. 
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Practice MCQs

1. Who introduced the World Wide 
Web to the public on August 6, 1991? 
A) Brendan Eich 
B) Tim Berners-Lee 
C) Bill Gates 
D) Steve Jobs 
Answer: B) Tim Berners-Lee 

2. What is the primary difference 
between the Internet and the Web? 
A) The Internet is for emails, the Web is 
for browsing 
B) The Internet is the global network, the 
Web is the collection of interconnected 
documents 
C) The Internet uses HTTP, the Web uses 
FTP 
D) There is no difference 
Answer: B) The Internet is the global 
network, the Web is the collection of 
interconnected documents 

3. Which of the following is NOT a 
reason to learn web development 
according to the chapter? 
A) Digital Literacy 
B) Career Opportunities 
C) Hardware Repair Skills 
D) Creativity 
Answer: C) Hardware Repair Skills 

4. What does URL stand for? 
A) Uniform Resource Locator 
B) Universal Reference Link 
C) Unified Resource Locator 
D) Uniform Retrieval Link 
Answer: A) Uniform Resource Locator 

5. Which type of website typically 
requires a user login and offers multiple 
services like email and news? 

A) News Website 
B) Web Portal 
C) Personal Website 
D) Entertainment Website 
Answer: B) Web Portal 

6. Which of the following is a back-end 
development language? 
A) HTML 
B) CSS 
C) JavaScript 
D) PHP 
Answer: D) PHP 

7. What does a full-stack developer 
handle? 
A) Only front-end development 
B) Only back-end development 
C) Both front-end and back-end 
development 
D) Only database management 
Answer: C) Both front-end and back-
end development 

8. Which version of HTML introduced 
tags for tables, scripts, and applets? 
A) HTML 1.0 
B) HTML 2.0 
C) HTML 3.2 
D) HTML5 
Answer: C) HTML 3.2 

9. What is the correct file extension for 
an HTML document? 
A) .txt 
B) .htm 
C) .html 
D) .web 
Answer: C) .html 
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Data Base and Data Management (DBMS) 
Data and Database Fundamentals 

Data, Information, and Knowledge 

Data consists of raw facts and figures, such as numbers, words, measurements, observations, 
images, or sounds (e.g., daily temperature readings, list of student names and 
marks). Information is processed, organized, or structured data presented in a meaningful 
context (e.g., a weather forecast, student percentage and grade). Information is derived from data 
and is useful for decision-making. Knowledge is the actionable insight gained from 
understanding patterns in information. Data becomes information through processing, and 
information becomes knowledge through analysis and interpretation. 

Aspect Data Information 

Nature Raw, unprocessed facts 
Processed, organized, 
meaningful data 

Role in System Input to a computer system Output of data processing 

Usefulness May not be meaningful on its own 
Useful, valuable, supports 
decisions 

Reproducibility Difficult to reproduce if lost 
Easier to reproduce (e.g., 
recalculated) 

Dependence An independent entity Depends on data 

The Need for Databases: Evolution from File Systems 

Before databases, File Management Systems (FMS) were used. Data was stored in 
independent files, each a collection of records made up of fields. This approach led to 
significant problems: 

• Data Redundancy: The same data duplicated across multiple files. 

Chapter 17 
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Practice MCQs

1. What is the primary difference 
between data and information? 
A) Data is processed; information is raw 
B) Data is meaningful on its own; 
information requires context 
C) Data is raw facts; information is 
processed data in context 
D) Data is output; information is input 
Answer: C) Data is raw facts; 
information is processed data in context 

2. Which of the following was a major 
problem with File Management Systems 
(FMS)? 
A) Program-Data Independence 
B) Controlled Data Redundancy 
C) Data Inconsistency 
D) Enhanced Security 
Answer: C) Data Inconsistency 

3. What is the key principle that data in 
a database is independent of the 
application programs called? 
A) Data Redundancy 
B) Program-Data Dependence 
C) Data Isolation 
D) Program-Data Independence 
Answer: D) Program-Data 
Independence 

4. Which database model allows a child 
record to have more than one parent? 
A) Hierarchical Model 
B) Network Model 
C) Relational Model 
D) Object-Oriented Model 
Answer: B) Network Model 

5. In the relational model, what is a two-
dimensional structure of rows and 
columns called? 

A) Attribute 
B) Tuple 
C) Relation/Table 
D) Key 
Answer: C) Relation/Table 

6. Which property of a relation states 
that each row must be unique? 
A) Column Atomicity 
B) Order Insignificance 
C) No Duplicate Rows 
D) NULL Allowed 
Answer: C) No Duplicate Rows 

7. What is a set of one or more 
attributes that can uniquely identify all 
other attributes in a relation called? 
A) Candidate Key 
B) Super Key 
C) Primary Key 
D) Foreign Key 
Answer: B) Super Key 

8. Which key must be unique and 
cannot contain NULL values? 
A) Foreign Key 
B) Alternate Key 
C) Secondary Key 
D) Primary Key 
Answer: D) Primary Key 

9. What does a Foreign Key (FK) 
enforce between tables? 
A) Entity Integrity 
B) Referential Integrity 
C) Column Atomicity 
D) Data Redundancy 
Answer: B) Referential Integrity 

10. In an ER diagram, what does a 
diamond represent? 
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System Development, Troubleshooting and 
Maintenance 

Introduction 

Systems are created to solve problems. Modern systems are often large and complex, requiring 

collaboration between teams of architects, analysts, programmers, testers, and users to produce 

the software that drives organizations. To manage this complexity and ensure structured, high-

quality outcomes, a systematic process is essential. This process is known as the System 

Development Life Cycle (SDLC). This unit focuses on the SDLC, explaining its importance, 

objectives, key participants (stakeholders), and the logical phases followed to develop a 

software product from conception to maintenance. 

What is a System? 

The term "system" originates from the Greek word "systema," meaning to "place together." A 

system can be defined as a set of interrelated components with a clearly defined boundary that 

work together to achieve a common set of objectives. When these components are methods, 

procedures, and routines applied in a proper sequence to build software, it is called a software 

system. 

System Development Life Cycle (SDLC) and Its Importance 

The System Development Life Cycle (SDLC) is a conceptual model and a structured, 

stepwise process used in project management to guide the development of an information 

system. It encompasses all stages from an initial feasibility study through to the maintenance 

of the completed application. It is also known as information system development or 

application development. 
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One Liners: System Development Troubleshooting and 
Maintenance 

1. System troubleshooting is a systematic process to identify problems and find quick 
solutions to prevent costly downtime and system damage. 

2. The primary goal of troubleshooting is to maintain system reliability, security, and 
efficiency without always relying on professional help. 

3. The first step in the systematic troubleshooting process is to identify and clearly define 
what is not working as expected. 

4. After identifying the problem, the troubleshooter must establish a theory of probable cause 
based on the observed symptoms. 

5. Testing the theory to determine the cause involves performing specific checks to confirm 
or rule out the suspected issue. 

6. Once the cause is confirmed, the next step is to establish a detailed plan of action to 
resolve the problem. 

7. The implementation phase involves carrying out the planned actions to fix the identified 
issue. 

8. After implementing the solution, it is critical to verify full system functionality to ensure 
the problem is resolved. 

9. Documenting findings, actions, and outcomes creates a valuable knowledge base for 
future reference. 

10. Troubleshooting is crucial for preventing downtime, which can lead to lost productivity 
and revenue for businesses. 

11. Ensuring data integrity is a key reason for troubleshooting, as it helps identify and fix 
problems that could corrupt information. 

12. Effective troubleshooting can reveal security vulnerabilities and breaches, allowing for 
swift protective action. 

13. Troubleshooting enhances system performance by identifying causes of slowdowns, such 
as insufficient RAM or software conflicts. 

14. Regular troubleshooting and fixing small issues early can extend equipment life by 
preventing major failures. 

15. Mastering troubleshooting saves costs by reducing the need for expensive emergency 
repairs and prolonged downtime. 

16. A reliable, well-performing system resulting from good troubleshooting enhances the 
overall user experience. 

17. For an application freezing, a common solution is to use Task Manager (Ctrl+Alt+Delete) 
to end the unresponsive task. 

18. If an application freezing persists, reinstalling the application or checking for updates is 
recommended. 

19. For unresponsive peripherals, the first steps are to check physical connections and 
unplug/replug the device. 
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Practice MCQs

1. What is the primary goal of system 
troubleshooting? 
a) To increase software licensing costs 
b) To maintain system reliability, 
security, and efficiency 
c) To replace all hardware components 
periodically 
d) To reduce the need for user training 
Answer: b) To maintain system 
reliability, security, and efficiency 

2. Which of the following is the FIRST 
step in the systematic troubleshooting 
process? 
a) Test the theory 
b) Establish a plan of action 
c) Identify the problem 
d) Document findings 
Answer: c) Identify the problem 

3. A laptop does not turn on. According 
to troubleshooting steps, what should 
you do immediately after identifying 
this problem? 
a) Replace the motherboard 
b) Establish a theory of probable cause 
(e.g., dead battery) 
c) Immediately document the failure 
d) Reinstall the operating system 
Answer: b) Establish a theory of 
probable cause (e.g., dead battery) 

4. Why is documenting the 
troubleshooting process considered 
important? 
a) It increases the complexity of the 
solution 
b) It creates a bill for the client 
c) It creates a valuable knowledge base 
for future reference 
d) It is only required for auditing 

purposes 
Answer: c) It creates a valuable 
knowledge base for future reference 

5. Which troubleshooting benefit directly 
relates to minimizing financial loss for 
a business? 
a) Extending equipment life 
b) Preventing downtime 
c) Enhancing user experience 
d) Improving security 
Answer: b) Preventing downtime 

6. An application becomes unresponsive. 
What is the most common immediate 
software-based solution? 
a) Reformat the hard drive 
b) Use Task Manager to end the task 
c) Restart the web server 
d) Update the BIOS 
Answer: b) Use Task Manager to end 
the task 

7. For an unresponsive external mouse, 
which sequence of actions is most 
appropriate initially? 
a) Update the OS, then replace the mouse 
b) Check physical connections, then 
unplug and replug 
c) Reinstall all device drivers, then restart 
d) Scan for viruses, then check the power 
supply 
Answer: b) Check physical 
connections, then unplug and replug 

8. What is the primary technical reason 
restarting a computer often resolves 
software issues? 
a) It upgrades the hardware firmware 
b) It clears memory and stops conflicting 
processes 
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Emerging and Contemporary Technologies 
Introduction to Emerging Technologies 

Definition and Characteristics 

An Emerging Technology is a new technology or a significant advancement in an existing one, 
capable of bringing about profound technical, institutional, and social changes. These 
technologies are poised to replace current systems in the near future and will be integrated into 
every field, from education and IT to medicine, transportation, and communication. They are 
distinguished by key characteristics: 

• Innovation: Introduces novel ideas and methods. 

• Fast Growth: Develops and scales rapidly. 

• Consistency: Provides reliable and repeatable performance. 

• Prominent Impact: Creates significant changes in how tasks are performed and problems are 
solved. 

• Interdisciplinary Nature: Combines knowledge and methods from multiple fields like 
computer science, engineering, and biology. 

• Convergence: Merges different technologies to create new, synergistic capabilities. 

Detailed Exploration of Emerging Technologies 

Artificial Intelligence (AI) and Machine Learning (ML) 

Artificial Intelligence (AI) is a broad field of computer science focused on building intelligent 
machines and software capable of performing tasks that typically require human-like 
intelligence, such as reasoning, learning, problem-solving, and decision-making. The term was 
coined by John McCarthy in 1956. Key subfields include: 

• Machine Learning (ML): A subset of AI that gives computers the ability to learn from data and 
experience without being explicitly programmed. ML algorithms build models by identifying 
patterns in large datasets. 

o Supervised Learning: The algorithm learns from a labeled dataset where the correct output is 
known, used for making predictions on new data (e.g., predicting prices). 

o Unsupervised Learning: The algorithm finds hidden patterns or intrinsic structures in 
unlabeled data, often through clustering (e.g., grouping customers). 

Chapter 19 
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One Liners: Emerging and Contemporary Technologies 
1. An Emerging Technology is a new technology or a significant advancement in an existing 

one, capable of bringing profound technical, institutional, and social changes. 
2. Emerging technologies are poised to replace current systems in the near future and will be 

integrated into every field. 
3. Key characteristics of emerging technologies include Innovation, Fast Growth, Consistency, 

Prominent Impact, Interdisciplinary Nature, and Convergence. 
4. The Interdisciplinary Nature of emerging technologies combines knowledge from fields like 

computer science, engineering, and biology. 
5. Convergence refers to the merging of different technologies to create new, synergistic 

capabilities. 
6. Artificial Intelligence (AI) is a broad field of computer science focused on building 

intelligent machines capable of human-like tasks such as reasoning, learning, and decision-
making. 

7. The term "Artificial Intelligence" was coined by John McCarthy in 1956. 
8. Machine Learning (ML) is a subset of AI that gives computers the ability to learn from data 

and experience without being explicitly programmed. 
9. Supervised Learning involves algorithms learning from labeled datasets where the correct 

output is known, used for making predictions. 
10. Unsupervised Learning involves algorithms finding hidden patterns in unlabeled data, often 

through clustering. 
11. Deep Learning (DL) is a specialized subset of ML that uses Neural Networks with many 

hidden layers. 
12. A Neural Network is inspired by the human brain and consists of interconnected nodes 

(neurons). 
13. The layers of a Neural Network are Input Layer, Hidden Layers, and Output Layer. 
14. Weights in a neural network represent the importance of connections between neurons. 
15. Biases are threshold adjusters in neural networks that help the model fit the data better. 
16. Activation Functions in neural networks determine whether a neuron should be activated. 
17. Loss Functions measure the difference between the predicted output and the actual target. 
18. Training a neural network involves Feedforward Propagation and Backpropagation to 

minimize error. 
19. Deep Learning excels at autonomously extracting complex patterns from vast amounts of 

unstructured data like images and text. 
20. The hierarchical relationship is: AI ⊃ ML ⊃ Neural Networks ⊃ Deep Learning. 
21. Natural Language Processing (NLP) enables computers to understand, interpret, and generate 

human language. 
22. NLP applications include language translation, spam filtering, sentiment analysis, chatbots, 

and voice assistants. 
23. Speech Recognition converts spoken words into text or commands (e.g., dictation software, 

Siri). 
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Practice MCQs

1. Which of the following is NOT a 
characteristic of an emerging 
technology? 
A) Innovation 
B) Slow and steady growth 
C) Interdisciplinary nature 
D) Prominent impact 
Answer: B) Slow and steady growth 

2. Who coined the term "Artificial 
Intelligence"? 
A) Alan Turing 
B) John McCarthy 
C) Marvin Minsky 
D) Claude Shannon 
Answer: B) John McCarthy 

3. Which subset of AI gives computers 
the ability to learn from data without 
explicit programming? 
A) Natural Language Processing 
B) Machine Learning 
C) Computer Vision 
D) Expert Systems 
Answer: B) Machine Learning 

4. In machine learning, which type 
involves algorithms learning from 
labeled datasets? 
A) Unsupervised Learning 
B) Reinforcement Learning 
C) Supervised Learning 
D) Deep Learning 
Answer: C) Supervised Learning 

5. What is the hierarchical relationship 
between AI, ML, Neural Networks, and 
Deep Learning? 
A) AI ⊃ Neural Networks ⊃ ML ⊃ Deep 
Learning 
B) AI ⊃ ML ⊃ Neural Networks ⊃ Deep 

Learning 
C) ML ⊃ AI ⊃ Deep Learning ⊃ Neural 
Networks 
D) Deep Learning ⊃ Neural Networks ⊃ 
ML ⊃ AI 
Answer: B) AI ⊃ ML ⊃ Neural 
Networks ⊃ Deep Learning 

6. Which AI subfield enables computers 
to understand, interpret, and generate 
human language? 
A) Computer Vision 
B) Robotics 
C) Natural Language Processing 
D) Speech Recognition 
Answer: C) Natural Language 
Processing 

7. What is the key difference between 
speech recognition and voice 
recognition? 
A) Speech recognition identifies a person; 
voice recognition converts speech to text. 
B) Speech recognition converts speech to 
text; voice recognition identifies a person. 
C) Both are the same. 
D) Speech recognition is for commands; 
voice recognition is for transcription. 
Answer: B) Speech recognition converts 
speech to text; voice recognition 
identifies a person. 

8. Which technology creates a fully 
immersive, artificial three-dimensional 
environment? 
A) Augmented Reality 
B) Virtual Reality 
C) Holographic Imaging 
D) 3D Printing 
Answer: B) Virtual Reality 
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Digital Citizenship, Literacy and Ethics 

Introduction: Navigating the Modern Digital World 

The digital landscape is the cornerstone of modern society, transforming how we 
communicate, learn, work, and access entertainment. This evolution from traditional methods 
to a connected, technology-driven world brings immense power and convenience, but also 
introduces significant responsibilities, risks, and ethical dilemmas. This Master Chapter 
provides a complete, unified, and self-contained guide to becoming a competent, safe, 
responsible, and ethical participant in the digital world. It integrates foundational skills, 
security practices, ethical frameworks, societal impacts, and entrepreneurial thinking into a 
seamless professional textbook. 

The Digital Foundation – Hardware, Software, and Systems 

Understanding Software 

A computer consists of hardware—the physical components—and software, the set of 
instructions, data, and programs that operate the computer to perform specific tasks. 

Types of Software 

1. System Software: The essential set of programs that acts as the primary interface between 
hardware and the user. Its purpose is to simplify hardware use, control operations, and 
optimize performance. 

o Examples: Operating Systems (OS), Device Drivers, Utility Programs, Language 
Translators. 

2. Application Software: Programs written to carry out specific tasks for the user. 

o Examples: Word Processors (Microsoft Word), Spreadsheets (Excel), Presentation Software 
(PowerPoint), Web Browsers (Chrome), Email Clients (Gmail), Image Editors (Paint). 

System Software Deep Dive 

The Operating System (OS) 

The OS is the most critical system software that controls and manages all computer 
operations. A computer cannot function without it. 

Chapter 20 
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• Cyberterrorism, Cyberstalking, Phishing, Spoofing. 

Malicious Software (Malware) 

Software designed to harm, disrupt, or gain unauthorized access. 

Type Description Key Characteristics 

Virus 
Attaches to a legitimate 
file/program and replicates 
when executed. 

Requires user action, spreads via 
files, corrupts/deletes data. 

Worm 
A standalone program that self-
replicates across networks. 

Does not need a host file, consumes 
bandwidth/space. 

Trojan 
Horse 

Disguises as legitimate software 
but performs malicious actions. 

Does not self-replicate; creates 
backdoors, steals data. 

Spyware 
Secretly collects user 
information (habits, passwords). 

Tracks activity, changes settings, 
leads to identity theft. 

Adware 
Displays unwanted ads, often 
bundled with free software. 

Slows system, tracks browsing for 
targeted ads. 

Ransomware 
Encrypts victim's files, 
demanding payment for 
decryption. 

Makes data inaccessible, extorts 
money. 

Keylogger 
Records keystrokes to capture 
sensitive data like passwords. 

A type of spyware focused on 
logging input. 

How Malware Spreads: Infected removable media, pirated software, network/internet 
downloads, email attachments (most common). 

Symptoms of Infection: Slow performance, frequent crashes/freezes, unwanted pop-
ups/toolbars, programs opening/closing automatically, inaccessible files, unusual error 
messages, emails sent from your account without knowledge. 
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One Liners: Digital Citizenship, Ethics and Literacy 
1. The digital landscape is the cornerstone of modern society, transforming communication, 

learning, work, and entertainment. 
2. A computer consists of hardware (physical components) and software (instructions, data, 

and programs). 
3. System software acts as the primary interface between hardware and the user, simplifying 

hardware use, controlling operations, and optimizing performance. 
4. Application software carries out specific tasks for the user (e.g., word processors, 

spreadsheets). 
5. The Operating System (OS) is the most critical system software that controls and manages 

all computer operations; a computer cannot function without it. 
6. OS functions include Booting, Security Management, Application Management, Memory 

Management, File Management, Device Management, and providing a User Interface. 
7. Common OS examples are Microsoft Windows, macOS, Linux, Android, and iOS. 
8. Device Drivers are specialized programs enabling hardware components to communicate 

with the OS. 
9. Utility Programs perform management and maintenance tasks (e.g., antivirus, disk 

cleanup). 
10. Language Translators convert human-readable programming code into machine-

understandable code (Assemblers, Compilers, Interpreters). 
11. The desktop is the main screen after startup, containing icons, taskbar, Start button/menu, 

notification area, and background/wallpaper. 
12. A File is a common storage unit holding information; a Folder is a virtual container used 

to organize files. 
13. A Shortcut is a link providing quick access to a file, folder, or program without moving 

the original item. 
14. Essential file operations include Create, Rename, Cut/Copy/Paste, Delete & Restore, and 

Drag and Drop. 
15. Deleted files are sent to the Recycle Bin, from which they can be restored. 
16. A word processor is an application used to create, edit, format, save, and print text-based 

documents. 
17. Key word processor interface elements include the Quick Access Toolbar, Title Bar, 

Ribbon, and Document Workspace. 
18. Character formatting in a word processor includes changing Font Style, Size, Color, and 

applying Bold, Italic, Underline, and Text Alignment. 
19. Page Layout adjustments involve margins, orientation (Portrait/Landscape), and size. 
20. Lists can be bulleted (unordered) or numbered (sequential). 
21. Headers and Footers are areas at the top and bottom of every page for titles, page 

numbers, and dates. 
22. Spell & Grammar Check (F7) and Thesaurus are tools for error checking and finding 

synonyms. 



 

  MK PREPARATIONS  

 
 

P a g e  30 | 34 

 

  

2
0

. D
ig

ita
l C

itize
n

sh
ip

, L
ite

ra
cy

 a
n

d
 E

th
ics 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Practice MCQs

1. What are the two main components 
of a computer system? 
A) CPU and RAM 
B) Hardware and Software 
C) Input and Output 
D) Operating System and Applications 
Answer: B) Hardware and Software 

2. Which type of software acts as the 
primary interface between hardware 
and the user? 
A) Application Software 
B) System Software 
C) Utility Software 
D) Programming Software 
Answer: B) System Software 

3. Which of the following is NOT a 
function of an Operating System? 
A) Booting 
B) Memory Management 
C) Word Processing 
D) File Management 
Answer: C) Word Processing 

4. What is the purpose of a Device 
Driver? 
A) To perform disk cleanup 
B) To enable hardware components to 
communicate with the OS 
C) To compile programming code 
D) To create documents 
Answer: B) To enable hardware 
components to communicate with the 
OS 

5. Where are deleted files typically 
stored before permanent deletion? 
A) Downloads folder 
B) Recycle Bin 
C) Temp folder 

D) Desktop 
Answer: B) Recycle Bin 

6. Which keyboard shortcut is used to 
copy selected text or files? 
A) Ctrl+X 
B) Ctrl+C 
C) Ctrl+V 
D) Ctrl+A 
Answer: B) Ctrl+C 

7. In a word processor, which tab is 
used to adjust page margins and 
orientation? 
A) Home 
B) Insert 
C) Layout 
D) Review 
Answer: C) Layout 

8. What does Bcc stand for in an 
email? 
A) Basic Carbon Copy 
B) Blind Carbon Copy 
C) Broad Copy Control 
D) Binary Copy Code 
Answer: B) Blind Carbon Copy 

9. Which email protocol downloads 
emails from the server to a single 
device and typically removes them 
from the server? 
A) SMTP 
B) IMAP 
C) POP 
D) HTTP 
Answer: C) POP 

10. What is the ability to effectively 
find, create, evaluate, communicate, 
and share content in a digital 
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Entrepreneurship in the Digital Age 

Introduction 

Entrepreneurship is the dynamic process of identifying a market opportunity, conceptualizing a 
solution, and undertaking the risk of launching and managing a new business venture to bring 
new products, services, or processes to life. It is the engine of innovation, job creation, and 
economic growth. In the contemporary world, this traditional process has been fundamentally 
transformed by digital technologies. The fusion of classic business acumen with tools like the 
internet, social media, cloud computing, and data analytics has created unprecedented 
opportunities while reshaping the entrepreneurial landscape. This Master Chapter provides a 
comprehensive, unified guide to understanding the complete journey of entrepreneurship—
from its core principles and initial idea validation to building, launching, and scaling a venture 
in the digital era. It is designed to be a self-contained, professional resource for students and 
aspiring entrepreneurs. 

The Foundation of Entrepreneurship 

Definition and Core Concepts 

• Entrepreneur: An individual who organizes, manages, and assumes the financial risks of a 
new business venture. An entrepreneur is commonly seen as an innovator, a source of new 
ideas, goods, services, and business procedures. The term originates from the French word 
meaning "to undertake." 

• Entrepreneurship: The process of designing, launching, and running this new business 
venture. It involves identifying a market need, taking calculated risks under conditions of 
uncertainty, and making strategic decisions to achieve business objectives and create value. 

Significance and Impact 

Entrepreneurship is a vital catalyst for any economy due to its multi-faceted role: 

• Economic Growth: Creates new jobs and introduces new products and services, stimulating 
economic activity. 

• Innovation and Progress: Drives groundbreaking ideas that transform lifestyles and 
industries (e.g., smartphones, digital platforms). 

• Job Creation: Generates employment opportunities directly and indirectly. 

Chapter 21 
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One Liners: Entrepreneurship in Digital Age 

1. Entrepreneurship is the dynamic process of identifying a market opportunity and 

undertaking the risk of launching a new business venture. 

2. An entrepreneur is an individual who organizes, manages, and assumes the financial risks of 

a new business venture. 

3. The term "entrepreneur" originates from the French word meaning "to undertake." 

4. Entrepreneurship is commonly seen as a source of innovation, introducing new ideas, goods, 

services, and business procedures. 

5. The process of entrepreneurship involves identifying a market need, taking calculated risks, 

and making strategic decisions to create value. 

6. Entrepreneurship acts as a vital catalyst for economic growth by creating new jobs. 

7. It drives economic growth by introducing new products and services that stimulate 

economic activity. 

8. Entrepreneurship is a primary driver of groundbreaking innovation that transforms lifestyles 

and industries. 

9. A major impact of entrepreneurship is job creation, generating employment opportunities 

both directly and indirectly. 

10. By introducing fresh ideas and competition, entrepreneurship leads to better products, 

services, and prices for consumers. 

11. Social entrepreneurship specifically addresses pressing societal and environmental 

challenges. 

12. A key characteristic of successful entrepreneurs is innovation and creativity. 

13. Entrepreneurs exhibit calculated risk-taking, understanding that failure is possible but great 

rewards can follow. 

14. Successful entrepreneurs are moderate risk-takers, not gamblers. 

15. Persistence and resilience are essential attributes for overcoming inevitable challenges and 

setbacks. 
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Practice MCQs

1. What is the core definition of an 
entrepreneur? 
a) An employee who follows company 
procedures 
b) An individual who organizes, 
manages, and assumes the financial risks 
of a new business venture 
c) A government official who regulates 
markets 
d) A consumer who buys innovative 
products 
Answer: b) An individual who 
organizes, manages, and assumes the 
financial risks of a new business 
venture 

2. The term "entrepreneur" originates 
from which language? 
a) Latin 
b) Greek 
c) French 
d) German 
Answer: c) French 

3. Which of the following is NOT a 
primary impact of entrepreneurship on 
an economy? 
a) Job Creation 
b) Economic Stagnation 
c) Innovation and Progress 
d) Increased Competition 
Answer: b) Economic Stagnation 

4. A successful entrepreneur who takes 
financial risks with an understanding 
of potential failure, but not recklessly, 
is best described as a: 
a) Gambler 
b) Calculated risk-taker 
c) Avoider of all risk 

d) Follower of trends 
Answer: b) Calculated risk-taker 

5. Which characteristic involves the 
ability to pivot strategies based on 
market feedback? 
a) Persistence 
b) Confidence 
c) Flexibility and Adaptability 
d) Future Orientation 
Answer: c) Flexibility and Adaptability 

6. What is a significant drawback of 
entrepreneurship? 
a) Unlimited profit potential 
b) Gaining control over one's career 
c) Uncertainty and variability of income 
d) Doing personally enjoyable work 
Answer: c) Uncertainty and variability 
of income 

7. A local grocery store that supports a 
family lifestyle without seeking venture 
capital is an example of: 
a) Scalable Startup 
b) Social Entrepreneurship 
c) Small Business Entrepreneurship 
d) Buyer Entrepreneurship 
Answer: c) Small Business 
Entrepreneurship 

8. Which type of entrepreneurship aims 
primarily for social good rather than 
profit maximization? 
a) Innovative Entrepreneurship 
b) Social Entrepreneurship 
c) Hustler Entrepreneurship 
d) Imitator Entrepreneurship 
Answer: b) Social Entrepreneurship 
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Miscellaneous Information: Quick Revision Notes 

1. Most Common Keyboard Shortcuts 

Windows 

• Ctrl + C → Copy selected item → Used to copy text/files. 

• Ctrl + X → Cut selected item → Removes and copies text/files. 

• Ctrl + V → Paste copied/cut item → Inserts clipboard content. 

• Ctrl + Z → Undo last action → Reverses previous operation. 

• Ctrl + Y / Ctrl + Shift + Z → Redo action → Reapplies undone action. 

• Ctrl + A → Select all items → Highlights all content in a window. 

• Ctrl + S → Save current document → Saves file in active application. 

• Ctrl + F → Open find/search box → Searches for text on a page. 

• Ctrl + P → Print current page/document → Opens print dialog. 

• Ctrl + N → Open new window/document → Creates new instance. 

• Ctrl + W → Close current window/tab → Shuts active tab/window. 

• Ctrl + T → Open new browser tab → Creates tab in browsers. 

• Ctrl + Shift + T → Reopen closed tab → Restores recently closed tab. 

• Alt + Tab → Switch between open apps → Toggles running applications. 

• Alt + F4 → Close active application → Quits current program. 

• Windows Key + D → Show/hide desktop → Minimizes all windows. 

• Windows Key + E → Open File Explorer → Launches file manager. 

• Windows Key + L → Lock computer → Locks screen quickly. 

• Windows Key + R → Open Run dialog → Executes commands. 

Chapter 22 



 

  MK PREPARATIONS  

 

P a g e  6 | 34 

 

  

2
2

. M
isce

lla
n

e
o

u
s In

fo
rm

a
tio

n
: Q

u
ick

 R
e

v
isio

n
 N

o
te

s 
  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

o Country of Origin: Pakistan 

o Headquarters: Karachi, Pakistan 

o Current CEO: Bjarke Mikkelsen 

o Major Services: Online marketplace in South Asia (Pakistan, Bangladesh, Sri Lanka, 
Nepal, Myanmar). 

o Launch Year: 2012 

o Key Fact: Alibaba-owned leading online shopping platform in South Asia. 

• Walmart (Walmart.com) 

o Founder: Sam Walton 

o Country of Origin: USA 

o Headquarters: Bentonville, Arkansas, USA 

o Current CEO: Doug McMillon 

o Major Services: Online retail, grocery delivery, in-store pickup, Walmart+ membership. 

o Launch Year: 2000 (online) 

o Key Fact: World's largest retailer by revenue, with massive omnichannel e-commerce 
presence. 

• Rakuten 

o Founder: Hiroshi Mikitani 

o Country of Origin: Japan 

o Headquarters: Tokyo, Japan 

o Current CEO: Hiroshi Mikitani 

o Major Services: E-commerce, fintech, digital content, communications, investing. 

o Launch Year: 1997 

o Key Fact: Japan's largest e-commerce site, operates as an ecosystem of services. 

• Mercado Libre 

https://walmart.com/
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o Owner/Parent: Hugging Face, Inc. 

o CEO: Clément Delangue 

o Launch Year: 2016 

o Key Feature: Central repository for open-source AI models and transformers library. 

4. Core Computer Science Concepts 

• Operating System (OS): Software that manages computer hardware and provides services 
for applications. 

• Kernel: Core component of OS that manages CPU, memory, and system calls. 

• Process: An instance of a program in execution, with its own memory space. 

• Thread: The smallest unit of processing that can be scheduled within a process. 

• Deadlock: A situation where two or more processes are unable to proceed because each is 
waiting for the other. 

• Virtual Memory: Memory management technique that uses disk space to extend RAM. 

• File System: Method for storing, organizing, and retrieving files on a storage device. 

• Database Management System (DBMS): Software for creating, managing, and 
interacting with databases. 

• Relational Database: Database structured with tables, rows, and columns, using SQL. 

• NoSQL Database: Non-relational database designed for scalability and flexible data 
models. 

• ACID Properties: Atomicity, Consistency, Isolation, Durability – guarantees for database 
transactions. 

• SQL: Structured Query Language used to communicate with relational databases. 

• Primary Key: Unique identifier for a record in a database table. 

• Foreign Key: Field in a table that links to the primary key of another table. 

• Normalization: Process of organizing data to reduce redundancy and improve integrity. 

• Indexing: Database optimization technique to speed up data retrieval. 
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• Web3: Idea for a decentralized internet built on blockchain technology. (Example: Using 
Ethereum-based dApps without centralized control.) 

• Low-Code/No-Code Platforms: Development environments allowing creation of apps 
with minimal hand-coding. (Example: Building a business app using drag-and-drop 
in Bubble.io .) 

6. General High-Value IT and Tech Facts 

• Microsoft was founded by Bill Gates and Paul Allen in 1975. 

• Apple was founded by Steve Jobs, Steve Wozniak, and Ronald Wayne in 1976. 

• Google was founded by Larry Page and Sergey Brin in 1998. 

• Amazon was founded by Jeff Bezos in 1994, originally as an online bookstore. 

• Facebook (Meta) was founded by Mark Zuckerberg in 2004. 

• Linux is an open-source kernel created by Linus Torvalds in 1991. 

• Windows is a family of proprietary operating systems developed by Microsoft. 

• macOS is the proprietary Unix-based operating system for Apple Mac computers. 

• Android is a mobile OS based on a modified Linux kernel, developed by Google. 

• iOS is Apple's mobile operating system for iPhone and iPad. 

• Google Chrome is a web browser developed by Google (parent: Alphabet). 

• Mozilla Firefox is an open-source browser developed by Mozilla Foundation. 

• Microsoft Edge is a browser developed by Microsoft, based on Chromium. 

• Safari is a browser developed by Apple for its devices. 

• C programming language was created by Dennis Ritchie at Bell Labs (1972). 

• C++ was created by Bjarne Stroustrup as an extension of C (1985). 

• Java was created by James Gosling at Sun Microsystems (1995, now owned by Oracle). 

• Python was created by Guido van Rossum and released in 1991. 

• JavaScript was created by Brendan Eich at Netscape in 1995. 

https://bubble.io/
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• MP3 is a coding format for digital audio using lossy compression. 

• JPEG is a commonly used method of lossy compression for digital images. 

• PNG is a raster-graphics file format supporting lossless data compression. 

• MP4 is a digital multimedia container format for video, audio, and subtitles. 

• Elon Musk is the CEO of Tesla and SpaceX, and founded Neuralink and The Boring 
Company. 

• Satya Nadella is the Chairman and CEO of Microsoft. 

• Tim Cook is the CEO of Apple. 

• Sundar Pichai is the CEO of Alphabet (Google's parent company). 

• Jensen Huang is the co-founder and CEO of NVIDIA. 

• The first programmable computer was the Z3 by Konrad Zuse (1941). 

• The first electronic general-purpose computer was ENIAC, completed in 1945. 

• The World Wide Web (WWW) was invented by Tim Berners-Lee in 1989. 

• The first website was info.cern.ch , launched in 1991. 

• ARPANET, the precursor to the internet, became operational in 1969. 

• The first email was sent by Ray Tomlinson in 1971, using the "@" symbol. 

• The first iPhone was announced by Steve Jobs in 2007. 

• The first domain name ever registered was symbolics.com  (March 15, 1985). 

• As of 2024, the most valuable public company is Microsoft (by market cap). 

• The most downloaded app of all time is WhatsApp. 

• The most popular programming language (as per various 2024 indices) is Python. 

• The largest data center in the world is the China Telecom Data Center in Hohhot, China. 

• The first 1 GB hard drive (IBM 3380) weighed 550 pounds and cost $40,000 in 1980. 

 

https://info.cern.ch/
https://symbolics.com/
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• AI: Artificial Intelligence - Intelligence demonstrated by machines. 

• ML: Machine Learning - AI subset where systems learn from data. 

• IoT: Internet of Things - Network of interconnected physical devices. 

• ISP: Internet Service Provider - Company providing internet access. 

• SMTP: Simple Mail Transfer Protocol - Protocol for sending email messages. 

• FTP: File Transfer Protocol - Standard network protocol for transferring files. 

• OS: Operating System - System software that manages computer hardware and software 
resources. 

• BIOS: Basic Input/Output System - Firmware used to perform hardware initialization 
during booting. 

• POST: Power-On Self-Test - Diagnostic testing sequence performed by firmware/BIOS on 
boot. 

• CMOS: Complementary Metal-Oxide-Semiconductor - Battery-powered chip storing 
BIOS settings. 

• IP: Internet Protocol - Principal communications protocol for relaying datagrams across 
networks. 

• MAC: Media Access Control Address - Unique hardware identifier for network interfaces. 

• LAN: Local Area Network - Network covering a small geographic area like a home or 
office. 

• WAN: Wide Area Network - Network covering a broad area (e.g., internet). 

• MAN: Metropolitan Area Network - Network covering a city or campus. 

• PAN: Personal Area Network - Network for communication among devices close to a 
person. 

• 5G: 5th Generation - Latest standard for cellular networks, high speed and low latency. 

• LTE: Long-Term Evolution - Standard for high-speed wireless communication. 

• PDF: Portable Document Format - File format for presenting documents. 

• DOCX: Microsoft Word Open XML Document - Default format for Microsoft Word 
documents. 
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• CMS: Content Management System - Software application for creating and managing 
digital content. 

• ERP: Enterprise Resource Planning - Integrated management of main business processes. 

• CRM: Customer Relationship Management - System for managing company interactions 
with customers. 

• SCM: Supply Chain Management - Management of flow of goods and services. 

• BI: Business Intelligence - Technologies/applications for analyzing business information. 

• ETL: Extract, Transform, Load - Process in data warehousing for preparing data for 
analysis. 

• OLAP: Online Analytical Processing - Approach to answer multi-dimensional analytical 
queries. 

• OLTP: Online Transaction Processing - Class of systems facilitating transaction-oriented 
applications. 

• NoSQL: Not only SQL - Broad class of database management systems differing from 
relational databases. 

• MongoDB: A popular document-oriented NoSQL database. 

• Hadoop: Open-source framework for distributed storage/processing of big data. 

• Spark: Apache Spark - Unified analytics engine for large-scale data processing. 

• Kafka: Apache Kafka - Distributed event streaming platform. 

• DevOps: Development and Operations - Culture/practice combining software development 
and IT operations. 

• CI/CD: Continuous Integration/Continuous Deployment - Automating software delivery 
pipeline. 

• Agile: Iterative approach to project management and software development. 

• Scrum: Framework within which people can address complex adaptive problems in Agile. 

• Kanban: Visual system for managing work as it moves through a process in Agile. 

• JVM: Java Virtual Machine - Virtual machine enabling computer to run Java programs. 
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Past Papers Questions

1. How many rows in MS Excel Sheet? 
A) 86340 
B) 1048576 
C) 86400 
D) None of these 
Answer: B) 1048576 

2. Which Pane is not available in 
PowerPoint? 
A) WordArt 
B) Insert 
C) Animation 
D) None of these 
Answer: A) WordArt 

3. Deleted Items in file directly go to the: 
A) Recycle Bin 
B) Desktop 
C) Windows Folder 
D) None of these 
Answer: A) Recycle Bin 

4. Crop function is used to crop: 
A) Videos 
B) Images 
C) Files 
D) None of these 
Answer: B) Images 

5. Which key is used to move the cursor to 
end of the line? 
A) End 
B) Home 
C) Shift+ tab 
D) None of these 
Answer: A) End 

6. In MS-DOS, DOS stands for: 
A) Disk Operating System 
B) Device Operating System 
C) Driver Operating System 

D) None of these 
Answer: A) Disk Operating System 

7. HTML stands for hypertext markup 
language is used for creating: 
A) Web pages 
B) Web server 
C) Client server 
D) None of these 
Answer: A) Web pages 

8. Gmail, Hotmail and Yahoo are: 
A) Email Server 
B) Client Server 
C) Email Programmer 
D) None of these 
Answer: D) None of these 

9. Windows 9 and Windows 10 are known 
as: 
A) Operating system 
B) System software 
C) Application software 
D) None of these 
Answer: A) Operating system 

10. In PowerPoint the header and footer 
button can be found on the: 
A) Home tab 
B) Insert tab 
C) Draw tab 
D) None of these 
Answer: B) Insert tab 

11. Which of the following are word 
processing software? 
A) Browser 
B) PowerPoint 
C) MS Word 
D) None of these 
Answer: C) MS Word 
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12. The first computers were 
programmed using: 
A) Assembly language 
B) Machine language 
C) Object code 
D) None of these 
Answer: B) Machine language 

13. The computer cannot boot if it cannot 
load the: 
A) Loader 
B) Operating system 
C) Assembler 
D) None of these 
Answer: B) Operating system 

14. BIOS stands for: 
A) Basic Input Output System 
B) Binary Input Output System 
C) Broad Input Output System 
D) None of these 
Answer: A) Basic Input Output System 

15. LCD stands for: 
A) Light Clear Display 
B) Liquid Crystal Display 
C) Light Crystal Display 
D) None of these 
Answer: B) Liquid Crystal Display 

16. Which function in Excel returns the 
remainder of division? 
A) Divide 
B) MOD 
C) ACOT 
D) None of these 
Answer: B) MOD 

17. Which template provides design 
concept, fonts and color scheme? 
A) Design template 
B) Color template 
C) Animation template 
D) None of these 
Answer: A) Design template 

18. Which key is used to minimize an 
Excel Worksheet? 
A) CTRL+F5 
B) CTRL+F9 
C) CTRL+F11 
D) None of these 
Answer: B) CTRL+F9 

19. Videos, documents and files can be 
shown in: 
A) WhatsApp 
B) YouTube 
C) Skype 
D) None of these 
Answer: D) None of these 

20. The extension of a PowerPoint file is: 
A) XLS 
B) PPT 
C) TXT 
D) All of these 
Answer: B) PPT 

21. In MS Word, Header and Footer are 
inserted in: 
A) Front page 
B) Last page 
C) On every page 
D) None of these 
Answer: C) On every page 

22. Which button do you click to add up a 
series of numbers? 
A) Auto sum 
B) Formula button 
C) Total Button 
D) None of these 
Answer: A) Auto sum 

23. When you insert an Excel file into a 
Word document, the data are: 
A) Embedded 
B) Linked 
C) Hyperlink placed in word table 
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B) Printed parts 
C) Program 
D) None of these 
Answer: A) Physical parts 

116. An element of an array is mentioned 
by its: 
A) Array 
B) Subscript 
C) Superscript 
D) None of these 
Answer: B) Subscript 

117. What is the main difference between 
a mainframe and a supercomputer? 
A) Supercomputer is much larger than 
mainframe computer 
B) Supercomputers are much smaller than 
mainframe computers 
C) Supercomputers are focused to execute a 
few programs as fast as possible while the 
mainframe used its power to execute as 
many programs concurrently 
D) None of these 
Answer: C) Supercomputers are focused to 
execute a few programs as fast as possible 
while the mainframe used its power to 
execute as many programs concurrently 

118. Is it necessary for an algorithm to 
solve a problem with an infinite number 
of steps? 
A) No 
B) Yes 
C) Error 
D) None of these 
Answer: B) Yes 

119. Arithmetic Operations are 
performed by: 
A) LU 
B) ALU 
C) CU 
D) None of these 
Answer: B) ALU 

120. A processor is also known as: 
A) CPU 
B) UPS 
C) PUS 
D) None of these 
Answer: A) CPU 

121. Which part of the CPU controls the 
sequence of instructions? 
A) AU 
B) CU 
C) ALU 
D) None of these 
Answer: B) CU 

122. RAM stands for: 
A) Random Access Memory 
B) Random Analysis 
C) Read Able Memory 
D) None of these 
Answer: A) Random Access Memory 

123. ROM stores data: 
A) Permanently 
B) Partially 
C) Temporary 
D) None of these 
Answer: A) Permanently 

124. Which of the following is the highest 
speed slot? 
A) ISA 
B) AGP 
C) AGC 
D) None of these 
Answer: B) AGP 

125. A video game is played by using 
__________ card. 
A) Sound 
B) Modem 
C) Graphics 
D) None of these 
Answer: C) Graphics 
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